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Disclaimer 

 

The material in this document is for information purposes only. The content and the product described 

are subject to change without notice. Honeywell makes no representations or warranties with respect 

to this document. In no event shall Honeywell be liable for technical or editorial omissions or mistakes 

in this document, nor shall it be liable for any damages, direct or incidental, arising out of or related to 

the use of this document. No part of this document may be reproduced in any form or by any means 

without prior written permission from Honeywell. 

 

Copyright © 2019 HONEYWELL International, Inc. All rights reserved.  

 

Niagara Framework® is a registered trademark of Tridium Inc. 
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About This Guide 

This document serves as a guide to configure and use the Honeywell CIPer Model 30 programming 

model. Released versions of the tool include a complete collection of technical information that is pro-

vided in both online help and PDF format. The information in this document includes basic descrip-

tions and concepts as well as reference information, to help Systems Integrators and Engineers use 

the CIPer Model 30 programming model. To make the most of the information in this guide, readers 

should have some training or previous experience working with Honeywell WEBs controllers, as well as 

Niagara 4 or Niagara AX software. 

Other Related Documents 

• 31-00183EFS (CIPer Model 30 Installation Instructions) 

• 31-00236EFS (CIPer Model 30 Product Data Sheet) 

• 31-00206EFS (CIPer Model 30 Installation and Operation Guide) 

• 31-00207EFS (IPC Software Tool- Hardening Guide) 

• Software Release Bulletins 

• Niagara 4 Installation Guide 

For more details about CIPer Model 30 controller, refer The Honeywell Buildings Forum. 

Abbreviations 

Abbreviation Full Form 

CIPer Internet Protocol Controller 

VAV Variable Air Volume 

I/O or IO Input / Output 

UI/AO Universal Input Output 

AO Analog Output 

DO Digital Output 

AI Analog Input 

DI Digital Input 

HTTP Hypertext Transfer Protocol 

LAN Local Area Network 

DHCP Dynamic Host Configuration Protocol 

https://honeywellprod.sharepoint.com/teams/ecc-TheBuildingsForum/HoneywellWEBs/WEBsN4/Forms/AllItems.aspx?viewpath=%2Fteams%2Fecc%2DTheBuildingsForum%2FHoneywellWEBs%2FWEBsN4&id=%2Fteams%2Fecc%2DTheBuildingsForum%2FHoneywellWEBs%2FWEBsN4%2FCIPer%20Model%2030%20Controller


HONEYWELL CIPer MODEL 30 SYSTEM ENGINEERING USER GUIDE 

About This Guide Abbreviations 

31-00237EFS - 02 | 9  

RSTP Rapid Spanning Tree Protocol 

STP Spanning Tree Protocol 

DNS Domain Name System 

UTP Unshielded Twisted Pair 

HOA Hand Off Auto 

AIA Adaptive Integral Action controller 

PID Proportional Integral Derivative 

tr throttling range 

CPH Cycles per Hour 

A Ampere-Current Unit 

Hz Hertz-Frequency Unit 

GB Gigabytes 

TUNCOS Time Until Next Change of State 
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ABOUT HONEYWELL WEB-C3036 or CIPer Model 30 CONTROLLER 

CIPer Model 30 is a unitary IP edge controller (interchangeably called IPC or ipc) designed by Honey-

well. 

The controller device series is WEB-C3036. It is designed for Variable Air Volume (VAV), unitary and 

plant applications. You can use the CIPer Model 30 controller for aggregating the real-time infor-

mation—alarms, trends, and history. In future, the controller will also be able to further integrate the 

aggregated information to the Sentience Cloud for value-added data analytics. 

Features 

• Native Niagara N4 for faster programming, installation, and commissioning 

• No tools needed for installation of CIPer Model 30 controller mounting 

• Spyder to CIPer (Model 30) Migrator Tool 

• Integrate variety of IP devices (cameras, access control, etc.) 

• Scalable, can expand I/O count to 15 additional expansion modules 

• 4-port IP unmanaged switch for maximum flexibility 

• Utilizes lower cost CAT5 or CAT6 IP cabling 

• Faster installation using pre-terminated CAT5 or CAT6 cables 

• On-board H-O-A switches for easy commissioning 

• VAV model includes on-board differential pressure sensor 

• Digital outputs can drive 1.5A Continuous current, 3.5A inrush current for 100 mS 

• Niagara N4 License included, good for 150 external points and 3 devices. Expandable 

• 1 Gigabit per second (Gbps) IP switch supports demanding IP peripherals such as color cam-

eras 

• On-board programming platform 

• Web-serving capability 

• Integrated Control: The web server and controller have a combined package in the CIPer Model 

30 controller 

• Data logging 

• Alarming 

• Trending 

• Schedule management 
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Controller and Expansion I/O Model Number Details 

There are two variants in CIPer Model 30 controller. 

1. WEB-C3036EPUBNH  

2. WEB-C3036EPVBNH 

The following table describes the WEB-C3036 series pin slots and its meaning. 

Table 1: WEB-C3036 Series Pin Slots 

Attribute 
Variants 

WEB-C3036EPUBNH WEB-C3036EPVBNH 

Brand Identifier WEB WEB 

Controller C C 

Analog Inputs 3 3 

Digital Inputs 0 0 

Analog Outputs 3 3 

Digital Outputs 6 6 

Ethernet E E 

Programmable P P 

Unitary vs VAV U V 

BACnet B B 

No Actuator N N 

The CIPer Model 30 controller is compatible with two expansion or external I/O models. 

1. WEB-O9056H  

2. WEB-O3022H 

The WEB-O9056H module is a large expansion module and the WEB-O3022H module is a small ex-

pansion module. 
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Table 2: I/O Models in CIPer Model 30 

Attribute Model 

WEB-O9056H WEB-O3022H 

Brand identifier WEB WEB 

Expansion I/O Module O O 

Analog Inputs 9 3 

Digital Inputs 0 0 

Analog Outputs 5 2 

Digital Outputs 6 2 

Hand Off Auto H H 

License Limits 

The Honeywell CIPer Model 30 controller comes with features that are license-controlled. 

• CIPer Model 30 controller (WEB-C3036EPUBNH / WEB-C3036EPVBNH) has 150 points Ni-

agara N4 license. You cannot use the CIPer Model 30 programming model with other devices 

other than CIPer Model 30 controller. 150 points also include data sharing points from third 

party BACnet devices using BACnet devices. 

• Expansion I/O device (WEB-O9056H and WEB-O3022H) supports 15 devices and additional 

license for 50 I/O points. 

• Sylk device limitation is 7. See SylkDevices section under Sylk Device Programming. 

• Function Block maximum limitation is 5000. You can add more than 5000 blocks till there is 

memory in CIPer device, but the controller may take more than 1 second execution time when 

more than 5000 blocks are added in the Sequenced Control Program. 

 
Note:   

To validate the license that you have, see Managing License section under Managing Software and 

Licenses. 
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Hardware Input Specifications 

Universal Inputs (configurable): 3 UI 

3 UI/AOs configurable as UIs  

Differential pressure sensor range (VAV model): 0-2” WC (0 to 374 Pa) 32 to 122F (0 to 55C) 

Pulse Inputs: 100Hz max, minimum duty cycle: 5 mS ON / 5 mS OFF 

Flexible UI’s to connect external sensors like 20KNTC, PT1000, and other resistive sensors. 

Range (voltage/current): 

• Rated voltage: 20-30 VAC; 50/60Hz 

• WEB-C3036EPVBNH Power consumption (AC): 

- 50 VA maximum for controller only load 

- 100VA maximum for controller and all connected Loads 

• WEB-O9056H: 35VA 

• WEB-O3022H: 15VA 

For example, you can configure temperature sensor C7041N2020/U as 20 KNTC in UI/UI/AO port. 

Hardware Output Specifications 

Analog Outputs (configurable): 3 UI/AOs configurable as AO 

Digital Output voltage rating: 20 to 30 VAC @ 50/60 Hz 

Digital Output current rating: Solid-State Relay, 1.5A Continuous, 3.5A Inrush for 100 mS. 

For example, you can configure damper actuator AFB24-MFT N4H as 20 KNTC in UI/UI/AO port. 
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Sylk Device Support 

A brief view to the different wall modules supported in CIPer Model 30 programming model and the 

parameters that these modules support is as follows: 

Table 3: Sylk TR120X Modules and Parameters 

Parameter 

Module-TR120X 

TR120BusWallModule TR120HBusWallModule 

ROOMTEMP Y Y 

HUMIDITY N Y 

OccupancyOverrideCommand Y Y 

ValueFromWallModule Y Y 

TimeOfDay Y Y 

SystemStatus Y Y 

OccupancyStatus Y Y 

ValueFromController Y Y 

SystemCommand Y Y 

TimeField Y Y 

BypassTime Y Y 

SensorOffset Y Y 

HomeScreen Y Y 

NetworkSetpoint Y Y 

SylkTime Y Y 

FanCommand Y Y 

SylkSchedule Y Y 
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Table 4: Sylk TR7X Modules and Parameters 

Parameter 

Module-TR7X 

TR75HSBus-

WallModule 

TR75SBus-

WallModule 

TR71HSBus-

WallModule 

TR71SBus-

WallModule 

ROOMTEMP Y Y Y Y 

HUMIDITY Y N Y N 

OccupancyOverrideCom-

mand Y Y Y Y 

ValueFromWallModule Y Y Y Y 

TimeOfDay Y Y Y Y 

SystemStatus Y Y Y Y 

OccupancyStatus Y Y Y Y 

ValueFromController Y Y Y Y 

SystemCommand Y Y Y Y 

TimeField Y Y Y Y 

BypassTime Y Y Y Y 

SensorOffset Y Y Y Y 

HomeScreen Y Y Y Y 

NetworkSetpoint Y Y Y Y 

SylkTime Y Y Y Y 

FanCommand Y Y Y Y 

SylkSchedule Y Y N N 
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Table 5: Sylk TR4X Modules and Parameters 

Parameter 

Module-TR4X 

TR42H

CO2SB

usWall-

Module 

TR42H

SBus-

Wall-

Mod-

ule 

TR42C

O2SBus

Wall-

Module 

TR42SB

usWall-

Module 

TR40HCO

2SBus-

WallMod-

ule 

TR40H

SBus-

Wall-

Module 

TR40CO

2SBus-

Wall-

Module 

TR40S

Bus-

Wall-

Module 

ROOMTE

MP 
Y Y Y Y Y Y Y Y 

HUMIDITY Y Y N N Y Y N N 

CO2 Y N Y N Y N Y N 

Occupan-

cyOver-

rideCom-

mand 

Y Y Y Y N N N N 

Occupan-

cyStatus 
Y Y Y Y N N N N 

Bypass-

Time 
Y Y Y Y N N N N 

Net-

workSet-

point 

Y Y Y Y N N N N 

FanCom-

mand 
Y Y Y Y N N N N 

Table 6: Sylk Zeleny Modules and Parameters 

Parameter Module 

C7400S (Zeleny) 

ROOMTEMP Y 

HUMIDITY Y 

Y: Yes  N: No 
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Sylk Device Limits 

The CIPer Model 30 controller does not support Sylk I/O, TR70, TR70H, and Zelix devices. 

Power and Grounding Requirements 

The CIPer Model 30 controller requires 20-30 VAC, 50/60Hz. Power consumption is based on the sum 

of the VA rating for each controller and should not exceed 100VA. If additional modules are required, 

they must be powered from a separate transformer. Refer VA rating for each module in the following 

note. 

 
Note:   

Transformer VA load for module power only (no BO loads) 

• WEB-C3036EPVBNH: 50VA 

• WEB-O9056H: 35VA 

• WEB-O3022H: 15VA 

For more details on power and grounding, see CIPer Software Tool Installation and Operations Guide. 

Power Slaves 

The following table lists all of the current Sylk Power Slave devices. 

Device Base OS 

Numbers 

Addresses 

Available 

Device Max Power 

or Avg/Peak Cur-

rent Req’t  

Total Bus 

Power or 

Avg/Peak 

Current 

Normalized 

Value 

(To-

tal=1.000) 

Zio Plus/En-

hanced 

TR71 

TR75 

TR71-H 

TR75-H 

1-10 230 mW 950 mW 0.242 

Zio Lite TR40 

TR40-H 

1-15 6.5 mA (avg cur) 72 mA 0.090 

Zio Lite with CO2 TR40-CO2 

TR40-H-CO2 

1-15 17.5 mA (peak cur) 96 mA 0.182 

Zio Lite with 

Small Display 

TR42 

TR42-H 

1-15 122 mW 950 mW 0.128 
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Zio Lite with 

Small Display 

with CO2 

TR42-CO2 

TR42-H-CO2 

1-15 20 mA (peak cur) 96 mA 0.208 

Jade Enthalpy 

Sensor 

C7400S100

0 

0-7 or 8-15 

(depending 

on setting by 

FFT) 

6.5 mA (avg cur) 72 mA 0.090 

TR120 TR120 

TR120-H 

1-15 523 mW 950 mW 0.55 
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NETWORKING REQUIREMENTS 

The CIPer Model 30 controllers are shipped from the factory with a default platform and station and all 

necessary items to run the station, along with a Tridium certificate. To start using the platform and the 

station inside it, you must change the default credentials for platform and station using commissioning 

process provided in the Connecting to Default Platform and Station section of the CIPer Software Tool 

Installation and Operations Guide. Once the default credentials are changed, you can use the device. 

 
Note:  

The CIPer Model 30 controllers comes within built DIP Switch feature, before configuring IP setting 

make sure all DIP switches are in off position.. 

 

Default IP Address 

The factory-shipped state of a controller has the following default settings for IP address, HTTP port, 

and platform credentials. 

IP Address 

When shipped, a new CIPer Model 30 controller is pre-configured with an IPv4 address in the range: 

192.168.1.160. 

Default subnet mask: 255.255.255.0 

You change these IPv4 network settings while starting up the commissioning of the CIPer Model 30 

controller.  

HTTP Port for Platform Access 

When shipped, the platform daemon of CIPer Model 30 is configured to listen on HTTPS port 5011. 

Often, this is left at default. However, if a different port is needed for a platform connection (perhaps 

for firewall reasons), you can change this during the commissioning of the CIPer Model 30. 

Platform Daemon Credentials 

Any CIPer Model 30 controller is shipped with default platform daemon (administrator) credentials. 

Default platform credentials: 

• Username: honeywell 
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• Password: webs 

Default station credentials: 

• Username: admin 

• Password: Admin12345 

• Passphrase: Honeywell1 

Initially, you need to use the default credentials (User ID and Password) to open (login to) a platform 

connection to the CIPer Model 30. During the startup commissioning, you must replace this platform 

administrator account with at least one different platform administrator user. Make sure to guard the 

credentials for such platform users closely. 

 
Note:  

The Niagara 4 Commissioning Wizard does not allow you to commission and startup a controller while 

retaining the factory platform user.  

Protocols 

The communication protocols supported in the CIPer Model 30 are separated into two categories 

• Network-Level 

• Controller-Level 

Controller-Level 

Fox/Foxs (Fox-secure) 

Tridium’s proprietary TCP/IP protocol used for station-to-station and Workbench-to-station commu-

nication. The Fox Service in each station defines the port to use and manages the access. 

HTTP/HTTPS (HTTP-secure) 

Standard protocol used by web browsers to access station web pages. The Web Service facilitates com-

munication over HTTP. 

Niagarad/platformtls (secure niagarad) 

Tridium’s proprietary protocol used for Workbench-to-daemon communication. In the Supervisor sta-

tion, Niagarad also communicates with the Provisioning Service. This service automates the perform-

ing of tasks on remote controllers.  

Field Bus protocols: 

o BACnet/IP: To connect with other BACnet devices over IP network 

o Panel Bus: To connect with panel bus I/O devices 

o Sylk: To connect with Sylk devices 
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Network- or Ethernet-Level 

Cable Type and Length: Use an approved Category 5e or better Ethernet drop cable with RJ-45 plugs. 

Use professionally manufactured cables of no more than 328 feet (100 meters). 

Rapid Spanning Tree Protocol (RSTP) 

It is a network protocol which facilitates with a loop-free topology for Ethernet networks. RSTP is faster 

than STP in terms of convergence when topology changes occur. The loop-free topology ensures that 

there is no broadcast storms and duplicate frame transmission. 

The supported configuration for RSTP is as follows: 

• Disable or enable STP: Disable or enable the spanning tree protocol. 

• Bridge Priority: The bridge priority range for forwarding the packets varies from 0 to 61410, 

lower value means high priority. 

• Port Priority: The port priority range varies from 0 to 240, lower value means high priority. 

• Hello Time: The time varies from 0 to 10 seconds. You can set the time interval between trans-

missions of configuration messages by the root device, thus ensuring that the switch is func-

tioning. The default hello time is 2 seconds. 

• Maximum Aging Time: The aging time varies between 6 and 40 seconds. You can set the max-

imum aging time value to ensure that the old information packets do not circulate endlessly 

through the same path in the network. 

• Forward Delay: The forward delay value varies from 4 to 30 seconds. You can set the maximum 

amount of time for which the root device waits before changing the states. The default forward 

delay value is 20 seconds. 

When user changes multiple properties, CIPer Controller will get rebooted for the first property change 

and will not save other properties.  You need to invoke the action “Apply RSTP settings” action to save 

the data to the CIPer Controller. And if you have set reboot to true, CIPer controller will get rebooted 

after saving the data. 

 

Spanning Tree Protocol (STP) 

It is a network protocol which facilitates with a loop-free topology for Ethernet networks. STP is slower 

in comparison with RSTP. 

Dynamic Host Configuration Protocol (DHCP) 

It is network management protocol, where the DHCP server dynamically allocates an IP address to the 

network devices or systems, so that all the device in the network communicate with each other. 
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Domain Name System (DNS) 

The DNS translates the domain name of a network system or device into numeric IP address, which is 

required for identifying a specific device in the network. 

TCP/IP Configuration 

The TCP/IP configuration step enables you to review and adjust the TCP/IP settings for a platform. 

 

Figure 1: TCP/IP Configuration Wizard 

 
Note:   

IPv6 support is available; however, this document focuses on IPv4 configuration. 

Configuring TCP/IP Settings 

While configuring the TCP/IP properties, do the following: 

1. Review the Interface 1 settings on the IPv4 Settings tab, which includes the temporary factory-

shipped IP address. 

2. Enter a unique IPv4 address for the network. No other device on this network should use this IP 

address. 

3. Enter the appropriate subnet mask used by the network. 
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Alternatively, if the network supports Dynamic Host Configuration Protocol (DHCP), you can 

enable it by selecting the DHCPv4 option. In this case, the IPv4 Address and IPv4 Subnet Mask 

fields become read-only. 

 
Note:   

• Generally, static IP addressing is recommended over DHCP for stability. If DHCP is pre-

ferred, an IP address Reservation should be entered for the CIPer Model 30 in the 

DHCP server and the CIPer Model 30 IP address should not change. 

• Do not enable DHCP unless you are sure that the network has the DHCP servers. Oth-

erwise, the CIPer Model 30 controller may become unreachable over the network. 

• In case you forget the IP address of the CIPer Model 30, you can connect to the device 

using serial mode of communication to know the IP address of the controller. 

4. Review, and if needed adjust other TCP/IP settings, which (in the order of importance) include: 

• IPv4 Gateway — The IP address for the device that forwards packets to other networks or 

subnets. 

 
Note:   

The CIPer Model 30 controller supports only one gateway for all adapters. This includes the 

CIPer Model 30 Wi Fi Adapter in Client mode. 

• DNS Domain Name — The name of the network domain. If it is not applicable, leave blank. 

• DNSv4 Servers — The IPv4 address of one or more DNS servers. 

• Hostname — Default hostname may be localhost or enter another name you want to use 

for this host. If the hostname is entered, typically the name is unique for the domain. 

 
Note:   

In some installations, changing the hostname may result in unintended impacts on the net-

work, depending on how the DHCP or DNS servers are configured. If in doubt, leave host-

name at default. 

• Hosts File — Click control to expand and modify field. Format is a standard TCP/IP host file, 

where each line associates an IP address with a known host name. Each entry should be on 

an individual line. The IP address should be placed in the first column, followed by the cor-

responding host name. The IP address and hostname should be separated by at least one 

space. 

a. To add a line, click at the end of the last line and press Enter key on the keyboard.  

b. Enter the required data on the new line. 

c. To return to see all TCP/IP settings, click the control to collapse the edit field when 

done. 

5. Click Next to go to the next step.  
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Note:   

• The CIPer Model 30 controllers have four Ethernet ports with 1Gbps speed support, where 

you can configure IPv4 or IPv6 for interface-1 using TCP/IP Configuration section under Plat-

form. All four Ethernet ports also work as Ethernet switch. 

• You can connect to CIPer Model 30 platform using any of the four Ethernet ports and remain-

ing ports can be connected to IP based devices if needed. For example, IP Cameras, IP Ther-

mostats). You can also perform IP daisy chain by looping the Ethernet cable from one CIPer 

Model 30 programming model to another CIPer Model 30 programming model, because 

Ethernet ports work as switch. 

• You can enable DHCPv4 for interface 1 using TCP/IP Configuration section under Platform, 

if you want DHCP server to assign IPv4 automatically. 
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Network Topologies 

This section describes the network topologies that are used in CIPer Model 30 controller to communi-

cate with other devices in the network. 

Supported Cables 

The CIPer Model 30 controller supports four Ethernet ports. The Ethernet switch shall support: 

• IEEE 802.3 standard with category (CAT) 3,4,5,6 Unshielded Twisted Pair (UTP) wiring. 

• Segment length up to 80 percent of the maximum length allowed. IEEE 802.3ab supports maxi-

mum length up to 100 meters. 

• Up to 2 sequential CIPer Model 30 controller connections through IP wiring 

• Rapid Spanning Tree protocol (IEEE 802.1w) supports over 200 controllers on a daisy-chain bus 

with fewer home runs for faster and lower cost wiring. 

o Up to 40 controllers in a redundant ring configuration 

• for enhanced fault tolerance. 

• LAN star configuration. 

• Continuous communications bandwidth of up to 50 percent of maximum bps capacity of Gigabit 

Ethernet. 

Non-Failover (Daisy Chain) 

In non-failover, that is daisy chain connection type, if any of the device in the network fails, the devices 

next to the failed device also fail. 

For example, there are 10 devices in a network and device number 1 is the master device, which con-

nected to device 2, and device 2 is connected to 3, and so on. If device 5 fails to function, the device 

after 5, that is 6, 7, 8, 9, and 10 also fail to communicate with master device. 

Failover (Spanning Tree) 

In the failover or spanning tree connection type, the devices connected in the ring, communicate with 

each other. If one of the devices in the network fails or stops working, the rest of the devices continue 

to work and failure of one device does not affect the working of other devices. 

For example, there are 10 devices in a network and device number 1 is the master device, which con-

nected to device 2, and device 2 is connected to 3, and so on. If device 5 fails to function, all the devices 

in the network except 5 continues functioning and communicating with master device. 
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GETTING STARTED 

This section gives the information about the software tools that you need to download and install to 

start using CIPer Model 30 programming model. 

Digital Signature 

IMPORTANT: 

The Honeywell CIPer Model 30 software tool is signed. You can verify the signature using any OpenSSL 

tool. Following are the prerequisites and steps to verify the digital signature using OpenSSL community 

distribution. 

Prerequisites: 

1. Download the Honeywell public key “Honeywell_IP_Controller.crt” from The Honeywell Build-

ings Forum. 

2. Download the batch file “VerifyIPCToolsSignature_OpenSSL.bat” from The Honeywell Build-

ings Forum. This file has the commands to verify the module signature using the public key 

specified in Step 1. 

3. Download OPENSSL from the link - https://www.openssl.org/source/openssl-1.0.2o.tar.gz. 

4. Extract the file using any ZIP utility to get the folder-openssl-1.0.2o. 

5. In the extracted folder find the file “openssl.cnf”. 

6. Set Windows environment variable OPENSSL_CONF=<Path to openssl.cnf>, for example 

OPENSSL_CONF=C:\openssl-1.0.2o\apps\openssl.cnf 

To verify the signature: 

1. Place the files “Honeywell_IP_Controller.crt”, “VerifyIPCToolsSignature_OpenSSL.bat”, Honey-

well CIPer Model 30 software tool distribution/modules and signature file together at the same 

location. For example, following files are in one place. 

• Honeywell_IP_Controller.crt 

• VerifyIPCToolsSignature_OpenSSL.bat 

• honeywellFunctionBlocks-rt.jar 

• honeywellFunctionBlocks-rt.jar.sig 

2. Open the command prompt and navigate to the location where you saved the above files. 

3. Verify all the modules released to confirm their authenticity by executing the batch file.  

For example, verify “VerifyIPCToolsSignature_OpenSSL.bat” against a module, C:\Develop-

ment\38840-F1-IP-Products\Release&Demo\F1_SoftwareTool\Releases\CIPer_Signa-

ture_Verification_Process>VerifyIPCToolsSignature_OpenSSL.bat honeywellFunctionBlocks-rt.jar. 

4. OpenSSL verifies the module’s signature and printout the below verification details: 

https://honeywellprod.sharepoint.com/teams/ecc-TheBuildingsForum/HoneywellWEBs/WEBsN4/Forms/AllItems.aspx?csf=1&cid=b21c3b16%2Da56a%2D4843%2D9db3%2Dd7b5374dc0c8&FolderCTID=0x0120004F1B825D370A224FAE0DD94B9645FDFD&id=%2Fteams%2Fecc%2DTheBuildingsForum%2FHoneywellWEBs%2FWEBsN4%2FCIPer%20Model%2030%20Controller%2FDigital%20Signature
https://honeywellprod.sharepoint.com/teams/ecc-TheBuildingsForum/HoneywellWEBs/WEBsN4/Forms/AllItems.aspx?csf=1&cid=b21c3b16%2Da56a%2D4843%2D9db3%2Dd7b5374dc0c8&FolderCTID=0x0120004F1B825D370A224FAE0DD94B9645FDFD&id=%2Fteams%2Fecc%2DTheBuildingsForum%2FHoneywellWEBs%2FWEBsN4%2FCIPer%20Model%2030%20Controller%2FDigital%20Signature
https://honeywellprod.sharepoint.com/teams/ecc-TheBuildingsForum/HoneywellWEBs/WEBsN4/Forms/AllItems.aspx?csf=1&cid=b21c3b16%2Da56a%2D4843%2D9db3%2Dd7b5374dc0c8&FolderCTID=0x0120004F1B825D370A224FAE0DD94B9645FDFD&id=%2Fteams%2Fecc%2DTheBuildingsForum%2FHoneywellWEBs%2FWEBsN4%2FCIPer%20Model%2030%20Controller%2FDigital%20Signature
https://honeywellprod.sharepoint.com/teams/ecc-TheBuildingsForum/HoneywellWEBs/WEBsN4/Forms/AllItems.aspx?csf=1&cid=b21c3b16%2Da56a%2D4843%2D9db3%2Dd7b5374dc0c8&FolderCTID=0x0120004F1B825D370A224FAE0DD94B9645FDFD&id=%2Fteams%2Fecc%2DTheBuildingsForum%2FHoneywellWEBs%2FWEBsN4%2FCIPer%20Model%2030%20Controller%2FDigital%20Signature
https://honeywellprod.sharepoint.com/teams/ecc-TheBuildingsForum/HoneywellWEBs/WEBsN4/Forms/AllItems.aspx?csf=1&cid=b21c3b16%2Da56a%2D4843%2D9db3%2Dd7b5374dc0c8&FolderCTID=0x0120004F1B825D370A224FAE0DD94B9645FDFD&id=%2Fteams%2Fecc%2DTheBuildingsForum%2FHoneywellWEBs%2FWEBsN4%2FCIPer%20Model%2030%20Controller%2FDigital%20Signature
https://honeywellprod.sharepoint.com/teams/ecc-TheBuildingsForum/HoneywellWEBs/WEBsN4/Forms/AllItems.aspx?csf=1&cid=b21c3b16%2Da56a%2D4843%2D9db3%2Dd7b5374dc0c8&FolderCTID=0x0120004F1B825D370A224FAE0DD94B9645FDFD&id=%2Fteams%2Fecc%2DTheBuildingsForum%2FHoneywellWEBs%2FWEBsN4%2FCIPer%20Model%2030%20Controller%2FDigital%20Signature
https://honeywellprod.sharepoint.com/teams/ecc-TheBuildingsForum/HoneywellWEBs/WEBsN4/Forms/AllItems.aspx?csf=1&cid=b21c3b16%2Da56a%2D4843%2D9db3%2Dd7b5374dc0c8&FolderCTID=0x0120004F1B825D370A224FAE0DD94B9645FDFD&id=%2Fteams%2Fecc%2DTheBuildingsForum%2FHoneywellWEBs%2FWEBsN4%2FCIPer%20Model%2030%20Controller%2FDigital%20Signature
https://honeywellprod.sharepoint.com/teams/ecc-TheBuildingsForum/HoneywellWEBs/WEBsN4/Forms/AllItems.aspx?csf=1&cid=b21c3b16%2Da56a%2D4843%2D9db3%2Dd7b5374dc0c8&FolderCTID=0x0120004F1B825D370A224FAE0DD94B9645FDFD&id=%2Fteams%2Fecc%2DTheBuildingsForum%2FHoneywellWEBs%2FWEBsN4%2FCIPer%20Model%2030%20Controller%2FDigital%20Signature
https://www.openssl.org/source/openssl-1.0.2o.tar.gz
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Caution! You must trust the module authenticity only when you get the confirmation “Verified OK”. 

  

If the Niagara module is compromised, you get the following log, where verification has failed: 
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Connecting to Platform and Station with Default Credentials 

To know more see CIPer Model 30 Installation and Operations Guide. 

Connecting to Platform 

To open and connect to a platform: 

1. Navigate to the Nav tree and right-click My Host<host_id> and click Open Platform. The Connect 

window is displayed. 

 

Figure 2: Connect Window to Open Platform 

2. Select the session type either Platform TLS Connection (secured) or PlatformConnection (unse-

cured / standard) in the Type drop-down menu. 

3. Select the Host as IP in the Host drop-down menu. 

4. Enter the host Id in the input field next to Host. By default, the application takes the host Id of your 

system. If you select the secured platform type, the default port number is 5011 and if you select 

the unsecured planform type then the port is 3011. 

 
Note:   

• The  (History) icon next to the host Id displays the list of host Ids used before. You can 

also select the host Id from the History drop-down menu. 

• Honeywell recommends use of TLS type connection for secure connection. 

5. Click Ok. The Niagara Identity Verification dialog box is displayed for the TLS connection. 
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Figure 3: Identity Verification Dialog Box 

6. Click Accept and the Authentication window is displayed. 

 

Figure 4: Authentication Window 

7. Enter the credentials and click Ok. You must login with your platform credentials. 

Connecting to Factory Installed Station  

The default station will be empty with IPC Network added to it. You can connect to the station and start 

using the device. The default credentials for station are: 

Username: honeywell 

Password: webs 
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Creating and Connecting to New Station 

To create and connect to a new station: 

1. Perform the steps to open a platform. 

2. Navigate to Tools drop-down menu and click New Station. The New Station Wizard is displayed. 

 

Figure 5: New Station Wizard 

3. Enter the name of the station. The Station Directory field, which is non-editable field, displays 

the location of the station. 

4. Select the NewControllerStation.ntpl template from the Station Templates and click Next. The 

next screen of the wizard is displayed. 

 

Figure 6: New Station Wizard 
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5. Click Set Password and Set Password window is displayed. 

 

Figure 7: Set Password Window 

6. Enter the password and confirm it by re-entering the same password in the Confirm field. 

7. Click Ok. 

8. Select the copy it to secure platform for “localhost” with Station Copier action to perform 

after completing the process for opening a station. 

 

Figure 8: New Station Wizard 

9. Click Finish to complete the process of opening a station. The application shows a status noti-

fication at the lower-right side of the screen. 

 

Figure 9: Status Notification After Opening Station 

The Station Copier screen is displayed, and then the Station Transfer Wizard is displayed as 

shown in the figure Station Transfer Wizard. 
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Figure 10: Station Copier Screen 

10. Select the options—START AFTER INSTALL and AUTO-START as required and click Next. 

 

Figure 11: Station Transfer Wizard 

 
Note:   

The AUTO-START option is disabled by default due to security reasons. You must enable it if 

required. 

11. Click Finish to complete the process of transferring the station from local device to localhost. 

The Open Application Director dialog box is displayed. 
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Figure 12: Open Application Director Dialog Box 

12. Click Yes and the application director is displayed with the station that you created in the list of 

stations along with station details like name, type, status, and so on. 

 

Figure 13: Application Director 

13. Select the station to start.  

14. Clear or select the Auto-Start and Restart on Failure check boxes as required. 

15. Click Start to start the station. 
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Signing into Station 

To sign in to and set up a station: 

1. Navigate to the Nav tree and right-click <IP address of CIPer> and click Open Station. The 

Connect window is displayed. 

 

Figure 14: Connect Window 

2. Select the station type as Platform TLS Connection (secured) or Platform Connection (unse-

cured / standard) in the Type drop-down menu. 

3. Select the host as IP in the Host drop-down menu. 

4. Enter the host Id in the input field next to Host. By default, the application takes the host Id of 

your system. If you select the secured platform type the default port number is 5011 and if you 

select the unsecured planform type, the port is 3011. 

 
Note:   

The  (History) icon next to the host Id displays the list of host Ids used before. You can 

also select the host Id from the History drop-down menu. 

5. Click Ok. The Authentication window is displayed. 

 

 



HONEYWELL CIPer MODEL 30 SYSTEM ENGINEERING USER GUIDE 

GETTING STARTED Creating and Connecting to New Station 

31-00237EFS - 02 | 35  

Figure 15: Authentication Window 

6. Enter the credentials and click Ok. You must login with station credentials. 

7. Expand the Station and navigate to Config > Drivers. 

 

Figure 16: Nav Tree View 

You can do the programming as required in the Sequenced Control Program and Event Control 

Program folders under IPCNetwork folder. 

Resetting to Factory Defaults 

In case you forget the station credentials, you can reset to the factory defaults. Follow the below steps 

to reset CIPer 30 controller to default factory setting. 

NOTE:  Since this operation performed in  bootloader, the controller must be  running in bootloader.  

1. Connect the CIPer 30 controller with serial console using terminal emulators tool (for 

example Putty). 

NOTE: The supported baudrate on CIPer 30 devices is 115200 bps. 
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2. After configuring CIPer 30 controller with serial console, power cycle the device.  

3. When system displays Hit any key to stop autoboot, type passphrase enter and 

press Enter key on the keyboard. 

NOTE: Complete the step (3) within 5 seconds. If fail to enter, system will continue au-

toboot.  

  

 

This action redirects you to factory reset menu and conformation message is displayed 

“Are you sure to reset to factory defaults? <Y/N>” 

 

4. Type Y and press Enter key on the keyboard, this action reset controller to default fac-

tory settings. 

Wait until the LED shows the device is working properly. Do not power off the controller 

during the reset process or the controller will be damaged permanently. 
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This completes CIPer Model 30 Controller factory reset.   

Opening and Using Palette 

To open and use a palette: 

1. Navigate to Window > Side Bars > Palette to open the palette pane. The palette pane is dis-

played at the lower left side of the screen. 

 

Figure 17: Palette Pane 

2. Click  (Open Palette). The Open Palette window is displayed. 

 

Figure 18: Open Palette Window 

3. Select the module ipcProgrammingTool from the list or type the module name in the input 

field to open the palette, and then click Ok. To select multiple modules, hold the Ctrl key on the 
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keyboard and select the required modules. This adds the selected module to the palette drop-

down menu and the palette pane displays the selected palette. 

You can also use the Browse button on the Open Palette window to select the path of the mod-

ule file from the device if you know the module location.  

See To open module file using Browse button. 

 

Figure 19: ipcProgrammingTool Palette Objects 

 
Note:   

To open another palette, click the palette drop-down menu and select the required palette if 

present, or open it by clicking the Open Palette icon. 

To close the opened palette, click  (Close Palette). 

To view the preview of an item inside the object in the palette, select the item, and then click 

 (Preview). The preview of the selected item is displayed at the lower side of the palette 

pane. 

 

 
Note:   

• To open another palette, click the palette drop-down menu and select the required 

palette if present, or open it by clicking the Open Palette icon. 

• To close the opened palette, click  (Close Palette). 
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• To view the preview of an item inside the object in the palette, select the item, and 

then click  (Preview). The preview of the selected item is displayed at the lower 

side of the palette pane. 

4. Navigate to the Drivers folder in the Nav tree. 

5. Drag and drop the IPCNetwork object from the ipcProgrammingTool palette into the Drivers 

folder. The IPCNetwork folder is displayed under the Drivers folder along with NiagaraNetwork 

folder. 

6. Expand the IPCNetwork folder and navigate to LocalDevice > Points. The Points node contains 

two folders 

• SequencedControlProgram - The SequencedControlProgram folder is used for Hon-

eywell function blocks (honFunctionBlocks) 

• EventControlProgram -  The EventControlProgram is used for kitControl components. 

 

Figure 20: Nav Tree View  
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Replacing Pre-Configured Station with User-Supplied Station 

You can transfer the station by using station copier. 

To replace the pre-configured station by user-supplied station: 

1. Connect to the Platform and double-click Platform. The Platform screen is displayed. 

 

Figure 21: Platform Screen 

2. Double-click Station Copier. The Station Copier screen is displayed along with stations on your 

computer and default station running in the CIPer Model 30 controller. 

 

Figure 22: Station Copier Screen 

3. Select the required station to copy to the localhost from the stations available on your com-

puter. 

4. Click Copy. The Station Transfer Wizard starts copying the station to the CIPer Model 30 con-

troller. 
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Figure 23: Station Transfer Wizard  

5. Enter a name for the new station and click Next. The Station Transfer Wizard inform about the 

deletion of the existing the station in the remote host. 

 

6. Click Next, if you want to delete the existing station and replace it with new station. 

You can also delete the existing station in the remote host (CIPer Model 30) before you start 

copying the new station by selecting the station in the remote host and clicking Delete. 
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7. Click Next. 

 

8. Click Finish. The Transferring Station Wizard is displayed where all the applications are 

stopped, existing station is deleted, and new user-specified station is copied. 
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Figure 24: Successful Transferring Station 

The Open Application Director window is displayed. 

9. Click Yes. 

 

Figure 25: Open Application Director Window 

The user-created station is displayed on the Application Director screen and you can start using 

the newly copied station. 
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Connection Between Two CIPer Controllers Through Niagara Network 

You can connect two different CIPer controllers in the workbench through Niagara Network. 

1. Open the Niagara workbench. 

2. Connect to the required platform and station. 

3. Navigate to NiagaraNetwork folder under Station > Config > Drivers, double-click Ni-

agaraNetwork. 

 

Figure 26: NiagaraNetwork Folder 

4. Click Discover to discover the station in the platform of another controller. 

 

Figure 27: List of Discovered Stations 

5. Locate the required station to connect and drag and drop it from the Discovered pane to the 

Database pane. The Add window is displayed. 
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Figure 28: Add Window 

6. Enter the username and password of the station in the respective fileds. 

7. Click OK. The station is now added to the database. 

You can check the connection between two stations of different controllers by right-clicking 

the station and then selecting Actions > Ping. 
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Connecting Multiple CIPer 30 Controllers using RSTP Configuration  

You can connect to multiple CIPer 30 controller using RSTP configuration. RSTP loop (i.e. RING topol-

ogy) with 40 number of CIPer 30 IP controllers with maximum load in each controller. To configure and 

connect all CIPer 30 controllers in Workbench. For RSTP Configuration Setting refer Rapid Spanning 

Tree Protocol (RSTP) 

 

Figure 29: RSTP Configuration – 40 CIPer 30 Controllers and router connected to a single Network 

Switch  
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Connecting Multiple CIPer 30 Controllers using Daisy chain loop  

To connect the CIPer 30 Controllers in a daisy chain loop you need to add Port Configuration Property 

under Local Device from the IPC Programming Tool palette.  For port configuration details refer to Port 

Configuration 

 

Figure 30: IP Daisy Chain Configuration – N number of CIPer 30 Controllers connected to single 

Network Switch (Full load) 

 

 
Note:   

You can add any IP compatible devices (ex.- Edge Devices) in the spare Ethernet port. 

Rapid Spanning Tree protocol (IEEE 802.1w) supports over 200 controllers on a daisy-chain bus with 

fewer home runs for faster and lower cost wiring. 

o Up to 40 controllers in a redundant ring configuration 
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MANAGING SOFTWARE AND LICENSES 

This section gives information about how you can manage the CIPer Model 30 application licenses and 

certificates. 

The access rights in CIPer Model 30 are set to default for the administrator users and can be modified 

by the user who is responsible for configuring the CIPer Model 30. 

Managing License 

To see the license details or validate your license, navigate to Platform in the Nav tree and double-click 

License Manager. The License Manager screen is displayed. The details include the host address and 

ID of the system, brand ID, and list of license and certificate files. The host ID is unique for each con-

troller. 

 

Figure 31: License Manager Screen 

License Manager 

The capabilities that License Manager provides are as follow: 

• Importing License 

• Exporting License 

• Viewing License 
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• Deleting License 

• Importing Certificate 

• Viewing Certificate 

• Deleting Certificate 

Importing License 

You can import license by importing one or more licenses from files, local license database, and licens-

ing server.  

To import a license: 

1. Navigate to Platform in the Nav tree and double-click License Manager. The License Manager 

screen is displayed. 

2. Under Licenses section, click Import. The Import License window is displayed. 

 

Figure 32: Import License Window 

• Import one or more license from files: To import license from the local file 

• Import license from the local license database: To import license from the local database. 

This option is enabled when there is a local license database. 

• Import AX Supervisor (Honeywell Webs 4.7) licenses from the licensing server: To import 

license from the licensing server in case there are no license present in the local files and 

databases. When you select this option for importing license, the application displays fol-

lowing window to restart the station. 
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Figure 33: License Complete Dialog Box 

3. Select the required option to import the license. 

4. Click Ok. The Select File window is displayed. 

 

Figure 34: Select File Window 

5. Navigate to the required path where the license file is present. 

6. Select the required license file and click Ok. The import status is shown in the window displayed. 
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Figure 35: Licenses and Certificates Already Current Dialog Box 

7. Click Ok. 

Exporting License 

To export a license: 

1. Navigate to Platform in the Nav tree and double-click License Manager. The License Manager 

screen is displayed. 

2. Under Licenses section, click Export. The Save License As window is displayed. 

 

Figure 36: Save License As Window 

3. Navigate to the required path where you want to save the license file, and click Ok. 

 

Figure 37: File saved Dialog Box 

4. Click Ok. 

Viewing License 

To view a license details: 

1. Navigate to Platform in the Nav tree and double-click License Manager. The License Manager 

screen is displayed. 
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2. Under Licenses section, select the required license to view, and click View. The details of the 

selected license are displayed. 

Or double-click the required license. 

 

Figure 38: License Details 

3. Click Ok. 

Deleting License 

To delete a license: 

1. Navigate to Platform in the Nav tree and double-click License Manager. The License Manager 

screen is displayed. 

2. Under Licenses section, click the required license to delete, and click Delete. 

 

Figure 39: Delete Confirmation 

3. Click Yes to confirm the license deletion. 

Or click No, if you do not want to delete the license. 

Importing Certificate 
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To import a certificate: 

1. Navigate to Platform in the Nav tree and double-click License Manager. The License Manager 

screen is displayed. 

2. Under Certificates section, click Import. The Select File window is displayed. 

 

Figure 40: Select File Window 

3. Navigate to the required path where the certificate file is present. 

4. Select the required certificate file and click Ok. The import status is shown in the window dis-

played. 

 

Figure 41: Licenses and Certificates Already Current Dialog Box 

5. Click Ok. 

Viewing Certificate 

To view a certificate details: 

1. Navigate to Platform in the Nav tree and double-click License Manager. The License Manager 

screen is displayed. 

2. Under Certificates section, select the required certificate to view, and click View. The details of 

the selected certificate are displayed. 
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Or double-click the required certificate. 

 

Figure 42: Certificate Details 

3. Click Ok 

Deleting Certificate 

To delete a certificate: 

1. Navigate to Platform in the Nav tree and double-click License Manager. The License Manager 

screen is displayed. 

2. Under Certificates section, click the required certificate to delete, and click Delete. 

 

Figure 43: Delete Confirmation 

3. Click Yes to confirm the certificate deletion. 

Or click No, if you do not want to delete the certificate. 

Version Compatibility 

The version compatibility is similar to Webs. For more information on the operating system, browser, 

and other compatibility details, see CIPer Model 30 Installation and operation guide and Niagara 4 

Installation Guide. 
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MIGRATING EXISTING SPYDER APPLICATIONS 

With Spyder To IPC Migrator tool, you can migrate the existing Spyder applications to CIPer Model 30-

compatible applications. The file formats that you can migrate from Spyder backup using the IPC Mi-

grator tool are: 

• Station: To migrate Spyder controllers in the selected station to CIPer Model 30-compatible appli-

cations 

• Library: To migrate Spyder library to CIPer Model 30-compatible application library 

• Exported Library: To migrate exported Spyder libraries to CIPer Model 30-compatible applications 

• Custom Palette: To migrate custom palettes containing Spyder applications to CIPer Model 30-

compatible palette 

 
Note:   

• In the migration process, only the contents of ControlProgram are migrated, that is, only the 

control programs and its associated points present in the control program are migrated. The 

Niagara points that you have discovered in the Spyder application are not migrated to CIPer 

Model 30 application. So, if you need these points in the CIPer Model 30 application, you 

need to rediscover the points. 

• The IPC Migrator tool does not support Niagara AX version backups. See Prerequisites for 

more details. 

• If the time and schedule are defined in the wire sheet and TR75 also, only one time and 

schedule get migrated to CIPer Model 30 application. The default schedule, that is, original 

Schedule block is migrated. 

• When a function block contains both in and out parameters, a new user needs to create the 

loop between that function block and the source component, so that the changes made at 

one place reflect in the CIPer Model 30 application. If you are existing user and migrating 

your existing application to CIPer, the migration process creates the linking between the 

function block and the source component. When a Spyder application is migrated, the mi-

grator tool automatically creates the loop-back link to the component linking to an inout 

parameter. Refer following examples. 

• If any Network Setpoint is connected with the SBus wall module, after migration the setpoint 

output from the SBus all module bock will be connected with the Fallback of the Network 

Input to reflect the changes done in wall module in the network Input & vice versa. 
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Figure 44: Network setpoints associated with SBus Wall Module 

 

Figure 45: Network setpoints reverse connection with SBus Wall Module after migration 

SBusWallModule folder: 

In the migration process, the parameters present in the SBusWallModule are segregated as per their 

types. For example, after migration if you double-click the SBusWallModule block on the wire sheet, 

you can see different categories of parameters like sensors, setpoints, status, and so on. You can see 

all the sensor parameters available for the respective SBusWallModule by double-clicking the sen-

sors block. If you are creating a new application, you can segregate the parameters in any required 

manner. 
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Figure 46: SBusWallModule Function Block 

Parameters inside Sensors block 

Parameters are created under a folder (folder name is based on the category of a Sylk parameter) 

and category folder contains the Sylk parameters, which are present inside a folder, SylkDevice. In 

this case, it is SBusWallModule. 

  

Figure 47: Parameters Inside Sensors Block 
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Prerequisites 

CIPer Model 30 application is supported in WEBs N4 only. If your current Spyder program is on WEBs 

AX platform, you must upgrade it to WEBs N4 before you start migration. 

The prerequisites for the migration process are: 

• AX to CIPer Model 30 Migration: 

Step 1: Migrate the final backup of AX to N4.7. 

Step 2: Migrate the final backup of N4.7 to CIPer Model 30-compatible version 4.7. 

• N4 to CIPer Model 30 Migration: 

Step 1: Migrate the final backup of N4 (N4.1, N4.2, N4.3, or N4.4) to N4.7. 

Step 2: Migrate the backup from N4.7 to CIPer Model 30-compatible version 4.7. 
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Spyder to IPC Migrator Tool 

Follow the below steps to start migration process. Navigate to Tools > Spyder To IPC Migrator tool. 

 

Figure 48: Spyder To IPC Migrator tool in Tools Drop-Down Menu 

When you navigate to Tools > Spyder To IPC Migrator tool, default IPC Migrator tool window displayed. 

 

Figure 49: IPC Migrator Tool Window 
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Migration process from Spyder to Ciper 30 application consist of following steps: 

• Migrating Station 

• Migrating Library 

• Migrating Exported Library 

• Migrating Custom Palette 

• Copying Migration Results to CIPer Model 30 

• Limitations of Spyder to IPC Migrator Tool 

Follow the below steps to migrate the Spyder station to a CIPer Model 30-compatible format using IPC 

Migrator tool. 

Migrating Station 

To migrate a station: 

1. Select the file type as Station in the File Type drop-down menu. 

2. Click Browse next to the Select Niagara Home Directory field to select the path to the Ni-

agara home directory, where the list of stations is available. 

3. The Output directory input field displays the location, where the migrated applications are 

stored. By default, all the migrated applications are stored in the SequencedControlPro-

gram folder.  

4. Browse to the Output directory, where the migrated applications are stored. The migrated 

stations are stored in the MigratedStations folder. 

Following figure shows the file type as Station and the selected station to migrate. 

 

Figure 50: Station to Migrate 
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Migrating Library 

With the help of IPC Migrator tool, you can migrate the Spyder libraries to a CIPer Model 30-compatible 

format. 

To migrate a library: 

1. Select the file type as Library in the File Type drop-down menu. 

2. Click Browse next to the Select Niagara Home Directory field to select the path, where the list 

of libraries is available. 

3. Browse to the Output directory, where the migrated applications are stored. The migrated li-

braries are stored in the MigratedLibraries folder. 

Following figure shows the file type as Library. 

 

Figure 51: Library to Migrate 

Using Library file type under IPC Migrator tool you can migrate the following in the selected library: 

• Spyder devices 

• Applications 

• Macros, which contain some part of the application 

• SBus wall module 

Migrating Exported Library 

With Export Library option, you can convert the Spyder Export Library into CIPer Model 30-compatible 

Export Library of applications and on exporting the Spyder library, the application creates a folder with 

‘.slb’ extension containing migrated applications. 

To migrate exported library: 

1. Select the file type as Exported Library in the File Type drop-down menu. 

2. Click Browse next to the Select Niagara Home Directory field to select the path, where the list 

of exported libraries is available. 
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3. Browse to the Output directory, where the migrated applications are stored. 

Following figure shows the file type as Exported Library. 

 

Figure 52: Exported Library to Migrate 

The Export to file window enables you to select multiple items to export. 

 

Figure 53: Export to file Window 

Migrating Custom Palette 

With the help of the IPC Migrator tool, you can migrate the custom palette files containing Spyder ap-

plications. The migrated custom palettes are stored in the MigratedPalettes folder. 

To migrate exported custom palette: 

1. Select the file type as Custom Palette in the File Type drop-down menu. 

2. Click Browse next to the Select Niagara Home Directory field to select the path, where the list 

of custom palettes is available. 

3. Browse to the Output directory, where the migrated applications are stored. 



HONEYWELL CIPer MODEL 30 SYSTEM ENGINEERING USER GUIDE 

MIGRATING EXISTING SPYDER APPLICATIONS Spyder to IPC Migrator Tool 

31-00237EFS - 02 | 63  

 

Figure 54: Custom Palette to Migrate 

Copying Migration Results to CIPer Model 30 

In the migration process a .bog file is generated in the specified output directory. Once the migration 

process is completed, you can see multiple .bog files in the specified output directory. One .bog file 

represents one Spyder application. On expanding these .bog files, you can see IPCNetwork, which you 

can copy and paste to your new station. 

 
Note:   

You need to transfer KitControl modules (KitControl-rt, KitControl-ux and KitControl-wb) to F1 before 

performing copy paste of migrated IPCnetwork which contains numeric constant. 

 

 

Figure 55: Migrating Station 
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Figure 56: Successful Station Migration 

Navigate to C:\Users\user account\Niagara4.7\Webs\stations\MigratedStations. 

 

Figure 57: Tree View of bog File Generated after Migration 

Copy the logic present in the Sequenced Control Program folder under Nav tree and paste it into the 

Sequenced Control Program of the current station in CIPer controller. 
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Note:   

• Similarly, you can copy migration results of library, exported library, and custom palette file to 

CIPer. 

• It is recommended that you revisit or review the custom sensor linearization data entries after 

migration process. 

• After the migration process, the unassigned points are assigned to the valid terminals in the 

CIPer Model 30 software tool. 

• Enum names used in Physical points/Network points are not migrated. 

• Default value of enum is not migrated. First item in the enum is used as default value. 

• Niagara Alarm and History Extensions added to points are migrated and you need to configure 

those manually. 

Sylk: 

• Unassigned fixed Sylk point is migrated to a placeholder component (Zelix parameter). You 

need to correct the component, that is, replace Zelix parameter with an appropriate compo-

nent and its links accordingly. 

• Zelix Sylk Device block is not supported in CIPer Model 30 programming model. Zelix is con-

verted to a BZelixParam placeholder component. You need to correct the component, that is, 

replace Zelix parameter with an appropriate component and its links accordingly. 

• Sylk IOs if any, are migrated as physical inputs/outputs, and next available pin is assigned. 

COV of Sylk IO is not migrated. 

• TR70x device is migrated as TR71x. 

• Links to InOut parameters are not bidirectional. Explicit link is created automatically from Out 

slot of InOut parameter to source component which is connected to the InOut parameter. 

Function Blocks: 

• Alarm function block is migrated as NumericWritable with Out-of-range alarm extension. 

• PriorityOverride block is migrated as a NumericWritable component. 

• If the units of the same type of parameters connected with any function block are different 

then after migration unit converter block will be added ib between of the parameter and the 

function block For example if the Temperature setpoints connected to the Temperature Set-

point Calculator function block have different units then after migration the unit will remain 

same but unit converter block are added to convert the parameters unit to support the default 

unit of the function block of IPC programming tool palette  
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Figure 58: Temperature Setpoint Calculator Function Block 

 

Figure 59: Unit Converter addition after migration 
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IOs: 

• FloatingMotor output/Actuator type is migrated as periodic execution block of type BFloat-

ingMotor. 

• Pin assignment for physical inputs/outputs is not preserved during migration. After migration, 

next available pin is assigned. 

• Modulating Inputs of type CustomResistive/CustomVoltage are migrated as CustomSensor 

• Sensor Offsets for modulating inputs, if any, are picked up from the Bacnet interface during 

Library Application Migration. 

• Physical Outputs are migrated as NumericWritables. If the migrated application is a Bacnet 

application, the priority is picked up from Bacnet Object Advanced Settings. Else priority 12 is 

used as default priority.  

• Network Inputs/Outputs are migrated as NumericWritables. Any links to/from Network In-

puts/Outputs are linked to/from priority10 slot of the NumericWritable. 
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Limitations of Spyder to IPC Migrator Tool 

Following are the limitations in the migration process: 

Schedules: 

This limitation is applicable for the Weekday/Month for every year option in the Holidays tab. Here 

you can select a month and date of holiday and those details are migrated as they are. 

If the number in the Duration field is more than one then only the first day is migrated to CIPer 

Model 30 application, because of the complexity in directly mapping the rest of the days following 

the first day in Niagara 4 version. Remaining days are not migrated, and application shows an error 

message that you should separately migrate the schedule for remaining days. 

For example, you select January from the Select Holiday Start Month drop-down menu, LastSun-

day from the Select Holiday Start Day drop-down menu, and enter 3 as Duration. In the migration 

process, out of three last days of January, only one day is migrated, that is, Last Sunday of January. 

The remaining two days, that is Monday and Tuesday, are not migrated. 

Exception to the limitation: 

• If you click Load US Holidays, there can be some holidays which fall in the Weekday/Month for 

every year category, for example, Thanksgiving and Day After. In this scenario, the limitation 

related to migration of the schedule is not applicable and the schedule for all days mentioned 

in the Duration field is migrated. 

 

Figure 60: Spyder To IPC Migrator Tool Window 

• The Spyder schedule is converted into Niagara Schedule, and the Niagara Schedule does not 

contain TUNCOS (Time Until Next Change of State) functionality. To overcome this problem, 

after migration of schedule, the Application Folder is created with the same name of the sched-

ule. A tuncos block is created.in this folder. This block converts the Next Time of Niagara Sched-

ule into TUNCOS of Spyder Schedule. If the block is accidentally deleted, you must use the 

TUNCOS block present in the Utils folder in the ipcProgrammingTool palette. To know how to 

add Tuncos block, see to add Tuncos function block onto wire sheet section. 
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• If Spyder programming does not have any Schedule block in the logic, EnumSchedule is cre-

ated with default weekly schedule configuration and the component is present under Lo-

calDevice. 

 

Figure 61: Schedule Function Block 

 

Figure 62: Linking Between Schedule and Tuncos Function Blocks 

• Spyder to CIPer Migration will work fine only if the Spyder application being migrated has no 

validation errors. 
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HONEYWELL CIPer MODEL 30 PROGRAMMING MODELS 

The CIPer Model 30 software tool offers a graphical environment to program the Honeywell CIPer 

Model 30 programming model 

Using CIPer Model 30 software tool and all its components you can add a controller on the required 

network and create the application as per your requirement. 

Continuous Simulation mode is available for testing the application and its function offline. After com-

piling the program, you can perform operations such as download, upload, and online testing on live 

controller installed in the field. Following are the components of the CIPer Model 30 controller: 

Overview of Local Device Property Sheet 

This section provides brief about the components in the CIPer Model 30 controller. 

Network 

It is the communication channel used for CIPer Model 30 controller to communicate with CIPer de-

vices. The IPC network corresponds directly to physical network of the device. 

Device 

The local device represents the local interface to the IPC network. There is only one local device and you 

cannot delete or duplicate it. For example, LocalDevice in the CIPer Model 30 application. Following 

are the properties of the LocalDevice folder. 

Status 

This property reflects the status of the local device. This field is not editable. 

Enabled 

To enable or disable the local device. You can set it to true to enable and to false to disable. 

Fault Cause 

You can set the fault cause message. This field is not editable. 

Health 

The health of the local device contains information on the device state and time and date when that 

state was captured or noted, the condition of the local device-if it is in working condition or not (up or 

down), alarm, the last time when the local device was in Ok status, the last time when the local device 

was failed, and the cause of the failure. All these fields are not editable and are auto-generated. 
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Figure 63: Health Properties 

Alarm Source Info 

This section of the property sheet provides the details on the alarms. 

 

Figure 64: Alarm Source Info Properties 

Alarm Class 

Specifies or returns the alarm routing option for the component. 

Source Name 

Displays the name in an alarm record that identifies the source of the alarm. 

To Fault Text 

The text to display when the component transitions to a Fault status. When applicable, text entered for 

Fault Algorithm, High Limit Text and/or Low Limit Text may override this text.  
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To Offnormal Text 

The text to display when the component transitions to an Offnormal (alarm) state. When applicable, 

text entered for Fault Algorithm, High Limit Text and/or Low Limit Text may override this text. 

To Normal Text 

The text to display when the component transitions to a Normal status. When applicable, text entered 

for Fault Algorithm, High Limit Text and/or Low Limit Text may override this text. 

Hyperlink Ord 

Associates an ord, BLQ query or path with an alarm state on the component. When an alarm is reported 

in the console, the Hyperlink button activates. Clicking this button links to the location you specify here. 

Sound File 

The path to a sound file that plays when the current component is in an alarm state. Use the folder icon 

to browse to the file. Click the arrow icon to the right of the folder icon to test the path. 

Alarm Icon 

Defines the path to a graphic file the system includes in the Timestamp column of the alarm table in 

the Console Recipient view. Use the folder icon to browse for the file. Use the right-arrow to test the 

location you entered. 

Alarm Instructions 

Advice that accompanies the alarm notification (Alarm Record window) that provides important infor-

mation for the operator. Click the right-pointing arrow to view the instructions. 

Meta Data 

Allows you to enter new facets for the extension. 

FirmwareDetails 

The Firmware Details of the local device contains information on the firmware minor version, major 

version, installed patch version, installed build number, firmware health status, details of any fault oc-

currence, & its updating logs. 
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Figure 65: Firmware Details Properties 

Model 

Select the Model from the Model drop-down menu. 

 

Figure 66: Model Selection 

Modify the address as required. 

 

Figure 67: Device Address 

Maintenance Button 

The maintenance button will turn to True of the Maintenance button is pressed on the connected con-

troller. Once it becomes true the operator need to reset it to false by doing the mentioned steps. Select 

Maintenance Button-> Right click-> Action-> select Reset Maintenance Button Status. 

. 

Figure 68: Maintenance Button Properties 
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Figure 69: Maintenance Button Status Reset 

RSTP Configuration 

You can configure RSTP settings. 

. 

Figure 70: RSTP Configuration Properties 

Network Firewall Configuration 

The Network Firewall configuration will show the status of the Network Firewall.  

. 

Figure 71: Network Firewall Configuration Offline mode Properties 
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. 

Figure 72: Network Firewall Configuration Online Mode Properties 

Port Configuration 

For CIPer30 controller, outgoing traffic has no restriction, but all incoming IP traffics are restricted ex-

cept that allowed by the access rule. To define the access rule user need to change the Port Number, 

Port access rule, protocol via Port configuration option. To edit the port configuration, user need to drag 

NetworkPortConfig from Port Configuration folder of IPC Programming Tool palette and drop the same 

under the Network Firewall Configuration of the Local device  

. 

Figure 73: Port Configuration Properties 

Different services uses different port of TCP/UDP. And for some incoming service, source port is fixed; 

while for others destination port is fixed. Port access rule include two choices ‘Any Source Port to Spe-

cific Target port’ and ‘Specific Source Port to Any Target port’.  This configuration depends on the 

service. 

E.g. For SSH service, user start a SSH connection from PC using the protocol TCP and destination port 

22; so the rule is to allow Any Source Port to Specific Target port. CIPer 30 controller will listen on TCP 

port 22 and accept the incoming connection. 

While for DNS service, CIPer30 want to receive traffic from remote DNS server which has fixed source 

port udp/tcp 53. Now the rule is to allow Specific Source Port to Any Target port. And DNS service uses 

both TCP and UDP protocol, so two rules for TCP and UDP need to be added separately. 
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For incoming traffic, there is default rule for each CIPer 30 controller. By default, ICMP/ IPv6/ SSH/ 

NTP/ DNS/ DHCP/ Niagara platform/ Fox/ Foxs/ BACnet service related ports are allowed. Controller 

can receive these traffics from other devices. When you want to accept new service e.g. TFTP, then user 

need to manually add a new rule to accept the TFTP related port: UDP source port 69. You can drag 

Port Configuration to Network Firewall Configuration and set port number->69, rule->Specific Source 

Port to Any Target port, protocol->UDP and enable -> true. After that, right click the Network Firewall 

Configuration and apply port setting. 

 

Figure 74: Port Configuration Properties 
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Figure 75: Applying Port Configuration Properties 

If user modify the default port for some service e.g. BACnet 47808 to other ports, then user also need 

to modify the rule accordingly to make sure service can pass. 

 
Note:   

1. By default, BACnet port is disabled for security reason, to enable the BACnet port you need to 

man-ually enable BACnet UDP port and enter port number in hexadecimal format (example: 

For Port BAC 0 hex-adecimal port number is 47808) 

2. You can add multiple Port Configuration under one local device to make the specific device 

as Source and Target both 

3. By default, the CIPer 30 controller have Secure Fox connection. If you want to connect any 

device with standard/ non-secured Fox connection, then you need to disable the secured Fox 

connection from Fox services and the need to add access rules to the Network Firewall Con-

figuration. 

4. You cannot edit or delete configured port directly from Network Firewall Configuration. If you 

accidently delete or try to edit any configured port, system will restrict the operation, generat-

ing error message. 
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Sylk Configuration Download Status and Total Power consumption 

After adding the sylk device user can check the power consumption of the sylk device in the property 

sheet of the Local Device. Also, user can check if the sylk configuration is downloading status. 

 

Figure 76: Total Sylk Power Consumption data checking 

Sylk Alarm 

This will show the status of the Sylk bus whether any discrepancy are there in sylk device configuration 

. 

. 

Figure 77: Sylk Alarm Properties 

Points 

The Points node contains the Sequenced Control Program and Event Control Program. This option 

enables you to discover and configure the physical points in the CIPer Model 30 application. To add 

the devices to the database, you can use the Points folder. 
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Sequenced Control Program Container 

In this wire sheet, the value of the output changes continuously based on the execution of the function 

block in ascending order. The execution order of the function block can be changed anytime. See Order 

of Execution section. 

Event Control Program Container 

In this wire sheet, the value of the output changes only if there is a change in the input values. The 

function block gets executed based on the order of the changes in the input values. 

Views 

You can visualize the components in the system through views. Along with the Niagara-provided views, 

the CIPer Model 30 programming model provides the following views: 

• I P C Point Manager View: This view provides details information about the Physical Points  

associated with Local Device (CIPer Model 30 controller) and expansion IO Modules. 

• Wire Sheet View: You can write the logic in the wire sheet by using the CIPer Model 30 pro-

gramming model. 

• Sylk Parameter Summary View: This view provides detailed information about the Sylk param-

eters associated with the Sylk devices. 

• Commission Sylk Devices View: This view provides information about the errors in the config-

uration of Sylk parameters. 

I P C Point Manager View 

This view provides details information about the Physical Points associated with Local Device (CIPer Model 

30 controller) and expansion IO Modules. It displays details such as the associated Device Name, Device 

address, Pin Type, Terminal Number, Terminal Name & Description for Physical Points. You must convert 

the Physical Points to Niagara Points before using it in Control Program Logic. 

To access the IPC Point Manager View:  

In the Nav tree, browse to Station > Config > Drivers > IPCNetwork > LocalDevice > Points > right click 

Views > IPC Point Manager. 

 
Note:   

You must use ipcProgrammingTool from palette to write program in this wire sheet. To know more, see 

SEQUENTIAL PROGRAMMING. 

 
Note:   

You must use Kit Control from palette to write program in this wire sheet. To know more, see EVENT-

BASED PROGRAMMING. 
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Figure 78: I P C Point Manager Option in Views Menu 

The Discovered and Database tabs are displayed as shown in the following figure. 

 

Figure 79: I P C Point Manager View 

• New Folder: To add EventControlProgram folder 

• Edit: To modify the Niagara point added in the database 

• Discover: To discover the physical points present in the local device (CIPer Model 30 controller) 

and in associated expansion I/O devices 

• Add: To add the selected physical point to database 
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• Tagit: To tag the Niagara Points as per requirement for quick searching.  

Wire Sheet View 

You can write the logic in the wire sheet by using the CIPer programming model. 

Following are the steps to do this:  

1. Expand IPCNetwork in the Nav tree.  

2. Navigate to LocalDevice > Points.  

3. Select SequencedControlProgram or EventControlProgram as per requirement. 

4. Double-click the folder and the wire sheet is displayed. 

Or 

Right-click the folder > Views > Wire Sheet. The wire sheet is displayed on the right-side of the 

screen. 

Sylk Parameter Summary View 

This view provides detailed information about the Sylk parameters associated with the Sylk devices. It 

displays the details like associated Sylk Device Name, Category, Parameter Name, Slot Path, and the Type 

of the parameter. 

To access the Sylk Parameter Summary View: 

• In the Nav tree, navigate to Station > Config > Drivers > IPCNetwork > LocalDevice. 

• Right-click LocalDevice, click Views, and then select Sylk Parameter Summary. 

 

Figure 80: Sylk Parameter Summary Option Views Menu 
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The following details are displayed in the right-side of the screen. 

 

• Sylk Device Name: The associated Sylk device 

• Category: The category defined while configuring Sylk parameters. By default, it shows Category 

as category. 

• Parameter Name: The name configured while adding the parameter onto the wire sheet. 

• Slot Path: The path of the Sylk Parameter 

• Type: The type of the Sylk Parameter 

Commission Sylk Devices View 

This view provides information about the errors in the configuration of Sylk parameters. It displays the error 

message including the Sylk Parameter Name, Parameter ORD number, and the Type of the error. 

To access the Commission Sylk Devices View:  

1. In the Nav tree, navigate to Station > Config > Drivers > IPCNetwork > LocalDevice. 

2. Right-click LocalDevice, click Actions, and then select Commission Sylk Devices. 

 

Figure 81: Commission Sylk Devices Option in Actions Menu 
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The status notification of the commission Sylk devices action is displayed in the lower right side 

corner of the screen. 

 

Figure 82: Notification-Commission Sylk Devices 

3. Navigate to Window > Side Bars and select Jobs. 

 

Figure 83: Jobs Option in Window > Side Bars Menu 

4. Navigate to Jobs Palette and click  next to the required job. 

 

Figure 84: Jobs Palette 

The Job Log window is displayed. The job log contains details like status of the job, timestamp, and 

message. 
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Figure 85: Job Log 

The display provides the data regarding the Sylk Parameter Name, Parameter ORD number & the Type 

of the error. You can use the ORD number to locate the Point. 

 

Figure 86: Log Details Window 

  

 

Note:  

The job log generated after commissioning the Sylk device, displays all the validation errors, but the 

device level fault cause displays the latest fault cause only. 
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 I/O PROGRAMMING 

The CIPer Model 30 controller provides various input and output points for the configuration. Some 

points are on-board points, which are available on the controller itself, some points are expansion 

points, which as per requirement can be configured and used.  

• IPCNetwork: The IPCNetwork is the communication channel used for CIPer Model 30 control-

ler. The IPC network corresponds directly to physical network of the device. 

• ExpansionIODeviceExt: To add expansion IO devices 

 
Note:   

• Expansion I/O devices are added to LocalDevice folder only. 

• This device cannot be dragged onto the wire sheet. 

• Containers: This component provides folders, ApplicationFolder and EventControlProgram, to 

group or segregate the logic on the wire sheet for better understanding. 

 
Note:   

• Application Folder is for Sequenced Control Program only. You must not add the same 

into the EventControlProgram folder. 

• EventControlProgram folder is for Event Control Program only. You must not add the 

same into the SequencedControlProgram folder. 

• IOs: To configure the floating motor output 

• Function Blocks: To create the programming logic 
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IPC Network Component 

The IPCNetwork block in the CIPer Model 30 programming model provides following features: 

• Adding Network 

• Viewing or Modifying Controller Summary Details 

Adding Network 

To add an IPCNetwork:  

1. Click Window > Side Bars > Palette to add the Palette, if it is not visible on the screen. 

2. Drag and drop the IPCNetwork object from the ipcProgrammingTool palette to the Drivers 

folder in the Nav tree. The IPCNetwork folder appears in the Station > Config > Drivers 

folder in the tree. The Name window is displayed. 

 

Figure 87: IPCNetwork Name Window 

3. Enter a name for the IPCNetwork in the Name window or use the default name set by the 

application and click Ok. The IPCNetwork is added to the Drivers folder. 

 

Figure 88: IPCNetwork Added to Drivers 

 
Note:   

While running I/O programming, set IO Heart Beat value to 0 sec. This will disable IO Heart Beat. Once 

I/O programming completed and when the controller restart, you can set IOHeartbeat value to 8sec. 
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Viewing or Modifying IPCNetwork Components 

To view or modify IPCNetwork components: 

1. Double-click the IPCNetwork folder in the Nav tree. The Database tab is displayed with the 

device name and details. 

 

Figure 89: Local Device Name and Details in Database Tab 

2. Double-click the LocalDevice folder to modify the device name and status. The Edit window 

is displayed. 

 

Figure 90: Edit Window 

3. Modify the required details and click Ok to save the changes or click Cancel if you do not 

want to save the changes. 

4. Double-click the LocalDevice folder in the Nav tree to configure the LocalDevice proper-

ties. 
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Figure 91: Property Sheet of LocalDevice 

5. Modify the properties as required. See Overview of Major Components. 

6. Click Save to save the changes. 

Or Click Refresh, and then No, if you do not want to save the changes. 

 
Note:   

You can configure UI/AO as UI and UO. A UI can be configured as AI and BI, whereas, UO can be 

configured as AO and BO. 
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Local Device 

The I/O points which are present on the CIPer Model 30 controller are called on-board or local device 

I/O points. The on-board I/O points are present in the application by default. You need to add and con-

figure those I/O points into the database as per requirement. 

 

Figure 92: CIPer Model 30 Controller 

Following are the details of on-board I/O points available in the CIPer Model 30 controller: 

• WEBC3036EPUBNH: 3 universal inputs, 3 Universal I/O, 6 Binary Outputs, and HOA switches 

• WEBC3036EPVBNH: In-built Airflow Sensor, 3 universal inputs, 3 Universal I/O, 6 Binary Out-

puts, and HOA switches 

Configuring LocalDevice 

You can configure the on-board I/O point by changing the CIPer Model 30 controller model. 

To change the CIPer Model 30 controller model: 

1. Navigate to <Required Station> > Config > Drivers > IPCNetwork > LocalDevice. 

2. Double-click LocalDevice. The application displays the Property Sheet of the local device. 

3. Modify the details as required. 

• Select the Model from the Model drop-down menu.  

• Modify the address as required. 
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Figure 93: Property Sheet of Local Device 

4. Click Save. 

 
Note:   

To assign an unassigned Sylk parameter to a Sylk device, right-click the Sylk device, select Actions, and 

click Attach Unassigned Params. 

 

Figure 94: Attach Unassigned Params Action for Sylk Devices 

For example, you have two Sylk devices, TR75 and TR75H, added to the LocalDevice node. If you drag 

and drop the ROOMTEMP parameter to the wire sheet, it shows None in front of the sylkDevice field. 
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Now you can assign the ROOMTEMP parameter to the TR75 or TR75H Sylk device by either following 

the above-mentioned method or double-clicking the parameter on the wire sheet and assigning a Sylk 

device from the available list of applicable devices. Assume you have assigned the ROOMTEMP pa-

rameter to the TR75 Sylk device, and you delete the TR75 from the LocalDevice node, the ROOMTEMP 

parameter shows None in front of sylkDevice field. 

Future Implementation (not available for current Beta release): once the user has connected the con-

troller with the station then the slot for controller selection will be disabled and user will not be able to 

change the model type. If user wants to change the model type then user must disconnect the physical 

connection between controller and station, then change the mode type in offline mode.  

Expansion Devices 

The I/O points which you can add externally as an expansion to existing on-board points are called as 

expansion I/O points. The CIPer Model 30 programming model allows you to connect extra input and 

output connections along with the on-board I/O connections. The ExpansionIODeviceExt function 

block enables you to add the extra input/output (I/O) connections to the device. 

   

Figure 95: Expansion Device WEB-O3022H 
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Figure 96: Expansion Device WEB-O9056H 

Adding Expansion I/O Device 

You can add expansion I/O devices to the LocalDevice folder. 

To add expansion I/O: 

1. Navigate to the ExpansionIODeviceExt object in the ipcProgrammingTool palette. 

2. Drag the ExpansionIODeviceExt object and drop it under LocalDevice. 

3. Enter a name for the expansion I/O device and click Ok. 

Following are the details of I/O points available in Expansion I/O modules: 

• WEB-O3022H: 3 universal inputs, 2 universal I/O, 2 binary outputs, and HOA switches. 

• WEB-O9056H: 9 universal inputs, 5 Universal I/O, 6 Binary Outputs, and HOA switches. 

 
Note:   

• The CIPer Model 30 controller supports maximum 15 expansion I/O modules. 

• When you add more than one I/O device to the LocalDevice, the Address in the Property Sheet 

automatically increases by one. 

• You cannot directly swap the expansion I/O address. Enter a different address to one device, 

and then swap the address. 
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Figure 97: Expansion I/O Device Added to LocalDevice 

Configuring Expansion I/O Points 

You can configure the properties of an expansion I/O device to customize the I/O devices. 

To configure properties of expansion I/O: 

1. Navigate to <Required Station> Config > Drivers > IPCNetwork > LocalDevice. 

2. Double-click the required I/O device. The application displays the Property Sheet of the I/O 

device. 

3. Modify the details as required. 

• Set the Enabled to true or false. 

• Select the Model from the Model drop-down menu.  

• Modify the address as required. 
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Figure 98: Property Sheet of Expansion I/O Device 

4. Click Save. 

ExpIO Device Ping 

ExpIO Ping allows user to discover externally connected I/O points connected to CIPer 30. Also,it veri-

fies the configured of the Sylk device. 

To run ExpIO Ping, Navigate to the ExpansionIODeviceExt in Nav window > Actions > Ping. 

 

If no device discovered Status displays Down and Fault Cause shows No device found and ExpIO De-

vice stops read write operation. 

If unconfigured or defected device discovered Status displays Down and Fault Cause shows Incom-

patible device found and ExpIO Device stops read write operation. 

If the discovered device is compatible Status displays Ok and ExpIO Device performs read write oper-

ation. 
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Using On-Board and Expansion I/Os 

Following are the functions provided in I/O configuration of local and expansion devices: 

• Discovering on-board or expansion points in IPC 

• Adding on-board or expansion I/O points to database 

Discovering On-Board or Expansion Points in IPC 

You can discover the points as follows. 

To discover points in CIPer Model 30: 

1. Navigate to <Required Station> > Config > Drivers > IPCNetwork > LocalDevice. 

2. Double-click the Points folder. 

3. Click Discover. The application displays all the points present in the local device (CIPer Model 30 

controller) and expansion I/Os associated with the controller. The point names are displayed along 

with address, pin type, terminal number, terminal name, and description. The application also 

shows a pop-up notification with the status of the IPC Point Discovery at the lower-right side of the 

screen. 

 

 

Note:  

• If you change the device model after discovering the point in Niagara database, the application 

displays the Fault Cause-Invalid Terminal Number and error message-Error: NoSuchTerminal. 

Rediscover those points and drag and drop the points manually for the changed device. 

• The order in which the list of devices is displayed is first the on-board I/O local devices are 

displayed followed by the expansion I/O devices in the order same as displayed in the Nav 

tree. 

• You can configure the I/O devices in the CIPer Model 30 programming model without connect-

ing CIPer Model 30 device and the hardware points, that is, you can configure the I/O devices 

offline also. 
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Figure 99: IPC Point Discovery and Its Status 

Adding On-Board or Expansion I/O Points to Database 

After adding expansion I/O devices to the LocalDevice folder, it is necessary that you add the on-board and 

expansion I/O points to the database, so that the discovered points become the Niagara-compatible phys-

ical points. You cannot directly use the physical points onto the wire sheet until you add the points to the 

database. 

You can configure Universal Input/Output (UI/AO) point as input or output point as per requirement. Once 

the point is added to the database, you cannot change its type. Delete and add the same point again with 

the required configuration. 

To add expansion, I/O points to database: 

1. Discover the IPC I/O points. 

2. Double-click the required point. The application displays a window to add the device to the data-

base as shown in the following figure. 

Or 

Drag the required device and drop it into the Database tab. 
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Figure 100: Adding Local Device Point to Database 

 

Figure 101: Adding Expansion I/O Point to Database 

3. Modify the editable properties of the device as required. 

4. Click Ok.  

The action adds points into the database, you can view the added points in the Database section. 
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Figure 102: Device Added to Database 

You can add multiple discovered I/O points to the database, by hold down Ctrl while clicking the right mouse 

button on the required points.  

Also, while adding the multiple I/O points, you can edit the properties of all the selected I/O points, if the 

device properties like Point Type, Sub Type, Terminal Name are same for the multiple I/O points,  

If device properties like Point Type, Sub Type, Terminal Name are different for selected I/O points, then 

some of the properties are non-editable. 

 

Figure 103: Setting Value for Multiple Points in Add Window 

  



HONEYWELL CIPer MODEL 30 SYSTEM ENGINEERING USER GUIDE 

I/O PROGRAMMING Using On-Board and Expansion I/Os 

31-00237EFS - 02 | 100 

The following table describes the input fields available while adding a point to database. 

Table 7: Properties and Description to Add Point to Database 

Property Description 

Name Name of the point. 

Point Type Type of Input i.e. modulating or Binary 

Sub Type Sub type of the point i.e. sensor or signal details 

Terminal Name Details of the terminal port. 

Device Name Name of the associated device. You can change the device name in the Nav tree only. 

In the Add window it is not editable. 

Device Address Physical address of the associated controller. If you change the value and add the 

point into the database, the application displays the error message-Error: NoSuch-

Terminal. 

Enabled Status of the device. If Enabled is set to true, the point is enabled. If Enabled is set to 

false, the point is disabled. 

Facets Primarily, facets determine how the point’s value displays in the station. Examples 

include engineering units and decimal precision for numeric types, and descriptive 

value (state) text for boolean and enum types 

Point Config You can set specific property values for configuration of the point. The point configu-

ration properties differ for each point type and sub type. 

Tuning Policy 

Name 

Name of the Tuning policy 

Device Facets Default unit of the respective point. This property is not editable. 

Fault Cause Indicates the reason why a network, component, or extension is in fault. This field is 

empty unless a fault exists. 
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The following table describes different scenarios of operations that you can perform and their results. 

Table 8: Different Operations and Their Results 

Operation Result Description Solution 

Changing the device name in 

the Nav tree 

 Automatically reflects in the da-

tabase 

 

Changing the device address 

in the Property Sheet 

 Automatically reflects in the da-

tabase 

 

Adding a point with the same 

Terminal Number to the da-

tabase more than once 

Error  Fault Cause-Terminal Number 

is Duplicate on this device ad-

dress. 

Deleting any one point 

from the database re-

moves the error. 

Deleting any expansion I/O 

module after adding its 

points to database 

Error Error-NoSuchDevice  

Adding a point from a disa-

bled device to the database 

Error Point row becomes gray colored Enable the expansion I/O 

device from its Property 

Sheet. 

Disabling the LocalDevice Error Error-disabled 

All I/Os are disabled under 

Points folder, because Points 

folder is inside LocalDevice 

folder. See the exception to this 

case in the following Note. 

Enable the LocalDevice 

from the Property Sheet. 

 

 

Note:  

• Exception: If you want to use expansion I/O devices, but not the local devices, and disable the 

LocalDevice, you cannot do so, because disabling the LocalDevice disables all the devices in-

cluding local and expansion I/O devices. 

• You can replicate the same device with different Device Address to the database more than 

once. 

• If folder is removed or copy pasted (with I/O) then perform this action, right click on Pointsfolder 

> Action > Reconfigure points. 
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Remotely Mounted Expansion Module 

 

Figure 104: Remotely Mounted Expansion Module 

The cable length is up to 40 meters unterminated total length within the same building’s earth ground plane. 

Hand Off Auto (HOA) Switch 

HOA switches (physical) are provided for each output—Analog and Binary—present on the CIPer Model 

30 controller or expansion I/O. You can configure the HOA modes via physical switches present on the 

CIPer Model 30 controller and expansion I/O modules only. The H-O-A switch overrides all the software 

commands when set to HAND or OFF. 

Digital Outputs (DOs) 

If you configure the HOA switches to Off Mode, the Physical Digital Output is disabled irrespective of the 

Control program logic output. 

If you configure the HOA switches to Auto Mode, the Physical Output responses as per the value provided 

by the Control program logic output. 

If you configure the HOA switches to Hand Mode, the Physical Output is enabled irrespective of the Control 

program logic output. 

Analog Outputs (AOs) 

When the H-O-A switch is in HAND position, the H-O-A trimpot drives the output from 0–100% (0–20 mA 

or 0–10 VDC as appropriate) and it ignores the Control program logic output. 

When the switch is in OFF position, the output is at 0%. The trimpot value covers the full range of the output 

regardless of the Control program logic output. 
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If you configure the HOA switches to Auto Mode, the Physical Output responses as per the value provided 

by the Control program logic output. 

 

Note:  

When you change the HOA switch to Off, Auto, and Hand mode in the physical device, there is a delay 

of one second. This is to avoid the switch mode to change when it is mistakenly changed. So, if you want 

to see the switch mode to change, you need to keep the switch in the required mode at least for one 

second, otherwise the device ignores the change made by switch. 

Actions 

Use the Actions option to quickly force values to Network Input points. These options can be used to set 

values based on the priority:  

Emergency Override > Override > Set. 

Right-click the point on the wire sheet and select Actions. 

The actions allowed in the Online and Offline mode are:  

Input Actions 

The following table lists the actions available for numeric and Boolean input points. 

Table 9: Input Actions 

Action Description 

Point Type 

Numeric Input 

Points 

Boolean Input 

Points 

Override This option allows you to override the actual 

value of the input received from sensor as per re-

quirement. 

Available Not available 

Auto The Auto option removes the override value from 

the input and input shows the actual value. 

Available Available 

Active If Action is set to Active, the Input point becomes 

True irrespective of the actual value sensed by 

sensor. 

Not available Available 

Inactive If Action is set to Inactive, the Input point be-

comes False irrespective of the actual value 

sensed by sensor. 

Not available Available 
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Figure 105: Input Actions for Analog Input 

Points 

 

Figure 106: Input Actions for Binary Input 

Points 

To override input: 

1. Right-click the input function block on the wire sheet or in the Nav tree.  

2. Navigate to Actions and Override. The Override dialog box to enter the new value is displayed. 

 

Figure 107: Override Dialog Box 

3. Enter the new value in the input field of the Override dialog and click Ok. 

Similarly, you can select the Auto option and the application removes the overridden value from the input 

and input shows the actual value. 
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Output Actions 

The following table lists the actions available for numeric writable and Boolean writable output points. 

Action Description 

Point Type 

Analog Out-

put Point 

Binary 

Output 

Point 

Emergency 

Override 

Among other input actions Emergency Override has the 

highest priority. When you select the Emergency Override 

option, the value set for the Emergency Override is passed 

to the input point. 

Available Not avail-

able 

Emergency 

Auto 

This option overrides the Emergency Override value and 

the output point takes the value set by Override. Auto 

clears off the Override state of the point and the point is 

assigned the Sine/Cosine/Range value, if it is set. 

Available Available 

Emergency 

Active 

This has the highest priority. If Action is set to Emergency 

Active, the Output point becomes True irrespective of the 

actual value determined by the Control Program. 

Not available Available 

Emergency 

Inactive 

This has the highest priority. If Action is set to Emergency 

Inactive, the Output point becomes False irrespective of 

the actual value determined by the Control Program. 

Not available Available 

Override The Override has second-highest priority. The value set 

by Override is taken when the Emergency Auto option is 

selected, and the Override value is set. 

Available Not availa-

ble 

Active This has the second highest priority. If Emergency Auto is 

selected (that is Emergency Active and Emergency Inac-

tive are removed) and the Action is set to Active the Output 

point becomes True irrespective of the actual value deter-

mined by the Control Program. 

Not available Available 

Inactive This has the second highest priority. If Emergency Auto is 

selected (that is Emergency Active and Emergency Inac-

tive are removed) and the Action is set to Inactive, then 

the Output point becomes False irrespective of the actual 

value determined by the Control Program. 

Not available Available 

Auto The Auto option overrides the Override option, that is se-

lecting Auto removes the value set by Override. 

Available Available 

Set The Set option has the least priority among other actions. 

The value of Set is assigned to a point when Clear 

Available Available 
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Sine/Cosine/Range option is selected, and the Set value 

is already defined. 

 

 

Figure 108: Output Actions for Analog Output 

Points 

 

Figure 109: Output Actions for Binary Output 

Points 
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Order of Execution 

The order of execution defines the sequence in which function blocks are executed by the controller. When 

the function blocks are dragged onto the wire sheet to build the application logic, by default, the tool sets 

the execution order of the function blocks in the order they are dropped onto the wire sheet. However, you 

can alter the order in which the controller executes the function blocks by reordering the blocks. In the 

Simulation Mode, the order of execution that you set is followed.  

To change the order of execution:  

1. Drag the function blocks onto the Sequenced Control Program wire sheet from the ipcProgram-

mingTool palette. The order in which the function blocks are dragged determines the execution 

order. The execution order is displayed on the container of each function block on the wire sheet.  

2. Right-click the required container or Sequenced Control Program in the Nav tree and select Reor-

der. The Reorder window is displayed. 

 

Figure 110: Reorder option 

 

Note:  

• The execution of function blocks can be reordered only. Although Software and Physical points 

are shown in the Reorder screen, their order of execution cannot be reordered.  

• When a block is removed, the order of execution gets affected. 

• The order of execution cannot be changed for Built In function blocks. 
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3. Select the required application and click Move Up or Move Down to change the order of execution. 

 

Figure 111: Reorder ControlProgramScreen 

4. Click OK to close the dialog box. The value, in the Online mode, is directly written to the controller.  

Or  

Click Cancel, if you do not want to save the changes. 
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Physical Points 

Physical points are logical objects that are used in building application logic. Depending on the model se-

lected, default (Fixed) physical points are available.  

In CIPer Model 30 controller, three types of physical points are available to configure in the required appli-

cation:  

• Universal Input can be configured as: 

o Binary Inputs  

o Modulating Inputs  

• Universal Input / Outputs can be configured as: 

o Binary Inputs  

o Modulating Inputs  

o Binary Outputs  

o Modulating Output  

• Digital Outputs  

Physical points are logical objects that are used in building application logic. Depending on the model se-

lected, default (Fixed) Physical points are made available.  

The CIPer Model 30 programming model automatically validates the rules based on the model selected. 

Five types of physical points are available to configure in the required application:  

• ModulatingInput 

• ModulatingOutput 

• BinaryInput 

• BinaryOutput-Direct 

• BinaryOutput-SlowPWM 

To know how to add, configure, override, clear override, and delete a physical point block, and remove non-

required pin slots of a physical point block, see Function Block Details section under Function Block Library.  

ModulatingInput 

A ModulatingInput is a physical input. You can use the ModulatingInput function block while creating the 

application logic. 

 

Figure 112: ModulatingInput Function Block 
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ModulatingOutput 

A ModulatingOutput is a physical output. It is used to create ModulatingOutput in the application logic. 

 

Figure 113: ModulatingOutput Function Block 

BinaryInput 

A BinaryInput is a physical input. You can use the BinaryInput function block while creating the application 

logic. 

 

Figure 114: BinaryInput Function Block 

BinaryOutput-Direct 

A BinaryOutput is a physical output. You can use the BinaryOutput function block while creating the appli-

cation logic. 

 

Figure 115: BinaryOutput-Direct Function Block 

BinaryOutput-SlowPWM 

A BinaryOutput-SlowPWM is a physical output. You can use the BinaryOutput-SlowPWM function block 

while creating the application logic. 
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Figure 116: BinaryOutput-SlowPWM 

PWM Configuration: This is a sub type in the property sheet of the function block. When the sub type is 

Slow Pwm, enter the values for the following input fields: 

Period: The range is from 1 to 3276.7 seconds in tenths of seconds. It is the time of a one cycle of the 

pulse width modulation. 

Zero Time: When 0% command is given then the pulse width is equal to the value specified in this param-

eter. 

Full Time: When 100% command is given then the pulse width is equal to the value specified in this pa-

rameter. 

To know about the properties of above function blocks, see Using On-board and Expansion I/Os section 

under I/O Programming. 

Totalizer 

Totalizer sums up the pulses per second. 

Counter 

Counter counts the value per second. 

Point Status Behaviors 

The status is indicated by text on a colored background. 

The following table lists the status types, the default colors, and their meaning. 

Table 10: Point Status Behaviors 

Type Default Color Example Meaning 

alarm white text, red background 

65.0°F 

Point currently has a value in an alarm range, as defined 

by property in its alarm extension. 

fault black text, orange back-

ground 

65.0°F 

Originates from a proxy point only. Typically indicates a 

configuration or licensing error. If it occurs after normal 

operation, it may indicate a native fault in device, or the 

point’s parent device has a fault status. 

overridden black text, magenta back-

ground 

65.0°F 

Current point control is from an action, meaning a user-

invoked command at either priority level 8 (override) or 

priority 1 (emergency). 
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Type Default Color Example Meaning 

disabled gray text, light gray back-

ground 

65.0°F 

Originates from a proxy point only. Point (or its parent 

device or network) has been manually disabled (prop-

erty enabled = false). 

down black text, yellow back-

ground 

65.0°F 

Originates from a proxy point only. Driver communica-

tions to the parent device are currently lost, based upon 

the device status (Monitor) configuration for that net-

work. 

stale black text, tan background 

65.0°F 

Originates from a proxy point only. Driver communica-

tions have not received a requested response for this 

data item within the configured times (Tuning period). 

null (No color indication) 
Current point control has entered a null state, vs. a specific 
value and priority level. Typical to fallback operation for a 
writable point. 
 

Note: If linking a null status Out to a simple data slot, 
the point’s null value is processed.  
 

unackedAlarm (No color indication) Last point alarm event has not yet received user ac-

knowledgment. Point’s alarm extension uses alarm 

class requiring acknowledgment. 

License Requirements and Behaviors 

Following is the list of licensing requirements for CIPer Model 30 programming tool. 

• If the CIPer Model 30 programming tool is not licensed, any of the components in the controller 

does not function. 

• The license installed for CIPer Model 30 controller should be valid till the life of the CIPer Model 30 

programming tool, so that you need not renew and install the license every year.  

• You do not need any separate license to use the on-board I/Os and can use the on-board I/Os with 

the basic CIPer Model 30 license. 
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Configuring UI or UI/AO as Modulating Inputs 

You can configure the Modulating Input blocks and use them while adding the discovered physical UI/AO 

points into the database. 

 

Figure 117: UI configuration as Modulating 

Input  

 

Figure 118: UI/AO configuration as Modulating 

Input  

To add and configure the modulating input block: 

1. Discover the CIPer Model 30 I/O points. 

2. Double-click the required UI / UI/AO point. The application displays a window to add the device to 

the database as shown in the following figure. 

Or 

Drag the required UI / UI/AO point and drop it into the Database tab. 

3. Select Point Type as Modulating Input from the Point Type drop-down menu. 

 

Figure 119: Adding Modulating Input to Database 

The following table describes the configuration properties and their definitions. 
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Table 11: Configuration of Modulating Input Properties 

Name Definition 

Point Name  Enter the name of the function block or use the default names given by the ap-

plication. 

Point Type Select Modulating Input from the Point Type drop-down menu. 

Sub Type  Select a sensor type from the Sub Type drop-down menu. 

Enable  Select True to enable the selected point.  

 

Facets 
Click  to  view the details of the facets for the network/internal data type. 

The following information can be configured: 

• Minimum: The minimum limit for selected unit  

• Maximum: The maximum limit for selected unit  

Or 

• Range: Indicates the possible enumeration with its ordinal for a selected 

unit 

• Units: Indicates the unit symbol for the selected unit (if it shows null, it 

means the unit symbol is not applicable there.) 

• Resolution: Indicates scaling factor for the selected unit. When a value 

is written to the controller, the value is divided by the value specified in 

the Resolution field and when it is read from the controller, it is multiplied 

by the resolution value before it is displayed in Niagara.  

• Precision: Precision for the selected unit 

Point Configura-

tion 
Displays the unit of measurement for the selected point type. This is enabled 

when Resistive or Voltage is selected in the Sensor Type field.  

Enter the values for: 

• Sensor High Limit: Enter an upper limit in the High Limit field.  

• Sensor Low Limit: Enter a lower limit in the Low Limit field.  

• Sensor Reading Output Limits: 

o If Value is Invalid Outside High And Low Limit option is selected, 

and when output crosses the limit then output becomes invalid.  
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o If Clamp Value To High and Low Limits option is selected and if 

output crosses the High Limit or Low Limit then output is clamped 

to Low or High Limit, and it doesn’t become invalid. 

4. Click Ok, to save the information updated. 

Or  

Click Cancel, if you do not want to save the changes. 

Configuring UI or UI/AO as Pulse Meter or Counter 

In CIPer Model 30 controller model WEBC3036EPUBNH and WEBC3036EPUVNH, all UI & UI/AO points 

can be configured as Pulse Meter or Counter type sensor.  

When the modulating input is configured to type Pulse_Meter in the CIPer Model 30 Controller, it reads the 

number of pulses per hour. The algorithm averages the readings depending on the rate at which the pulses 

come in.  

• For fast pulses (< 20 seconds apart), the average of the last 4 readings is taken.  

• For medium pulses (< 40 seconds apart), the average of the last 2 readings is taken.  

• For slow pulses (>40 seconds apart), the last reading is taken. 

When the pulses stop coming in, the power gradually decreases and goes to 0 in approximately 11 minutes. 

The maximum measured rate is 54000 pulses per hour. The calculated output of a pulse meter input is in 

pulses per hour. This can be connected to the function block logic (multiply by scale factor) to the computer 

power. For example, 1 pulse = 1 W and 10 is added as a scale factor to the pulse. If pulse meter receives 

3600 pulses per hour, actual power consumption is equal to: 

3600 * 10 = 36 KW 

You can connect this to the function block logic and accumulate counts. 

To add and configure the pulse input block: 

1. Discover the CIPer Model 30 I/O points. 

2. Double-click the required UI / UI/AO point. The application displays a window to add the device to 

the database as shown in the following figure. 

Or 

Drag the required UI / UI/AO point and drop it into the Database tab. 

3. Select Point Type as Modulating Input from the Point Type drop-down menu. 

4. Select Sub Type as Pulse Meter or Counter from the Sub Type drop-down menu. 
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Figure 120: Adding Modulating Input to Database 

5. Click Ok to save the information updated. 

Or  

Click Cancel, if you do not want to save the changes. 

You can change the poll frequency of the Pulse Meter and Counter to Slow (), Fast (every second), 

and Normal (once in 5 seconds) as per requirement in the property sheet. 

Configuring UI or UI/AO as Custom Sensor 

If the sensor does not meet any standard characteristics of the available sensors, you can select the Type 

as Custom Sensor and set its characteristics. There are three type of custom sensor. 

• Resistive Input: A Resistive Input Point is an Analog Point which configures a UI / UI/AO to read 

a resistance from 0 to 300000 ohms. Configuration provides for default (ohms). 

• Voltage Input: A Voltage Input Point is an Analog Point which configures a UI / UI/AO to read a 

Voltage signal from 0 volt to 10.3 Volt. Configuration provides for default (Volts). 

• Current Input: A Current Input Point is an Analog Point which configures a UI / UI/AO to read a 

resistance from 0 to 20mA. Configuration provides for default (mA). 

Resistive Sensor 

A Restive Input Point is an analog point which configures a UI / UI/AO to read a resistance signal range 

from 0 to 300000 ohms. 
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To define custom sensor: 

1. Discover the CIPer Model 30 I/O points. 

2. Double-click the required UI point. The application displays a window to add the device to the da-

tabase as shown in the following figure. 

Or 

Drag the required UI point and drop it into the Database tab. 

3. Select Point Type as Modulating Input. 

4. Select the Sub Type as Custom Sensor. If the Sub Type is selected as Custom Sensor, you must 

set the Linearization, otherwise the custom sensor does not function properly, and shows a fault 

cause. 

 

  Figure 121: Selecting Custom Sensor in the Sub Type Drop-Down Menu 

 

Figure 122: Custom Sensor Configuration 

5. Click  to configure the facets. 
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6. Select Sensor Type as Resistive. 

Specification Unit option in the drop-down menu depends upon the Data Type selected while con-

figuring the details on the Add window. 

7. Click  next to the Linearization field, where the linearization points are provided to define the 

characteristics of the sensor. The Tabular Conversion Dialog window is displayed. 

 

Figure 123: Tabular Conversion Dialog Window 

8. Click Add. 

9. Enter the sensor resistance value for the electrical signal in the Source field and enter the corre-

sponding value of the parameter which is being sensed in the Result field.  

Enter the low and high limit sensor values in the Sensor Low Limit (0 ohm) and Sensor High Limit 

(300000 ohm) fields respectively as per Sensor Data Sheet. 

10. Select the value for Sensor Reading Output Limits from the respective drop-down menus. 

• If Value is INVALID outside High Limit option is selected, and when output crosses the limit, 

the output becomes invalid. 

• If Clamp Value as High and Low Limits option is selected, and if output crosses the high limit 

or low limit, the output is clamped to Low or High Limit and it doesn’t become invalid. 

11. Click Save after entering the required details. 

Voltage Input 

A Voltage input point is an analog point which configures a UI / UI/AO to read a Vdc signal range from 0 to 

10.3V. 

To define voltage input: 

1. Discover the CIPer Model 30 I/O points. 

2. Double-click the required UI point. The application displays a window to add the device to the da-

tabase as shown in the following figure. 

Or 

Drag the required UI point and drop it into the Database tab. 
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3. Select Point Type as Modulating Input. 

4. Select the Sub Type as Custom Sensor. 

 

Figure 124: Selecting Custom Sensor in Sub Type Drop-Down Menu 

 

Figure 125: Custom Sensor Configuration 

5. Click  to configure the facets. 

6. Select Sensor Type as Voltage as per requirement. 

7. Specification Unit option in the drop-down menu depends upon the Data Type selected while con-

figuring the details on the Add window. 

8. Click  next to the Linearization field, where the linearization points are provided to define the 

characteristics of the sensor. The Tabular Conversion Dialog window is displayed. 
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Figure 126: Tabular Conversion Dialog Window 

9. Click Add. 

10. Enter the sensor voltage value for the electrical signal in the Source field and enter the correspond-

ing value of the parameter which is being sensed in the Result field.  

Enter the low and high limit sensor values in the Sensor Low Limit (Sensor value at 0 Volt) and 

Sensor High Limit (Sensor value at 10.3 Volt) fields respectively as per Sensor Data Sheet. 

11. Select the value for Sensor Reading Output Limits from the respective drop-down menus. 

• If Value is INVALID outside High Limit option is selected, and when output crosses the 

limit, the output becomes invalid. 

• If Clamp Value as High and Low Limit option is selected, and if output crosses the high 

limit or low limit, the output is clamped to Low or High Limit and it doesn’t become invalid. 

12. Click Save after entering the required details. 

Current Input 

A Current input point is an analog point which configures a UI / UI/AO to read a current signal range from 

0 to 20mA. 

To define Current input: 

1. Discover the CIPer Model 30 I/O points. 

2. Double-click the required UI point. The application displays a window to add the device to the da-

tabase as shown in the following figure. 

Or 

Drag the required UI point and drop it into the Database tab. 

3. Select Point Type as Modulating Input. 

4. Select the Sub Type as Custom Sensor. 
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Figure 127: Selecting Custom Sensor in Sub Type Drop-Down Menu 

 

Figure 128: Custom Sensor Configuration 

5. Click  to configure the facets. 

6. Select Sensor Type as Current as per requirement. 

7. Specification Unit option in the drop-down menu depends upon the Data Type selected while con-

figuring the details on the Add window. 

8. Click  next to the Linearization field, where the linearization points are provided to define the 

characteristics of the sensor. The Tabular Conversion Dialog window is displayed. 
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Figure 129: Tabular Conversion Dialog Window 

9. Click Add. 

10. Enter the sensor current value for the electrical signal in the Source field and enter the correspond-

ing value of the parameter which is being sensed in the Result field.  

Enter the low and high limit sensor values in the Sensor Low Limit (Sensor value at 0 mA) and 

Sensor High Limit (Sensor value at 20mA) fields respectively as per Sensor Data Sheet. 

11. Select the value for Sensor Reading Output Limits from the respective drop-down menus. 

• If Value is INVALID outside High Limit option is selected, and when output crosses the 

limit, the output becomes invalid. 

• If Clamp Value as High and Low Limit option is selected, and if output crosses the high 

limit or low limit, the output is clamped to Low or High Limit and it doesn’t become invalid. 

12. Click Save after entering the required details. 

Configuring UI or UI/AO as Ntc20k 

Negative Temperature Coefficient (NTC) are thermistors, which decrease in resistance when the tempera-

ture increases. 

To define Ntc20k: 

1. Discover the CIPer Model 30 I/O points. 

2. Double-click the required UI or UI/AO point. The application displays a window to add the device 

to the database as shown in the following figure. 

Or 

Drag the required UI or UI/AO point and drop it into the Database tab. 
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Figure 130: Add Window to Add Device to Database 

3. Select Point Type as Modulating Input. 

4. Select the Sub Type as Ntc20k. 

 

Figure 131: Selecting Ntc20k from Sub Type Drop-Down Menu 

5. Configure the Point Config, Tuning Policy Name, Device Facets, and Fault Cause properties as 

required. 

6. Click Ok. 
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Configuring UI or UI/AO as Pt1000 

Pt1000 is a temperature sensor of platinum resistance thermometer type. 

To define Pt1000: 

1. Discover the CIPer Model 30 I/O points. 

2. Double-click the required UI or UI/AO point. The application displays a window to add the device to 

the database as shown in the following figure. 

Or 

Drag the required UI or UI/AO point and drop it into the Database tab. 

 

Figure 132: Add Window to Add Device to Database 

3. Select Point Type as Modulating Input. 

4. Select the Sub Type as Pt1000. 
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Figure 133: Selecting Pt1000 from Sub Type Drop-Down Menu 

5. Configure the Point Config, Tuning Policy Name, Device Facets, and Fault Cause properties as 

required. 

6. Click Ok. 

Configuring UI or UI/AO as Custom Resistive 

A resistive sensor is a transducer or electromechanical device that converts a mechanical change such as 

displacement into an electrical signal that can be monitored after conditioning. 

To define Resistive sensor: 

1. Discover the CIPer Model 30 I/O points. 

2. Double-click the required UI or UI/AO point. The application displays a window to add the device 

to the database as shown in the following figure. 

Or 

Drag the required UI or UI/AO point and drop it into the Database tab. 
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Figure 134: Add Window to Add Device to Database 

3. Select Point Type as Modulating Input. 

4. Select the Sub Type as Custom Resistive. 

 

Figure 135: Selecting Custom Resistive from Sub Type Drop-Down Menu 
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5. Enter the value for Input Low, Input High, Output Low, Output High, Sensor Low Limit, Sensor High 

Limit, Sensor Reading Output Limits & Offset as required. 

6. Configure the Point Config, Tuning Policy Name, Device Facets, and Fault Cause properties as 

required. 

7. Click Ok. 

Configuring Built-In Flow Sensor 

The built-in flow sensor is always assigned to the Universal Input 0 of the WEBC3036EPUVNH controller. 

Built-in flow sensor is only available for the models which have pressure tubes to measure velocity pressure. 

These models are mostly used for VAV applications. 

To add and configure a built-in flow sensor:  

1. Discover the CIPer Model 30 I/O points. 

2. Double-click the Flow Sensor UI Point. The application displays a window to add the device to the 

database. 

3. Enter the sensor low and high limit values in the Sensor Low Limit and Sensor High Limit respec-

tively as per Sensor Data Sheet. 

4. Select the value for Sensor Reading Output Limits from the respective drop-down menus. Sensor 

Readings Outside Limit,  

• If the Value is INVALID outside High Limit option is selected and when output crosses the 

limit, the output becomes invalid.  

• If the Clamp Value as High and Low Limits option is selected and if output crosses the high 

limit or low limit, the output is clamped to Low or High Limit and it doesn’t become invalid  

5. Click OK to complete adding a built-in flow sensor. 

Configuring UI or UI/AO as Binary Inputs 

You can configure the Binary Input blocks and use them while adding the discovered physical UI (universal 

input) or UI/AO (Universal Input Output) points into the database. 

 

Figure 136: Binary Input Function Block 

To add and configure a binary input block: 

1. Discover the CIPer Model 30 I/O points. 

2. Double-click the required UI / UI/AO point. The application displays a window to add the device to 

the database as shown in the following figure 

Or 
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Drag the required UI / UI/AO point and drop it into the Database tab. 

3. Select Point Type as Binary Input. 

 

Figure 137: Adding Binary Input to Database 

The following table describes the configuration details for a binary input. 

Table 12: Configuration of Binary Input Properties 

Name Definition 

Name Enter the name of the physical point or use the default names given by the 

application. 

Point Type  Select Binary Input from Point Type drop-down menu. 

 

Sub Type 

 

Not applicable 

Enable  Select True to enable the selected point. 
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Name Definition 

Facets 
Click . Change the values for trueText & falseText to match the require-

ment. For example, for Supply Fan status, the trueText can be On and falseT-

ext can be Off. 

Point Configuration 

 

• Normally Open 

• Normally Close 

 

4. Click Ok to save the information updated. 

Or  

Click Cancel, if you do not want to save the changes. 

Configuring UI/AO as Modulating Outputs 

You can configure the ModulatingOutput blocks and use them while adding the discovered physical UI / 

UI/AO points into database. 

 

Figure 138: UI/AO configuration as Modulating Output 

To add and configure a modulating output block:  

1. Discover the CIPer Model 30 I/O points. 

2. Double-click the required UI/AO point. The application displays a window to add the device to the 

database as shown in the following figure. 

Or 

Drag the required UI/AO point and drop it into the Database tab. 

3. Select Point Type as Modulating Output from the Point Type drop-down menu. 
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Figure 139: Adding Modulating Output to Database 

The following table describes the configuration properties and their definitions 

Table 13: Configuration of Modulating Output Properties 

Name Definition 

Point Name Enter the name of the function block or use the default names given by the ap-

plication.  

Point Type Select Modulating Output from Point Type drop-down menu. 

Sub Type Default value is Voltage. You can change it to current. Based on the sub type 

selection the units in the Point Config section changes. 

Enable  Select True to enable the selected point. 

 

Facets 
Click  to view the details of the facets for the network/internal data type. 

The following information can be configured: 

• Minimum: The minimum limit for selected unit  

• Maximum: The maximum limit for selected unit  

Or 
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Name Definition 

• Range: Indicates the possible enumeration with its ordinal for a selected unit 

• Units: Indicates the unit symbol for the selected unit (if it shows null, it means 

the unit symbol is not applicable there.) 

• Resolution: Indicates scaling factor for the selected unit. When a value is 

written to the controller, the value is divided by the value specified in the Res-

olution field and when it is read from the controller, it is multiplied by the res-

olution value before it is displayed in Niagara.  

Precision: Precision for the selected unit 

Point Config As per requirement, select one of following:  

• Volts: The range is 0 VDC - 10 VDC  

• Milliamps: The range is 0 mA - 20 mA. 

Enter the value for Zero Percent and Hundred Percent. 

Note: Each ModulatingOutput can be configured for the output voltage/current 

at 0% and at 100%. Each modulating output circuit operates in current mode for 

loads up to 600 . For loads of 600  to 1000 , the output transitions to voltage 

mode. For loads above 1000 , the output operates in voltage. 

When full percent is less than zero percent, the motor runs in the reverse direc-

tion. 

OK Saves the entered information and exits the dialog box. 

Cancel Exits the dialog box. Any information entered is lost. 

 

 

Note:  

When a ModulatingOutput is copied and pasted on wire sheet, then the same configuration is retained. 

The error message-Terminal Number is duplicate on the device address-is displayed on the IPC Point 

Manager view of the Points folder. You need to delete the duplicate point manually. 
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Configuring DO as Binary Output 

You can configure the BinaryOutput blocks and use them while adding the discovered physical DO or UI/AO 

points into database. 

 

Figure 140: DO Configuration as Binary Output  

To add and configure a binary output block: 

1. Discover the CIPer Model 30 I/O points. 

2. Double-click the required DO point. The application displays a window to add the device to the 

database as shown in the following figure. 

Or 

Drag the required DO point and drop it into the Database tab. 

3. Select Point Type as Binary Output from the Point Type drop-down menu. 

 

Figure 141: Adding Binary Output to Database 
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The following table describes the configuration properties and their definitions. 

Table 14: Configuration of Binary Output Properties 

Name Definition 

Point Name  Enter the name of the function block or use the default names given by the applica-

tion. 

Point Type Select Binary Output from Point Type drop-down menu. 

Sub Type  Select a Signal type from the Sub Type drop-down menu. 

• Direct: Select this option if the final control element is accepting the signal in the 

Constant Width Pulse signal form. 

• Slow Pwm: Select this option if the final control element is accepting the signal in 

the Pulse Width Modulation form. 

Enable Select True to enable the selected point. 

Facets 
Click .  

If you select Direct as Sub Type,  

Change the values for trueText and falseText to match the requirement. For exam-

ple, for Supply Fan status, the trueText can be On and falseText can be Off. 

If you select Slow Pwm as Sub Type, the following information can be configured. 

• Minimum: The minimum limit for selected unit  

• Maximum: The maximum limit for selected unit  

Or 

• Range: Indicates the possible enumeration with its ordinal for a selected unit 

• Units: Indicates the unit symbol for the selected unit (if it shows null, it means the 

unit symbol is not applicable there.) 

• Resolution: Indicates scaling factor for the selected unit. When a value is written 

to the controller, the value is divided by the value specified in the Resolution field 

and when it is read from the controller, it is multiplied by the resolution value be-

fore it is displayed in Niagara.  

• Precision: Precision for the selected unit 

Point Configura-

tion 

This is enabled when Slow Pwm is selected in the Type field. Enter the values for 

the following: 

• Period: The range is 1 - 3276.7 sec in tenths of seconds. It is the time of a one 

cycle of the pulse width modulation. 

• Zero time: When 0% command is given, the pulse width is equal to the value 

specified in this parameter, 
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• Full time: When 100% command is given, the pulse width is equal to the value 

specified in this parameter. 

OK  Saves the entered information and exits the dialog box. 

Cancel  Exits the dialog box. Any information entered is lost. 

4. Click Ok to save the information updated. 

Or  

Click Cancel, if you do not want to save the changes. 

Configuring UI/AO as Binary Output 

You can configure the BinaryOutput blocks and use them while adding the discovered physical DO or UI/AO 

points into database. 

 

Figure 142: UI/AO Configuration as Binary Output  

1. To add and configure a binary output block: 

2. Discover the CIPer Model 30 I/O points. 

3. Double-click the required UI/AO point. The application displays a window to add the device to the 

database as shown in the following figure. 

Or 

Drag the required UI/AO point and drop it into the Database tab. 

4. Select Point Type as Binary Output from the Point Type drop-down menu. 
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Figure 143: Adding Binary Output to Database 

The following table describes the configuration properties and their definitions. 

Table 15: Configuration of Binary Output Properties 

Name Definition 

Point Name  Enter the name of the function block or use the default names given by the appli-

cation. 

Point Type Select Binary Output from Point Type drop-down menu. 

Sub Type  Select a Signal type from the Sub Type drop-down menu. 

• Direct: Select this option if the final control element is accepting the signal in the 

Constant Width Pulse signal form. 

Enable Select True to enable the selected point. 

Facets 
Click .  

If you select Direct as Sub Type,  

Change the values for trueText and falseText to match the requirement. For exam-

ple, for Supply Fan status, the trueText can be On and falseText can be Off. 

Point Configuration Not applicable 
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OK  Saves the entered information and exits the dialog box. 

Cancel  Exits the dialog box. Any information entered is lost. 

5. Click Ok to save the information updated. 

Or  

Click Cancel, if you do not want to save the changes. 

Configuring DO and UI/AO as Floating Output 

You can configure the digital output and universal input output as floating output. 

FloatingOutput 

Floating: You can use this object when an actuator or a final control element is of Floating type. The CIPer 

Model 30 controller uses following two BinaryOutputs for floating-type signal:  

• One digital output moves the final control element in the clockwise direction 

• Other digital output moves the final control element in the anticlockwise direction 

The time for which the digital outputs are held on depends upon the stroke time of the final control element. 

For example, if the stroke time of the actuator is 90 seconds and the actuator is at full close position, and if 

50% command is given to the actuator then the clockwise binary output turns on for 45 seconds. At this 

position, if again 0% command is given to that actuator then the anticlockwise BinaryOutput turns on for 45 

seconds. 

In CIPer Model 30 Relay models the resolution of the floating control is limited to 1 second. The SyncEdg-

eTrigger option is available for CIPer Model 30. 

 

Note:  

• FloatingOutput block cannot be connected to two different devices.  

For example, FloatingOutput block cannot be used as one in local device and expansion I/O. 

• If the FloatingOutput block is used with two different devices, a fault status is shown in the block 

present on wire sheet. 

You can configure the FloatingOutput by adding IO Function Block present in the ipcProgrammingTool 

palette. 

 

Figure 144: Configuration of Floating Output  
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To add and configure a floating output block:  

1. Click Window > Side Bars > Palette to add the Palette, if it is not visible on the screen. 

2. Drag and drop the IOs > FloatingOutput object from the ipcProgrammingTool palette to the wire 

sheet.  

 

Figure 145: FloatingOutput Name Window 

3. Enter the name for the FloatingOutput in the Name window or use the default name set by the 

application, and then click Ok. The FloatingOutput is added to the Drivers folder. 

The following table describes the configuration properties and their definitions. 

Table 16: Floating Output Configuration 

Property Name Definition 

SyncEdgeTrigger If SyncEdgeTrigger as the output is selected, it can be triggered the motor point 

at any point in time using the following values: 

• <=0: No effect 

• 1: Sync closed 

• 2: Sync open 

• >=3: No effect 

TravelTime It is the maximum specified time for which clockwise or counter clockwise output 

remains ON when 100% command is given. 

AutoSyncType Following options are available for the AutoSyncType property:  

• None: When this option is selected, the CIPer Model 30 controller assumes 

that the motor is fully closed. 

• Sync Open: The motor is driven to fully open after the completion of Auto-

SyncInterval. 

• Sync Closed: The motor is driven to fully closed open after the completion 

of AutoSyncInterval. 

AutoSyncInterval The auto-synchronization interval is configured from 0 hour to 255 hours in one-

hour increments. The timer is loaded and starts counting down after power up 

reset and power up delay. When the timer expires, the motor is synchronized. 

This is applicable only if you configure auto-synchronization to Sync Open or 

Sync Close. 

PowerupSyncType Select one of the following values:  
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Property Name Definition 

• None: The CIPer Model 30 controller assumes that the motor is fully closed. 

• Sync Open: The motor is driven to fully open. 

• Sync Closed: The motor is driven to fully closed. 

PowerupDelay The power-up delay is configured from 0 - 3276.7 seconds in tenths of seconds. 

Zero (0) means no delay. 

MotorAction This is enabled only when Floating is selected in the Type field. Select one of 

the following values: 

• Direct  

• Reverse  

Reverse Action is configured for: 

• True - 100% = full close, 0% = full open 

• False is opposite. 0% = full Open, 100% = full close. 

4. Click Save to save the information updated. 

Or  

Click Cancel, if you do not want to save the changes. 

Configuring DO as Slow PWM 

You can configure a digital output as Slow Pwm (pulse width modulation). 

 

Figure 146: Function Block of BinaryOutput-SlowPWM 

To add and configure DO as Slow Pwm: 

1. Discover the CIPer Model 30 I/O points. 

2. Double-click the required DO point. The application displays a window to add the device to the 

database as shown in the following figure. 

Or 

Drag the required DO point and drop it into the Database tab. 

3. Select Point Type as Binary Output from the Point Type drop-down menu. 
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Figure 147: Adding Binary Output (Slow Pwm) to Database 

The following table describes the configuration properties and their definitions. 

Table 17: Configuration of Binary Output Properties 

Name Definition 

Point Name  Enter the name of the function block or use the default names given by the applica-

tion. 

Point Type Select Binary Output from Point Type drop-down menu. 

Sub Type  Select a Signal type from the Sub Type drop-down menu. 

• Slow Pwm: Select this option if the final control element is accepting the signal in 

the Pulse Width Modulation form. 

Enable Select True to enable the selected point. 

Facets 
Click .  

If you select Slow Pwm as Sub Type, the following information can be configured. 

• Units: Indicates the unit symbol for the selected unit (if it shows null, it means the 

unit symbol is not applicable there.) 

• Minimum: The minimum limit for selected unit  

• Maximum: The maximum limit for selected unit  
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• Precision: Precision for the selected unit 

Point Configura-

tion 

This is enabled when Slow Pwm is selected in the Type field. Enter the values for 

the following: 

• Period: The range is 1 - 3276.7 sec in tenths of seconds. It is the time of a one 

cycle of the pulse width modulation. 

• Zero time: When 0% command is given, the pulse width is equal to the value 

specified in this parameter, 

• Full time: When 100% command is given, the pulse width is equal to the value 

specified in this parameter. 

OK  Saves the entered information and exits the dialog box. 

Cancel  Exits the dialog box. Any information entered is lost. 

4. Click Ok to save the information updated. 

Or  

Click Cancel, if you do not want to save the changes. 

Modifying Terminal Assignment Using Property Sheet 

You can modify the terminal assignments from the property sheet and remove the assignment for a device 

and terminal. While modifying the terminal assignment, you can swap across different devices, and within 

a device you can swap across different terminals. 

To modify a terminal: 

1. In the Nav tree, browse to Station > Config > Drivers > IPCNetwork > LocalDevice > Points > 

right click Views > IPC Point Manager. 
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Figure 148: I P C Point Manager Option in Views Menu 

The Discovered and Database tabs are displayed as shown in the following figure. 

 

Figure 149: I P C Point Manager View 

2. Click Discover to discover the available points. 
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3. Add a device to the database by double-clicking the device, or by selecting a device and then 

clicking Add. 

4. Update the Terminal Name property by selecting the required option in the Terminal Name drop-

down menu. 

 

Figure 150: Modifying Terminal Assignment 

5. Click Ok to save the changes. 

Or 

Click Cancel, if you do not want to save the changes. 

 

Note:  

• You can also modify the terminal assignment by: 

o Clicking the Edit button after selecting the required device in the database 

o Double-clicking the required point on the wire sheet and then modifying the Pin property in the 

property sheet 

• To remove the assignment of the terminals and devices, select the Unassigned option in the Terminal 

Name and Device Name drop-down menus. 
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SYLK DEVICE PROGRAMMING 

The CIPer controller family supports Sylk Devices. Using Sylk-enabled sensors saves I/O on the controller 

and is faster and cheaper to install since only two wires are needed and the bus is polarity insensitive. 

CIPer controllers supports Sylk Bus. Sylk is a two wire, polarity insensitive bus that provides both 18 VDC 

power and communications between a Sylk-enabled sensor and a Sylk-enabled controller. Using Sylk-

enabled sensors saves I/O on the controller and is faster and cheaper to install since only two wires are 

needed and the bus is polarity insensitive. Sylk sensors are configured using the latest release of the of the 

CIPer Tool for Web-N4™ and WEBStation® 

The ipcProgrammingTool palette comes with inbuilt SylkDevices and SylkParams. IPCProgrammingTool 

palette device contain following Sylk modules:  

SylkDevices 

 

 

SylkParams 

 

SylkSchedule 
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Sylk Component Status Behaviors 

The status is indicated by text on a colored background. The following table lists the status types, the default 

colors, and their meaning. 

Table 18: Sylk Status Type, Default Colors, and Meaning 

Type Default Colors, Example Meaning 

alarm white text, red background 

65.0°F 

Point currently has a value in an alarm range, as defined 

by property in its alarm extension. 

fault black text, orange back-

ground 

65.0°F 

Originates from a proxy point only. Typically indicates a 

configuration or licensing error. If it occurs after normal 

operation, it may indicate a “native fault” in device, or the 

point’s parent device has a fault status. 

overridden black text, magenta back-

ground 

65.0°F 

Current point control is from an action, meaning a user-

invoked command at either priority level 8 (override) or 

priority 1 (emergency). 

disabled gray text, light gray back-

ground 

65.0°F 

Originates from a proxy point only. Point (or its parent 

device or network) has been manually disabled (prop-

erty enabled = false). 

down black text, yellow background 

65.0°F 

Originates from a proxy point only. Driver communica-

tions to the parent device are currently lost, based upon 

the device status (Monitor) configuration for that net-

work. 

stale black text, tan background 

65.0°F 

Originates from a proxy point only. Driver communica-

tions have not received a requested response for this 

data item within the configured times (Tuning period). 

null (No color indication) Current point control has entered a null state, vs. a spe-

cific value and priority level. Typical to fallback operation 

for a writable point. 

Note: If linking a null status Out to a simple data slot, 

the point’s null value is processed.  

unackedA-

larm 

(No color indication) Last point alarm event has not yet received user ac-

knowledgment. Point’s alarm extension uses alarm 

class requiring acknowledgment. 
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License Requirements and Behaviors 

The limitation for Sylk devices is as follows: 

Property Limit Remarks 

Sylk Device Limitation Device limit = 14 If you try to add more than 14 devices, the ap-

plication shows the device address property 

as unassigned and status as down. The Com-

mission Sylk Device option when clicked also 

detects and shows an error, if you try to add 

more than 14 Sylk devices. 

Following are the behaviors of a Sylk device: 

• Sylk device aid you to perform offline configuration. 

• You can perform the compilation of the Sylk device. 

• You need license to download Sylk device. 
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SylkDevices 

IPCProgrammingTool helps you to add and configure the Sylk devices. CIPer 30 controller connection 

limited to 14 Sylk device. If you try to add more than 14 devices, the added device address property sheet 

shows Address unassigned and Status down.  

Also, when you try to perform Commission Sylk Device with more than 14 sylk device add to controller, it 

shows an error message. 

 

Note:  

Whenever there is any change in the schedule component (SylkSchedule or EnumSchedule), you need to 

recommission the Sylk device. Recommission of the Sylk device enables the tool to send modified value 

to wallmodule. 

Adding Sylk Device 

To perform action on Sylk device, you need to add the Sylk device to the workstation. 

To add Sylk device: 

1. Navigate to Station > Config > Drivers > IPCNetwork > LocalDevice and open Wire Sheet view. 

2. Navigate to the pallet section select ipcProgrammingTool > SylkDevices. 

3. Select the sylk device from the SylkDevices list and drop it to Wire Sheet or drop it under Lo-

calDevices. 

4. If you want to add multiple sylk device, hold down Ctrl while clicking right mouse button select 

multiple sylk device from the SylkDevices list and drop it to Wire Sheet or drop it under Lo-

calDevices. 

5. After adding the sylk device to Wire Sheet or under Localdevice. Double-click on the added devices, 

this action opens property sheet, you can check the power consumption and configure the sylk 

device.  

Also, user can check if the sylk configuration is downloading status or not. 
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Figure 151: Total Sylk Power Consumption data checking 

 

Figure 152: After Adding Sylk Device to Local Device Folder 
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Configuring Sylk Device 

Once you have added the Sylk device to the LocalDevice folder, you can configure parameters of the Sylk 

devices.  

To configure a Sylk device: 

1. Navigate to Station > Config > Drivers > IPCNetwork > LocalDevice and open Wire Sheet view. 

2. Navigate to the pallet section, select ipcProgrammingTool > SylkParms. 

3. Drag and drop the Sylk parameters modules from the SylkParams into the wire sheet or under the 

LocalDevice.  

4. Double-click on the added Sylk parameters modules. This action opens Property Sheet of the Sylk 

parameter.  

In the property sheet, you can view the list of sylk device supported by the selected parameter.  

 

Figure 153: List of supported Sylk devices 

5. To view all the Sylk parameters configured for the Sylk device, navigate to the Local Device > 

Views > select Sylk Parameter Summary. 

 

Figure 154: Sylk Parameter Summary View 
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For each point that you want to add, a separate configuration is required. You can filter the parameters by 

category. The category field of a parameter is user-defined. 

With respective to workflow of the wall modules in CIPer Model 30 programming model, when you add 

OccupancyOverrideCommand module to the wire sheet, you need to explicitly add the OccupancySta-

tus module for the same. That is, in and out are separate. 

When you commission Sylk device, the Sylk Device Resource Usage shown under TR7X device and prop-

erties get updated.  

 

Figure 155: Sub-Menu of Sylk Device Resource Menu 
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A brief view to the different wall modules in CIPer Model 30 programming model and the parameters that 

these modules support is as follows: 

Parameter 
Module-TR120X 

TR120BusWallModule TR120HBusWallModule 

ROOMTEMP Y Y 

HUMIDITY N Y 

OccupancyOverrideCommand Y Y 

ValueFromWallModule Y Y 

TimeOfDay Y Y 

SystemStatus Y Y 

OccupancyStatus Y Y 

ValueFromController Y Y 

SystemCommand Y Y 

TimeField Y Y 

BypassTime Y Y 

SensorOffset Y Y 

HomeScreen Y Y 

NetworkSetpoint Y Y 

SylkTime Y Y 

FanCommand Y Y 

SylkSchedule Y Y 

 

Table 19: Sylk TR7X Modules and Parameters 

Parameter Module-TR7X 

TR75HSBus-

WallModule 

TR75SBus-

WallModule 

TR71HSBus-

WallModule 

TR71SBus-

WallModule 

ROOMTEMP Y Y Y Y 
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HUMIDITY Y N Y N 

OccupancyOverrideCom-

mand Y Y Y Y 

ValueFromWallModule Y Y Y Y 

TimeOfDay Y Y Y Y 

SystemStatus Y Y Y Y 

OccupancyStatus Y Y Y Y 

ValueFromController Y Y Y Y 

SystemCommand Y Y Y Y 

TimeField Y Y Y Y 

BypassTime Y Y Y Y 

SensorOffset Y Y Y Y 

HomeScreen Y Y Y Y 

NetworkSetpoint Y Y Y Y 

SylkTime Y Y Y Y 

FanCommand Y Y Y Y 

SylkSchedule Y Y N N 

 

Table 20: Sylk TR4X Modules and Parameters 

Parameter Module-TR4X 

TR42HCO2SBus-

WallModule 

TR42HSBus-

WallModule 

TR42CO2SBus-

WallModule 

TR42SBusWall-

Module 

ROOMTEMP Y Y Y Y 

HUMIDITY Y Y N N 

CO2 Y N Y N 

OccupancyOver-

rideCommand Y Y Y Y 

OccupancyStatus Y Y Y Y 



HONEYWELL CIPer MODEL 30 SYSTEM ENGINEERING USER GUIDE 

SYLK DEVICE PROGRAMMING SylkDevices 

31-00237EFS - 02 | 152 

BypassTime Y Y Y Y 

NetworkSetpoint Y Y Y Y 

FanCommand Y Y Y Y 

 

Parameter Module-TR4X 

TR40HCO2SBus-

WallModule 

TR40HSBus-

WallModule 

TR40CO2SBus-

WallModule 

TR40SBusWall-

Module 

ROOMTEMP Y Y Y Y 

HUMIDITY Y Y N N 

CO2 Y N Y N 

OccupancyOver-

rideCommand N N N N 

OccupancyStatus N N N N 

BypassTime N N N N 

NetworkSetpoint N N N N 

FanCommand N N N N 

 

Table 21: Sylk Zeleny Modules and Parameters 

Parameter Module 

C7400S (Zeleny) 

ROOMTEMP Y 

HUMIDITY Y 

Y: Yes,  N: No 
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Note:  

• Firmware Details: 

The firmware details available in the property sheet of the LocalDevice node get updated when a 

station is started up. You can get the firmware details manually by right-clicking the LocalDevice 

node, and select Actions, and click Ping. 

 

Figure 156: Manually Checking Firmware Details by Ping Action 

 

Figure 157: Ping Action Showing Firmware Details 

 

Figure 158: Property Sheet View of LocalDevice Showing Firmware Details Automatically 

Updated on Station Start up 

• Sylk Download Status: 

The flag, Is Sylk Configuration Downloaded, in the property sheet of the LocalDevice node indi-

cates if the Sylk device is downloaded after the configuration is modified. The flag is set to either 

true or false, and it represents multiple Sylk devices. If you modify any parameters in any Sylk 

device, the flag turns to false. So, you need to commission the Sylk device to get the modifications 
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done downloaded. On successful commissioning of Sylk device, the flag turns to true. Now you 

can read and write the Sylk device. 

Is Sylk Configuration Downloaded flag is also present in the individual property sheet of the all 

the Sylk devices. So, if you modify a property in a Sylk device, the Sylk download status flag for 

the corresponding device turns to false. 

Deleting Sylk Device 

If you want to remove the Sylk Device from a configured station, follow the below steps. 

To delete a Sylk Device: 

1. Right-click on the required Sylk device from the Nav window.  

2. Select Delete. 

 

Figure 159: Deleating Sylk Device 

 

Note:  

Whenever you add or delete any Sylk device or modify any Sylk params, effective Sylk device will not perfor 

read and write function. 

This modification will not impact the read and write function of other commissioned Sylk device.  

Validate Sylk Device 

Validating Sylk device basically to verify the configuration of added Sylk device. Also, it verifies the any 

incorrect value entered in parameters or limitation for the configured Sylk device.  

You can perform validation for all the added Sylk Devices or single Sylk Device. 

To validate all Sylk Device: 

1. Navigate Config > Drivers > IPCNetwork and right-click LocalDevice. 

2. On command list, select Actions > Validate Sylk Devices. 

 



HONEYWELL CIPer MODEL 30 SYSTEM ENGINEERING USER GUIDE 

SYLK DEVICE PROGRAMMING SylkDevices 

31-00237EFS - 02 | 155  

 

Figure 160: Sylk Devices Validation 

To validate single Sylk Device: 

1. Navigate Config > Drivers > IPCNetwork > LocalDevice and right-click on Sylk device. 

2. On command list, select Actions > Validate Sylk Device. 

 

Figure 161: Sylk Device Validation 

After you run the Validate Sylk Device, on the Job Log window, you view the status of the con-

figured Sylk Devices. 
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Figure 162: Sylk Device validation status 

You can perform this operation in online mode as well as while configuring Sylk devices on 

workstation in offline mode. 
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Sylk Ping 

User can perform Sylk ping from a Sylk device or Local device. Sylk ping verifies and shows status based 

on device connected on the network at the configured address. 

To run Sylk Ping, Navigate to the Sylk device in Nav window > Actions > Ping. 

 

• If no device connected at configured address Status displays Down, in this case Fault Cause 

shows No device found and Sylk Device stops read write operation.  

All Sylk parameters associated with the Sylk device will also be updated with the same status and 

fault cause 

• If user has configured TR75 and connected TR42 at the configured address then  Status displays 

Down, in this case Fault Cause shows Incompatible device found and Sylk Device stops read 

write operation.  

• If the device configured matching with the device connected on network, then Status displays 

Ok and Sylk Device resumes read write operation. 

 

To perform Sylk Ping for multiple connected device, Navigate to the Local device in Nav window > Ac-

tions > Ping Sylk Devices. 
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Note:  

User can perform ping explicitly from Sylk device or Local device, on Sylk commission auto Sylk ping will 

be happen on all configured Sylk devices, to verify the compatibility. 

Basic Sylk Devices 

SylkDevice C7400S Configuration 

The C7400S Sylk Bus sensor is a combination temperature and humidity sensor, which is intended to 

be used in commercial roof top units for sensing air. The sensor is powered by and communicates on 

the Sylk Bus. The C7400S communicates temperature and humidity information digitally separately 

on the Sylk Bus Communication Protocol.  

To add C7400S:  

1. Navigate to the ipcProgrammingTool palette.  

If there is no palette visible on the left pane, on the Menu bar, select Window > Side Bars > 

Palette. The ipcProgrammingTool palette is displayed. 

2. Navigate to IPCNetwork > Local Device. 

3. Drag and Drop the C7400S module from the ipcProgrammingTool palette to Local Device in the 

Nav tree and double-click the Sequenced Control Program or Event Control Program folder to 

open wire sheet view.  

4. Drag and drop the ROOMTEMP and HUMIDITY onto the wire sheet (C7400S supports only Tem-

perature & Humidity Sensor). 

5. Enter the name of the sensors and click Ok. The sensors are added and  appear on the wire 

sheet. 

6. Double-click the ROOMTEMP sensor on the wire sheet to configure its properties (refer Room 

Temperature Configuration). 
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  Figure 163: ROOMTEMP Property Sheet  

7. Double-click the HUMIDITY sensor on the wire sheet to configure its properties (ref Humidity Con-

figuration). 

 

Figure 164: HUMIDITY Property Sheet 

8. Click Save to save the changes made. 

Or click Refresh and then No, if you do not want to save the changes. 

 

Note:  

tR7XConfig and tR4X configuration is not applicable for C7400S sensor. 
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Table 22: Sylk Zeleny Modules and Parameters 

Parameter Module 

C7400S (Zeleny) 

ROOMTEMP Y 

HUMIDITY Y 
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SylkDevice TR7X or TR4X Configuration 

To add TR7X or TR4X:  

1. Navigate to the ipcProgrammingTool palette.  

If there is no palette visible on the left pane, on the Menu bar, select Window > Side Bars > 

Palette. The ipcProgrammingTool palette is displayed. 

2. Navigate to IPCNetwork > Local Device. 

9. Drag and Drop the TR7X module from the ipcProgrammingTool palette to Local Device in the 

Nav tree double-click the Sequenced Control Program or Event Control Program folder to open 

wire sheet view.  

3. Drag and drop the Sylk parameters modules from the SylkParams into the wire sheet or under the 

LocalDevice.  

Note: While adding Sylk parameters to the Wiresheet, don’t select HomeScreen.  

4. Enter the name of the parameters and click OK. The sensors are added, and they appear on the 

wire sheet. 

5. Drag and drop the HomeScreen parameter from the ipcProgrammingTool palette to the supported 

Sylk device present under Local Device in the Nav tree. 

Following is the property sheet of a TR7X Sylk device. 

 

Figure 165: Property Sheet of TR7X Sylk Device 
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Following is the property sheet of a TR4X Sylk device. 

 

Figure 166: Property Sheet of TR4X Sylk Device 

Categories and Parameters Node 

Categories and Parameters node allows user to reorder Sylk categories and Sylk parameters from work-

bench and browser. Sylk device will display the categories and parameters in the order specified in this 

place. 

 

Reordering can be done once user is completed with Sylk device and parameters configuration. 
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Note:  

Only TR7X Sylk devices supports reordering feature. 

Reordering Parameters and Categories 

The parameters can be reorder across the categories as well as in a category. Also, user can reorder 

Categories. 

To perform reordering  

1. Navigate to TR7X from Nav window and double click Categories and Parameters Node. 

 

Figure 167: Categories and Parameters Node 

2. Select Categories and Parameters Node and right click > Actions > Load Categories And Pa-

rameters. 

This will load all the categories and parameters associated with this Sylk device. 

3. Right click on any Category from the Property Sheet and select Reorder. 

 

Figure 168: Categories and Parameters Node Property Sheet 

4. Use Move Up or Move Down to reorder the parameter and Click Ok. 
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Figure 169: Category Reordering 

Similarly, you reorder for Categories also.  

Also, you can perform the similar reordering from Nav window.  

 

Once reordering is completed and Sylk commission is done, user can see the same order of categories 

and parameters in the connected Sylk device. 

Categories and Parameters Node allows user to see all the parameters associated with that device, and 

also provides an option to navigate to the parameter using the ord. 
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Note:  

To reflect any changes done in Sylk device and sylk parameter, user need to run below action. 

Navigate to Actions > Load Categories And Parameters.  

 

Figure 170: Load Categories And Parameters 

Renaming Parameter and Categories 

Categories and Parameters node allows user to rename categories as well as parameters from work-

bench. 

To rename Parameter 

1. Select parameter from the category, right click and select Rename. 

2. This action brings Rename window, enter the new name and click Ok. 

3. Navigate to Categories and Parameters node, right click and select Actions > Load Catego-

ries And Parameters. This action loads the changes. 

In the wiresheet, user can view the parameter is renamed with the new name. 

Similarly, user can rename the Categories also. 

To rename Categories 

1. Select category, right click and select Rename. 

2. This action brings Rename window, enter the new name and click Ok. 

3. Navigate to Categories and Parameters node, right click and select Actions > Load Catego-

ries And Parameters. This action loads the changes in the category, simultaneously affecting all 

the parameters associated with the category.  

In the wiresheet, user can view that category name under all parameters associated with it, is up-

dated with new name. 
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Figure 171: Renaming Parameter and Categories 

Disassociating Parameter and Categories 

Categories and Parameters node allows user to disassociating categories and parameters from the asso-

ciated Sylk Device. 

To disassociate Parameter, select parameter from the category > right click and select Delete. This action 

disassociates that parameter from the Sylk device, and none will be displayed for that Sylk parameter.  

To disassociate Category, select category > right click and select Delete. This action disassociates all the 

parameters from the Sylk device, and none will be displayed for all the parameters that associated with 

that category. 

 

Figure 172: Disassociating Parameter and Categories  
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Sylk Schedule 

The Schedule function block helps you to configures priorities schedule tasks for the controller. The sched-

uler allows you to determine the controller current occupancy state for present day and defined occupancy 

status for next day. An external device via LON communications may update the time of day and date. This 

function calculates: 

1. Current State 

2. Next State 

3. Time Until Next Change of State (TUNCOS) based on the date and time. 

 

Logic Diagram 

 

Function Block 

Figure 173: Schedule Function 

Also, you can set the activities that need to be performed when the system is in idle state or the system is 

down (not functioning). The schedule function calculates the current occupancy state, next state, and time 

until next change of state (TUNCOS) based on the date/time and the schedule. It makes them available as 

public variables. 
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Figure 174: Schedule 

Inputs 

Scheduler function block fetch data and time from the operating system. This input data utilized by the 

function block to deliver output. 

Outputs 

• Current State:  This state provide output for the preset day or current date. Following are the default 

output states.  

o Occupied means use the occupied setpoint. 

o Unoccupied means use the unoccupied setpoint. 

o Standby means use the standby setpoint. 

• Next State: This state provides the output after the current occupancy state is complete.  

o Unoccupied means the next state is unoccupied. 

o Standby means the next state is standby. 
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o OCCNUL means the next state unknown. 

• TUNCOS: This is the time duration (in minutes) until the next change of state happen. The controller 

uses this to recover the setpoint. 

Range: 0 to 11520 minutes (8 days). 11520 minutes means the time until next change of state is 

unknown or further in the future. 

The enumeration values for all occupancy states are: Occ = 0, Unocc = 1, Bypass = 2, Standby = 

3, Null = 255. 
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Sylk Schedule Configuration 

1. Double-click SylkSchedule on the wire sheet to configure the properties. 

 

Figure 175: Property Sheet of SylkSchedule 

• Status: Read-only point. Shows the status of the parameter. (alarm, fault, overridden, disabled, 

down, stale, null, unackedAlarm). For further details see Sylk Component Status Behaviors. 

• faultCause: Read-only point. Indicates the reason why the parameter is in fault. This property is 

empty unless a fault exists. When there are more than one errors, the fault cause shows only the 

error which is at the top of the list of errors. If the error is corrected, the next error is shown. 

• CURRENT_STATE: Provides is the occupancy state the controller must be in at this minute 

• NEXT_STATE: Provides the occupancy state the controller goes to after the current state is com-

plete 

• TUNCOS: Provides the time (in minutes) until the next change of state 

• Schedule: Internal block, and it is used to calculate TUNCOS 

2. Click Save to save the changes made. 

Or click Refresh and then No, if you do not want to save the changes. 

The Sylk commissioning process shows the validation error, when following conditions are not met. 

Four events for a day and the holidays in Sylk schedule with same events. 
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SylkSchedule 

The SylkSchedule parameter is used in TR75 and TR75H devices. Following is the workflow of the 

SylkSchedule parameter. 

1. Navigate to the Sequenced Control Program folder wire sheet. 

2. Add TR75H module to the LocalDevice folder. 

3. Navigate to the SylkSchedule parameter under ipcProgrammingTool palette. 

4. Drag and drop the SylkSchedule parameter onto the wire sheet. 

 

Figure 176: Function Block of SylkSchedule 

5. Double-click the SylkSchedule block. The property sheet of the SylkSchedule block is displayed. 

6. Click Schedule. The AX Scheduler is displayed. 

 

Figure 177: Schedule Option 

 

Figure 178: AX Scheduler 
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7. Add the schedule events as required and save the changes. 

8. Open the property sheet of TR75H model. 

 

Figure 179: Property Sheet of TR75H Model 

9. Set the Schedule Editable From Zio field to Yes. 

10. Change Param Permissions (Contractor Only, Tenant Read only, and Tenant Write only) as per 

requirement. 

11. Change the Schedule Type as per requirement (8 day schedule/ 7 day schedule/ 5-2-1 day sched-

ule/ 5-2 day schedule). 

12. Enter the schedule block location in the Schedule Block Location field. 

To Enter Scheduler Block Location: 

1) Click Folder icon ( ) and select Component Chooser from the drop-down list. 

2) On the Select Ord window, Click Drivers > IPCNetwork > LocalDevice > Points > Se-

quenced Control Program > SylkSchedule, and click OK. 

This action fetch scheduler location to the Scheduler Block Location filed.   

Or 

1) Go to Nav Window, navigate to the Station > Config > Drivers > IPCNetwork > LocalDevice 

> Points > Sequenced Control Program > Select SylkSchedule, and press Ctrl + L. 

2) This action opens Ord window, copy the location, and paste in the Scheduler Block Location 

field.   
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13. Click Save. 

Or click Refresh to cancel the changes. 

 

Note:  

• Sylk Commissioning fails if the number of events configured per day exceed three and if holidays that 

have schedule are not matching.  

• The Niagara EnumSchedule block, present under schedule palette, is also supported. So, you can 

give the location of the Niagara schedule in the Schedule Block Location field. 

 

Figure 180: Function Block EnumSchedule 

• Schedule configuration work flow changes - after changing any schedule changes in tool perform sylk 

commission  

Migrating Sylk Scheduled Events from SPYDER 

Spyder To IPC Migrator tool capable of migrating the existing Spyder sylk scheduled events to CIPer 

Model 30 sylk scheduled events. 

Follow the below steps to migrate Spyder sylk scheduled events to CIPer Model 30 sylk scheduled 

events: 
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1. Navigate to Spyder schedule function block, click Scheduling tab, and click the day of the week 

to select the day needs to be configured user wants to configure the schedule. For more details, 

refer Spyder User Guide. 

2. Click Apply Event. 

 

Figure 181: Scheduling View of Spyder Events 

3. Navigate to Tools > Spyder To IPC Migrator tool. 

4. Select the file type as Library in the File Type drop-down menu. 

5. Click Browse next to the Select Niagara Home Directory field to select the path, where the list 

of libraries is available. 

6. Browse to the Output directory, where the migrated applications are stored. 

7. Click Migrate.  
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8. Spyder To IPC Migrator tool popup after successful migration, click Ok. 

9. Navigate to CIper schedule function block, click Scheduling tab. 

 

Figure 182: Scheduling View of CIPer Events 

You can view all the migrated scheduled events from Spyder Sylk Schedule, displayed in CIPre Sylk 

Schedule window. 

Scheduling Enum Range 

To define Enum range: 

1. Navigate to Sylkschedule > Schedule Properties tab > Facets option, select default range (hon-

eywellSylkDevice:ScheduleStateEnum), and click () icon.  

 

Figure 183: Defining Enum range 

2. Select the default EnumRange, click (…) icon, and click () icon. 
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Figure 184: Default Enum Range 

To modify and add the entry in the Zio Enum Library: 

1. Select the entry. 

2. Modify the Ordinal value, Display field, and Tag field and click Modify. 

Or  

Change the Ordinal value, Display field, and Tag field and click Add. 

 

Note:  

• A total of maximum 255 entries can be added in a Zio enum library. 

• All the Holidays that are schedule in Spyder Schedular, after migration applicable to CIPer Sylk 

Schedular. 

•  All the unconfigured events in Spyder Schedular, displays Unscheduled in CIPer Schedular. 

• Unscheduled events in Spyder Schedular, display Unoccupied as default output for CIPer Sched-

ular. 

• In configured Schedule events gaps also consider as event (Tool will always write 4th event as de-
fault event (eg., UnOccupied), so that user can edit the end time of 3rd event. While reading the 
schedule from wall module, tool will not create default-event except in case non-continuous events 
ie., while filling the gaps)   
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Sylk Parameters 

This section in the ipcProgrammingTool palette contains the list of parameters available. Based on your 

requirement, you can add the parameters for the Sylk devices. 

 

Figure 185: SylkParams View 

Following are the Sylk parameters: 

• BypassTime: To provide the bypass time to wall module 

• CO2: CO2 concentration in the space 

• ControllerValue: Value from the controller to the wall module 

• FanCommand: To provide commands to the fan from wall module 

• HUMIDITY: Percent humidity of the Space 

• HomeScreen: To configure the LED display of wall module 

• NetworkSetpoint: To provide the setpoints to the wall module 

• OccupancyOverrideCommand: To override the Unoccupancy Mode to Occupied Mode 

• OccupancyStatus: Occupancy status in the wall module 

• ROOMTEMP: Temperature of the space 
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• SensorOffset: To provide the sensor offset to wall module 

• SylkSchedule: To add occupancy schedule to the wall module 

• SylkTime: to configure and change the value of Sylk module and platform time as well 

• SystemCommand: To override the system command from the wall module 

• SystemStatus: System status in the wall module 

• TimeField: To configure the time format of wall module  

• TimeOfDay: Time of the day to show on Sylk Device 

• ValueFromWallModule: To provide the value from the wall module to the controller 

 

Note:  

If you are using two network setpoints and if you connect the output of first block to the input of second 

block, the value of the second block does not reflect in the first block unless you connect the output of the 

second block to the input of the first block. The change in the workflow is handled in the migration process 

by providing the connection from destination component to the source component, so that the values are 

updated in the source component also.  
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Bypass Time Configuration 

1. Double-click BypassTime sensor on the wire sheet to configure the sensor properties. 

 

Figure 186: Property Sheet of BypassTime 

• sylkDevice: Select the required TR7x device from the drop-down menu  

 

Figure 187: sylkDevice Drop-Down Menu 

• Status: Read-only point. Shows the status of the parameter. (alarm, fault, overridden, disabled, 

down, stale, null, unackedAlarm). For further details see Sylk Component Status Behaviors. 

• faultCause: Read-only point. Indicates the reason why the parameter is in fault. This property is 

empty unless a fault exists. When there are more than one errors, the fault cause shows only the 

error which is at the top of the list of errors. If the error is corrected, the next error is shown. 

• pollInterval: Poll interval is the time between the end of a timeout period or completion of a network 

request, and the next request for data on the network 

• enableFD: Fail Detect is the time until the CIPer Model 30 is notified of a failure on this point.  

o True: If the parameter has not received an update from the IPC network source in the fail 

detect time, then an alarm is generated and the present Value is set to Invalid. Note that fail 

detect time depends on the update rate configured. 

o False: False means the object retains the last value that was written to it until a IPC network 

source changes it or the Honeywell CIPer Model 30 has a power outage or reset 
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• In: To provide the Controller Bypass Time Value to the Wall module. 

• OUT: To provide the wall module Bypass Time Value to the controller 

2. Click Save to save the changes made. 

Or click Refresh and then No, if you do not want to save the changes. 
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CO2 Configuration 

1. Double-click CO2 sensor on the wire sheet to configure the sensor properties. 

 

Figure 188: Property Sheet of CO2 

• sylkDevice: Select the required TR4x device from the drop-down menu  

 

Figure 189: sylkDevice Drop-Down Menu 

• Status: Read-only point. Shows the status of the parameter. (alarm, fault, overridden, disabled, 

down, stale, null, unackedAlarm). For further details see Sylk Component Status Behaviors. 

• faultCause: Read-only point. Indicates the reason why the parameter is in fault. This property is 

empty unless a fault exists. When there are more than one errors, the fault cause shows only the 

error which is at the top of the list of errors. If the error is corrected, the next error is shown. 

• pollInterval: Poll interval is the time between the end of a timeout period or completion of a network 

request, and the next request for data on the network. 

• category: The category defined by the user while configuring Sylk parameters. By default, it shows 

Category as category 

• paramPermissions: User can select the viewing option for the parameter. Select the parameter 

as viewable by Contractor Only or Tenant Read Only from the drop-down menu. If Contractor 

Only is selected, only the contractor can view the parameters in the wall module. If Tenant Read 

Only is selected, tenant can view the parameters, but cannot make any changes in the parameters. 
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Figure 190: paramPermissions Drop-Down Menu 

• enableFD: Fail Detect is the time until the CIPer Model 30 is notified of a failure on this point.  

o True: If the parameter has not received an update from the IPC network source in the fail 
detect time, then an alarm is generated and the presentValue is set to Invalid. Note that fail 
detect time depends on the update rate configured. 

o False: False means the object retains the last value that was written to it until a IPC network 
source changes it or the Honeywell CIPer Model 30 has a power outage or reset 

• OUT: Shows the current value of the parameter 

• temperatureUnit: Select the unit as Degree F or Degree C as per requirement 

2. Click Save to save the changes made. 

Or click Refresh and then No, if you do not want to save the changes. 
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Value From Controller Configuration 

1. Double-click ControllerValue on the wire sheet to configure the properties. 

  

Figure 191: Property Sheet of ControllerValue 

• sylkDevice: Select the required TR7x or TR4x device from the drop-down menu  

 

  Figure 192: sylkDevice Drop-Down Menu 

• Status: Read-only point. Shows the status of the parameter. (alarm, fault, overridden, disabled, 

down, stale, null, unackedAlarm). For further details see Sylk Component Status Behaviors. 

• faultCause: Read-only point. Indicates the reason why the parameter is in fault. This property is 

empty unless a fault exists. 

• pollInterval: Poll interval is the time between the end of a timeout period or completion of a network 

request, and the next request for data on the network 

• category: The category defined by the user while configuring Sylk parameters. By default, it shows 

Category as category 

• paramPermissions: User can select the viewing option for the parameter. Select the parameter 

as viewable by Contractor Only or Tenant Read Only from the drop-down menu. If Contractor 
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Only is selected, only the contractor can view the parameters in the wall module. If Tenant Read 

Only is selected, tenant can view the parameters, but cannot make any changes in the parameters. 

 

Figure 193: paramPermissions Drop-Down Menu 

• enableFD: Fail Detect is the time until the CIPer Model 30 is notified of a failure on this point. 

o True: If the parameter has not received an update from the IPC network source in the fail 

detect time, then an alarm is generated and the presentValue is set to Invalid. Note that fail 

detect time depends on the update rate configured. 

o False: False means the object retains the last value that was written to it until a IPC network 

source changes it or the Honeywell CIPer Model 30 has a power outage or reset. 

• in: To provide the Setpoints from the controller to the Wall module.  

• enumerated: This option allows the user to provide Enum Setpoints 

• enumDefinition: If the Enumerated is set to true then user can set the multiple states of the Enum 

setpoint. 

a. To set the Enum states of the Setpoint click on the >> button. 

 

Figure 194: enumRange Parameter 

b. Set the states Ordinal & Display as per requirement. For example, 

 

Figure 195: Enum Window 

c. Click Ok to save. 



HONEYWELL CIPer MODEL 30 SYSTEM ENGINEERING USER GUIDE 

SYLK DEVICE PROGRAMMING Sylk Parameters 

31-00237EFS - 02 | 185  

• defaultEnumValue: This option displays list of default Enum value from the defined enum 
range. 

• numberofDecimals: Provide the value of numbers of decimal as per requirement. 

• selectLabelsToShowOnScreen: Select the required option to show the parameter on the home 

screen shown below: 

 

Figure 196: Sub-Menu of selectLabelsToShowOnScreen 

2. Click Save to save the changes made. 

Or click Refresh and then No, if you do not want to save the changes. 
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Fan Command Configuration 

1. Double-click FanCommand on the wire sheet to configure the properties. 

 

Figure 197: Property Sheet of FanCommand 

• sylkDevice: Select the required TR7x or Tr4x device from the drop-down menu  

 

Figure 198: sylkDevice Drop-Down Menu 

• Status: Read-only point. Shows the status of the parameter. (alarm, fault, overridden, disabled, 

down, stale, null, unackedAlarm). For further details see Sylk Component Status Behaviors. 
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• faultCause: Read-only point. Indicates the reason why the parameter is in fault. This property is 

empty unless a fault exists. When there are more than one errors, the fault cause shows only the 

error which is at the top of the list of errors. If the error is corrected, the next error is shown. 

• pollInterval: Poll interval is the time between the end of a timeout period or completion of a network 

request, and the next request for data on the network 

• enableFD: Fail Detect is the time until the CIPer Model 30 is notified of a failure on this point.  

o True: If the parameter has not received an update from the IPC network source in the fail 

detect time, then an alarm is generated and the present Value is set to Invalid. Note that fail 

detect time depends on the update rate configured. 

o False: False means the object retains the last value that was written to it until a IPC network 

source changes it or the Honeywell CIPer Model 30 has a power outage or reset 

• In: To provide the Fan Enable Command from the controller to the Wall module. 

• Out: To provide the Final Fan Enable Command from wall module to the controller 

• fanStates: Select the States of the Fan command from the wall module as per requirement. 

 

Figure 199: Sub-Menu of fanStates 

• fanStatusValues: Set the Fan State Values as per requirement. 

 

Figure 200: Sub-Menu of fanStatusValues 

• tR7XConfig: 

o Default Fan State: Set the default state of Fan Command. 
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Figure 201: Sub-Menu of tR7XConfig 

• SetAsNetworksetpoint: This option allows you to specify, if the param needs to be configured as 

network set point or output only param. If you select Yes, then you have access to write and read 

values, if No selected you only have access to read values from sylk device. 

2. Click Save to save the changes made. 

Or click Refresh and then No, if you do not want to save the changes. 
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Humidity Configuration 

1. Double-click HUMIDITY sensor on the wire sheet to configure the sensor properties. 

 

Figure 202: Property Sheet of HUMIDITY 

• sylkDevice: Select the required TR7x or TR4x device from the drop-down menu. 
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Figure 203: sylkDevice Drop-Down Menu 

• Status: Read-only point. Shows the status of the parameter. (alarm, fault, overridden, disabled, 

down, stale, null, unackedAlarm). For further details see Sylk Component Status Behaviors.  

• faultCause: Read-only point. Indicates the reason why the parameter is in fault. This property 

is empty unless a fault exists. When there are more than one errors, the fault cause shows only 

the error which is at the top of the list of errors. If the error is corrected, the next error is shown. 

• pollInterval: Poll interval is the time between the end of a timeout period or completion of a 

network request, and the next request for data on the network 

• category: The category defined by the user while configuring Sylk parameters. By default, it 

shows Category as category 

• paramPermissions: User can select the viewing option for the parameter. Select the param-

eter as viewable by Contractor Only or Tenant Read Only from the drop-down menu. If Con-

tractor Only is selected, only the contractor can view the parameters in the wall module. If 

Tenant Read Only is selected, tenant can view the parameters, but cannot make any changes 

in the parameters. 

 

Figure 204: paramPermissions Drop-Down Menu 

• enableFD: Fail Detect is the time until the CIPer Model 30 is notified of a failure on this point.  

o True: If the parameter has not received an update from the IPC network source in the 

fail detect time, then an alarm is generated and the presentValue is set to Invalid. Note 

that fail detect time depends on the update rate configured. 

o False: False means the object retains the last value that was written to it until a IPC net-

work source changes it or the Honeywell CIPer Model 30 has a power outage or reset 

• OUT: Shows the current value of the parameter 

• tR7XConfig: 

o Number of Decimals: Enter the decimal accuracy 

o Default Sensor Offset Value: Enter the default value for sensor offset 
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o Select Labels To Show On Screen: Select the Humidity option to show the parameter on 

the home screen. 

 

Figure 205: Sub-Menu of tR7XConfig 

2. Click Save to save the changes made. 

Or click Refresh and then No, if you do not want to save the changes. 
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HomeScreen Options Configuration 

1. Double-click homeScreenOptions present under the respective TR7x module to configure the proper-

ties. 

 

Figure 206: Property Sheet of Room Temperature 

• Set As Default: Select this option if the current Home screen need to be set as default  

• Option Type: Select the type of screen is required 

 

Figure 207: Option Type Drop-Down Menu 

• Label Name: Add the label name as per requirement 

• Note: “Specify the parameter you want to show.” 

• Left Parameter: Select the parameter need to be shown on left side of the home screen 

• Middle Parameter: Select the parameter need to be shown on middle of the home screen 

• Right Parameter: Select the parameter need to be shown on right side of the home 

• Select Labels To Show On Home Screen: Select the required option (Room top or Room Bottom) 

to show the parameter on the home screen shown below: 
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Figure 208: Sub-Menu of Select Labels To Show On Home 

2.  Click Save to save the changes made. 

Or click Refresh and then No, if you do not want to save the changes. 
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Network Setpoint Configuration 

These are outputs from the wall module such as room setpoint 

1. Double-click NetworkSetpoint on the wire sheet to configure the properties. 

  

Figure 209: Property Sheet of NetworkSetpoint 

• sylkDevice: Select the required TR7x or TR4x module from the drop-down menu  

 

Figure 210: sylkDevice Drop-Down Menu 

• Status: Read-only point. Shows the status of the parameter. (alarm, fault, overridden, disabled, 

down, stale, null, unackedAlarm). For further details see Sylk Component Status Behaviors.  

• faultCause: Read-only point. Indicates the reason why the parameter is in fault. This property is 

empty unless a fault exists. When there are more than one errors, the fault cause shows only the 

error which is at the top of the list of errors. If the error is corrected, the next error is shown. 
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• pollInterval: Poll interval is the time between the end of a timeout period or completion of a network 

request, and the next request for data on the network 

• category: The category defined by the user while configuring Sylk parameters. By default, it shows 

Category as category 

• paramPermissions: User can select the viewing option for the parameter. Select the parameter 

as viewable by Contractor Only, Tenant Read Only, or Tenant Read Write from the drop-down 

menu. If Contractor Only is selected, only the contractor can view the parameters in the wall mod-

ule. If Tenant Read Only is selected, tenant can view the parameters, but cannot make any changes 

in the parameters. If Tenant Read Write is selected, tenant can view as well as modify the param-

eters. 

 

Figure 211: paramPermissions Drop-Down Menu 

• enableFD: Fail Detect is the time until the CIPer Model 30 is notified of a failure on this point.  

o True: If the parameter has not received an update from the IPC network source in the fail detect time, 
then an alarm is generated and the presentValue is set to Invalid. Note that fail detect time depends on 
the update rate configured. 

o False: False means the object retains the last value that was written to it until a IPC network source 
changes it or the Honeywell CIPer Model 30 has a power outage or reset 

• in: To provide the Controller Setpoint Value to the Wall module. 

• OUT: To provide the wall module Setpoint Value to the controller 

• allowNullValue: This option allows the user to provide Null value 

• selectLabelsToShowOnScreen: Select the required option (Setpoint top or Setpoint Bottom) to 

show the parameter on the home screen shown below: 
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Figure 212: selectLabelsToShowOnScreen Drop-Down Menu 

 

Figure 213: Display of Wall Module TR7X 

2. Click Save to save the changes made. 

Or click Refresh and then No, if you do not want to save the changes. 
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OccupancyOverrideCommand Configuration 

1. Double-click OccupancyOverrideCommand on the wire sheet to configure the properties. 

 

Figure 214: Property Sheet of OccupancyOverrideCommand 

• sylkDevice: Select the required TR7x or TR4x device from the drop-down menu. 

  

Figure 215: sylkDevice Drop-Down Menu 

• Status: Read-only point. Shows the status of the parameter. (alarm, fault, overridden, disabled, 

down, stale, null, unackedAlarm). For further details see Sylk Component Status Behaviors.  

• faultCause: Read-only point. Indicates the reason why the parameter is in fault. This property is 

empty unless a fault exists. 
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• pollInterval: Poll interval is the time between the end of a timeout period or completion of a network 

request, and the next request for data on the network. 

• enableFD: Fail Detect is the time until the CIPer Model 30 is notified of a failure on this point.  

o True: If the parameter has not received an update from the IPC network source in the fail 

detect time, then an alarm is generated and the presentValue is set to Invalid. Note that fail 

detect time depends on the update rate configured. 

o False: False means the object retains the last value that was written to it until a IPC network 

source changes it or the Honeywell CIPer Model 30 has a power outage or reset 

• OUT: Provide the Override Command to the wall module from the wall module 

• tR7XConfig: 

o Override To Occupied Settings:  

 

Figure 216: Sub-Menu of tR7XConfig 

▪ Override Occupied State: To override the current occupancy state to Occupied mode 

▪ Override Type:  

➢ Continuous Override: This will keep the system occupancy status in continuous 

occupied mode irrespective of system schedule 

➢ Timed Override: To provide the desired override timings in hours and minute for-

mat. User can override the system for the desired time by selecting the required 

days, Hours and minutes values. The Timed Override in Hours (Bypass) option is 

to override the system for required hours. The Timed Override in Minutes (Bypass) 

option is to override the system for required minutes. 

▪ Use Network Bypass Time Only: By clicking yes in Use Network Bypass Time Only option 

disables all other delays option (for example, Min Time Days, and so on). The timed over-

ride details will be determined by the programmable controller configuration. This option 

only applies to Occupancy override settings. Unoccupied and Standby do not use bypass. 

▪ Note: Shows the note One "Day" is a 24-hour period from the time the override is initiated. 

▪ Min Time Days: Provide the Maximum Days for override to occupied mode. 
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▪ Max Time Days:  Provide the Minimum Days for override to occupied mode. 

▪ Min Time Hours: Provide the Maximum Hours for override to occupied mode. 

▪ Max Time Hours: Provide the minimum Hours for override to occupied mode. 

▪ Min Time Minutes: Provide the Maximum Minutes for override to occupied mode. 

▪ Max Time Minutes: Provide the Minimum Minutes for override to occupied mode. 

o Override To Unoccupied Settings:  

 

Figure 217: Sub-Menu of tR7XConfig-Un Occupied Override Details Config 

▪ Override Unoccupied State: To override the current occupancy state to Unoccupied mode 

▪ Override Type:  

➢ Continuous Override: This will keep the system occupancy status in continuous 

occupied mode irrespective of system schedule 

➢ Timed Override: To provide the desired override timings in hours and minute for-

mat. User can override the system for the desired time by selecting the required 

days, Hours and minutes values. The Timed Override in Hours (Bypass) option is 

to override the system for required hours. The Timed Override in Minutes (Bypass) 

option is to override the system for required minutes. 

▪ Note: Shows the note One "Day" is a 24-hour period from the time the override is initiated 

▪ Min Time Days: Provide the Maximum Days for override to unoccupied mode. 

▪ Max Time Days:  Provide the Minimum Days for override to unoccupied mode. 

▪ Min Time Hours: Provide the Maximum Hours for override to unoccupied mode. 

▪ Max Time Hours: Provide the minimum Hours for override to unoccupied mode. 

▪ Min Time Minutes: Provide the Maximum Minutes for override to unoccupied mode. 

▪ Max Time Minutes: Provide the Minimum Minutes for override to unoccupied mode. 

o Override To Standby Settings:  
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Figure 218: Sub-Menu of tR7XConfig-Standby Override Details Config 

▪ Override Standby State: To override the current occupancy state to Standby mode 

▪ Override Type:  

✓ Continuous Override: This will keep the system occupancy status in continuous occu-

pied mode irrespective of system schedule 

✓ Timed Override: To provide the desired override timings in hours and minute format. 

User can override the system for the desired time by selecting the required days, Hours 

and minutes values. The Timed Override in Hours (Bypass) option is to override the 

system for required hours. The Timed Override in Minutes (Bypass) option is to over-

ride the system for required minutes. 

▪ Note: Shows the note One "Day" is a 24-hour period from the time the override is initiated 

▪ Min Time Days: Provide the Maximum Days for override to Standby mode 

▪ Max Time Days:  Provide the Minimum Days for override to Standby mode 

▪ Min Time Hours: Provide the Maximum Hours for override to Standby mode 

▪ Max Time Hours: Provide the minimum Hours for override to Standby mode 

▪ Min Time Minutes: Provide the Maximum Minutes for override to Standby mode 

▪ Max Time Minutes: Provide the Minimum Minutes for override to Standby mode 

o occupancyValues:  

To define the values for the respective states. 

 

Figure 219: Sub-Menu of tR7X 

2. Click Save to save the changes made. 

Or click Refresh and then No, if you do not want to save the changes.  
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Occupancy Status Configuration 

1. Double-click OccupancyStatus on the wire sheet to configure the properties. 

 

Figure 220: Property Sheet of OccupancyStatus 

• sylkDevice: Select the required TR7x or TR4x device from the drop-down menu  

 

Figure 221: sylkDevice Drop-Down Menu 

• Status: Read-only point. Shows the status of the parameter. (alarm, fault, overridden, disabled, 

down, stale, null, unackedAlarm). For further details see Sylk Component Status Behaviors. 

• faultCause: Read-only point. Indicates the reason why the parameter is in fault. This property is 

empty unless a fault exists. When there are more than one errors, the fault cause shows only the 

error which is at the top of the list of errors. If the error is corrected, the next error is shown. 

• pollInterval: Poll interval is the time between the end of a timeout period or completion of a network 

request, and the next request for data on the network 

• enableFD: Fail Detect is the time until the CIPer Model 30 is notified of a failure on this point.  
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o True: If the parameter has not received an update from the IPC network source in the fail 

detect time, then an alarm is generated and the presentValue is set to Invalid. Note that fail 

detect time depends on the update rate configured. 

o False: False means the object retains the last value that was written to it until a IPC network 

source changes it or the Honeywell CIPer Model 30 has a power outage or reset 

• In: To provide the System Occupancy Status to the Wall module. 

• tR7XConfig: 

o occupancyStatusDisplay: Select the Display option as per requirement 

 

   Figure 222: occupancyStatusDisplay Drop-Down Menu 

2. Click Save to save the changes made. 

Or click Refresh and then No, if you do not want to save the changes. 
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Room Temperature Configuration 

1. Double-click ROOMTEMP sensor on the wire sheet to configure the sensor properties. 

 

Figure 223: Property Sheet of ROOMTEMP 

• sylkDevice: Select the required TR7x or TR4x device from the drop-down menu 

  

Figure 224: SylkDevices List 
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• Status: Read-only point. Shows the status of the parameter. (alarm, fault, overridden, disabled, 

down, stale, null, unackedAlarm). For further details see Sylk Component Status Behaviors 

• faultCause: Read-only point. Indicates the reason why the parameter is in fault. This property 

is empty unless a fault exists. When there are more than one errors, the fault cause shows only 

the error which is at the top of the list of errors. If the error is corrected, the next error is shown. 

• pollInterval: Poll interval is the time between the end of a timeout period or completion of a 

network request, and the next request for data on the network 

• category: The category defined by the user while configuring Sylk parameters. By default, it 

shows Category as category 

• paramPermissions: You can select the viewing option for the parameters. Select Contractor 

Only or Tenant Read Only option from the drop-down of the parameter. If Contractor Only is 

selected, only the contractor can view the parameters in the wall module. If Tenant Read Only 

is selected, tenant can view the parameters, but cannot make any changes in the parameters.  

 

Figure 225:paramPermissions Drop-Down Menu 

• enableFD: Fail Detect is the time until the CIPer Model 30 is notified of a failure on this point.  

o True: If the parameter has not received an update from the IPC network source in 

the fail detect time, then an alarm is generated and the presentValue is set to Inva-

lid. Note that fail detect time depends on the update rate configured. 

o False: False means the object retains the last value that was written to it until a IPC 

network source changes it or the Honeywell CIPer Model 30 has a power outage or 

reset 

• OUT: Shows the current value of the parameter 

• temperatureUnit: Select the unit as Degree F or Degree C as per requirement 

• tR7XConfig: 

o Number of Decimals: Enter the decimal accuracy 

o Default Sensor Offset Value: Enter the default value for sensor offset 

o Select Labels To Show On Screen: Select the required option (Room top or Room 

Bottom) to show the parameter screen. 
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Figure 226: Sub-Menu of tR7XConfig 

 

Figure 227: Display of Wall Module TR7X 

2. Click Save to save the changes made. 

Or click Refresh and then No, if you do not want to save the changes. 
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Sensor Offset Configuration 

These are outputs from the wall module such as room setpoint 

1. Double-click SensorOffset on the wire sheet to configure the properties. 

  

Figure 228: Property Sheet of SensorOffset 

• sylkDevice: Select the required TR7x device from the drop-down menu  

 

Figure 229: sylkDevice Drop-Down Menu 

• Status: Read-only point. Shows the status of the parameter. (alarm, fault, overridden, disabled, 

down, stale, null, unackedAlarm). For further details see Sylk Component Status Behaviors.  

• faultCause: Read-only point. Indicates the reason why the parameter is in fault. This property is 

empty unless a fault exists. When there are more than one errors, the fault cause shows only the 

error which is at the top of the list of errors. If the error is corrected, the next error is shown. 
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• pollInterval: Poll interval is the time between the end of a timeout period or completion of a network 

request, and the next request for data on the network 

• category: The category defined by the user while configuring Sylk parameters. By default, it shows 

Category as category 

• paramPermissions: User can select the viewing option for the parameter. Select the parameter 

as viewable by Contractor Only, Tenant Read Only, or Tenant Read Write from the drop-down 

menu. If Contractor Only is selected, only the contractor can view the parameters in the wall mod-

ule. If Tenant Read Only is selected, tenant can view the parameters, but cannot make any changes 

in the parameters. If Tenant Read Write is selected, tenant can view as well as modify the param-

eters. 

 

Figure 230: paramPermissions Drop-Down Menu 

• sensorSelect: Select the respective sensor.  

 

Figure 231: selectSensor Drop-Down Menu 

• incrementDecrement: Value of the Offset to be increased or decreased at one step.  

• defaultValue: Default value of the Offset. 

• limitConfig: To set the high & low limits of the Offset 

 

Figure 232: Sub-Menu of limitConfig 

o Low Limit From Sylk Param: To select the Low limit value from the other Sylk parame-

ter of the respective system device 

o High Limit From Sylk Param: To select the High limit value from the other Sylk param-

eter of the respective system device 

o Low Limit: Set the constant value for High limit 

o High Limit: Set the constant value for Low limit 
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• numberOfDecimals: Provide the value of numbers of decimal as per requirement. 

• selectLabelsToShowOnScreen: Select the required option (Setpoint top or Setpoint Bottom) to 

show the parameter on the home screen shown below: 

 

Figure 233: selectLabelsToShowOnScreen Drop-Down Menu 

 

Figure 234: Display of Wall Module TR7X 

2. Click Save to save the changes made. 

Or click Refresh and then No, if you do not want to save the changes. 
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Sylk Time Configuration 

1. Double-click SylkTime on the wire sheet to configure the properties. 

 

Figure 235: Property Sheet of SylkTime 

• sylkDevice: Select the required TR7x device from the drop-down menu  

 

Figure 236: sylkDevice Drop-Down Menu 

• Status: Read-only point. Shows the status of the parameter. (alarm, fault, overridden, disabled, 

down, stale, null, unackedAlarm). For further details see Sylk Component Status Behaviors. 

• faultCause: Read-only point. Indicates the reason why the parameter is in fault. This property is 

empty unless a fault exists. When there are more than one errors, the fault cause shows only the 

error which is at the top of the list of errors. If the error is corrected, the next error is shown. 

• paramPermissions: User can select the viewing option for the parameter. Select the parameter 

as viewable by Contractor Only, Tenant Read Only, or Tenant Read Write from the drop-down 

menu. If Contractor Only is selected, only the contractor can view the parameters in the wall mod-

ule. If Tenant Read Only is selected, tenant can view the parameters, but cannot make any changes 

in the parameters. If Tenant Read Write is selected, tenant can view as well as modify the param-

eters. 

 

Figure 237: paramPermissions Drop-Down Menu 

• OUT: To use the time of the wall module. 

2. Click Save to save the changes made. 

Or click Refresh and then No, if you do not want to save the changes. 

 

Note:  

User need to add Sylk time to change the IPC Controller time from sylk device and only one sylk time 

component is allowed per sylk device 
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System Command Configuration 

1. Double-click SystemCommand on the wire sheet to configure the properties. 

 

Figure 238: Property Sheet of SystemCommand 

• sylkDevice: Select the required TR7x device from the drop-down menu  

 

Figure 239: sylkDevice Drop-Down Menu 

• Status: Read-only point. Shows the status of the parameter. (alarm, fault, overridden, disabled, 

down, stale, null, unackedAlarm). For further details see Sylk Component Status Behaviors. 

• faultCause: Read-only point. Indicates the reason why the parameter is in fault. This property is 

empty unless a fault exists. When there are more than one errors, the fault cause shows only the 

error which is at the top of the list of errors. If the error is corrected, the next error is shown. 

• pollInterval: Poll interval is the time between the end of a timeout period or completion of a network 

request, and the next request for data on the network 
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• enableFD: Fail Detect is the time until the CIPer Model 30 is notified of a failure on this point.  

 

Figure 240: enableFD Drop-Down Menu 

o True: If the parameter has not received an update from the IPC network source in the fail 

detect time, then an alarm is generated and the presentValue is set to Invalid. Note that fail 

detect time depends on the update rate configured. 

o False: False means the object retains the last value that was written to it until a IPC network 

source changes it or the Honeywell CIPer Model 30 has a power outage or reset 

• in: To provide the System Command from the controller to the Wall module. 

• OUT: To provide the Final System Command from wall module to the controller 

• systemCommands: Select the modes of the command from the wall module 

 

Figure 241: systemCommands Drop-Down Menu 

• defaultSystemCommands: Select the Default value of the System Command mode. 

 

Figure 242: defaultSystemCommands Drop-Down Menu 

• systemCommandValues: Set the System Command State Values as per requirement 
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Figure 243: systemCommandValues Drop-Down Menu 

• SetAsNetworksetpoint: This option allows you to specify, if the param needs to be configured as 

network set point or output only param. If you select Yes, then you have access to write and read 

values, if No selected you only have access to read values from sylk device. 

2. Click Save to save the changes made. 

Or click Refresh and then No, if you do not want to save the changes. 
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System Status Configuration 

1. Double-click SystemStatus on the wire sheet to configure the properties. 

 

Figure 244: Property Sheet of SystemStatus 

• sylkDevice: Select the required TR7x device from the drop-down menu  

 

Figure 245: sylkDevice Drop-Down Menu 

• Status: Read-only point. Shows the status of the parameter. (alarm, fault, overridden, disabled, 

down, stale, null, unackedAlarm). For further details see Sylk Component Status Behaviors. 

• faultCause: Read-only point. Indicates the reason why the parameter is in fault. This property is 

empty unless a fault exists. When there are more than one errors, the fault cause shows only the 

error which is at the top of the list of errors. If the error is corrected, the next error is shown. 

• pollInterval: Poll interval is the time between the end of a timeout period or completion of a network 

request, and the next request for data on the network 

• EnableFD: Fail Detect is the time until the CIPer Model 30 is notified of a failure on this point.  
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o True: If the parameter has not received an update from the IPC network source in the fail 

detect time, then an alarm is generated and the presentValue is set to Invalid. Note that fail 

detect time depends on the update rate configured. 

o False: False means the object retains the last value that was written to it until a IPC network 

source changes it or the Honeywell CIPer Model 30 has a power outage or reset 

• in: To provide the system Status from the controller to the Wall module. 

• System Status Values: Set the System Sate as per requirement 

 

  Figure 246: Sub-Menu of systemStatusValues 

2. Click Save to save the changes made. 

Or if you do not want to save the changes, click Refresh and then No. 
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Time Field Configuration 

1. Double-click TimeField parameter on the wire sheet to configure the sensor properties. 

  

Figure 247: Property Sheet of TimeField 

• sylkDevice: Select the required TR7x device from the drop-down menu 

 

Figure 248: sylkDevice Drop-Down Menu 

• Status: Read-only point. Shows the status of the parameter. (alarm, fault, overridden, disabled, 

down, stale, null, unackedAlarm). For further details see Sylk Component Status Behaviors.  

• faultCause: Read-only point. Indicates the reason why the parameter is in fault. This property is 

empty unless a fault exists. 

• pollInterval: Poll interval is the time between the end of a timeout period or completion of a network 

request, and the next request for data on the network 

• category: The category defined by the user while configuring Sylk parameters. By default, it shows 

Category as category 
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• paramPermissions: User can select the viewing option for the parameter. Select the parameter 

as viewable by Contractor Only or Tenant Read Only from the drop-down menu. If Contractor 

Only is selected, only the contractor can view the parameters in the wall module. If Tenant Read 

Only is selected, tenant can view the parameters, but cannot make any changes in the parameters. 

If Tenant Read Write is selected, tenant can view as well as modify the parameters. 

 

Figure 249: paramPermissions Drop-Down Menu 

• enableFD: Fail Detect is the time until the CIPer Model 30 is notified of a failure on this point.  

 

Figure 250: enableFD Drop-Down Menu 

o True: If the parameter has not received an update from the IPC network source in the fail 

detect time, then an alarm is generated and the presentValue is set to Invalid. Note that fail 

detect time depends on the update rate configured. 

o False: False means the object retains the last value that was written to it until a IPC network 

source changes it or the Honeywell CIPer Model 30 has a power outage or reset 

• in: To provide the Controller time to the wall module. 

• OUT: To provide the wall module time to the controller 

• timeComponent: Set the parameter of the time as per requirement 

 

Figure 251: timeComponent Drop-Down Menu 

• automaticallyUpdateControllerTime: To update the controller time as per the time of wall mod-

ule. 

• selectLabelsToShowOnScreen: Select the required option to show the parameter on the home 

screen shown below: 
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Figure 252: Sub-Menu of selectLabelsToShowOnScreen 

  

Figure 253: Display of Wall Module TimeField 

2. Click Save to save the changes made. 

Or click Refresh and then No, if you do not want to save the changes. 
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Time of Day Configuration 

1. Double-click TimeOfDay on the wire sheet to configure the properties. 

 

Figure 254: Property Sheet of TimeOfDay 

• sylkDevice: Select the required TR7x device from the drop-down menu 

 

Figure 255: sylkDevice Drop-Down Menu 

• Status: Read-only point. Shows the status of the parameter. (alarm, fault, overridden, disabled, 

down, stale, null, unackedAlarm). For further details see Sylk Component Status Behaviors.  

• faultCause: Read-only point. Indicates the reason why the parameter is in fault. This property is 

empty unless a fault exists. 

• pollInterval: Poll interval is the time between the end of a timeout period or completion of a network 

request, and the next request for data on the network 

• category: The category defined by the user while configuring Sylk parameters. By default, it shows 

Category as category 

• paramPermissions: User can select the viewing option for the parameter. Select the parameter 

as viewable by Contractor Only or Tenant Read Only from the drop-down menu. If Contractor 
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Only is selected, only the contractor can view the parameters in the wall module. If Tenant Read 

Only is selected, tenant can view the parameters, but cannot make any changes in the parameters. 

 

Figure 256: paramPermissions Drop-Down Menu 

• enableFD: Fail Detect is the time until the CIPer Model 30 is notified of a failure on this point.  

o True: If the parameter has not received an update from the IPC network source in the fail 

detect time, then an alarm is generated and the presentValue is set to Invalid. Note that fail 

detect time depends on the update rate configured. 

o False: False means the object retains the last value that was written to it until a IPC network 

source changes it or the Honeywell CIPer Model 30 has a power outage or reset 

• in: To provide the system time to the Wall module. 

• selectLabelsToShowOnScreen: Select the required option to show the parameter on the home 

screen shown below: 

 

Figure 257: Sub-Menu of selectLabelsToShowOnScreen 

2. Click Save to save the changes made. 

Or click Refresh and then No, if you do not want to save the changes. 
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Value From Wall Module Configuration 

These are outputs from the wall module such as sensor values. 

1. Double-click ValueFromWallModule on the wire sheet to configure the properties. 

 

Figure 258: Property Sheet of ValueFromWallModule 

• sylkDevice: Select the required TR7x device from the drop-down menu. 

 

Figure 259: sylkDevice Drop-Down Menu 

• Status: Read-only point. Shows the status of the parameter. (alarm, fault, overridden, disabled, 

down, stale, null, unackedAlarm). For further details see Sylk Component Status Behaviors.  

• faultCause: Read-only point. Indicates the reason why the parameter is in fault. This property is 

empty unless a fault exists. When there are more than one errors, the fault cause shows only the 

error which is at the top of the list of errors. If the error is corrected, the next error is shown. 
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• pollInterval: Poll interval is the time between the end of a timeout period or completion of a network 

request, and the next request for data on the network 

• category: The category defined by the user while configuring Sylk parameters. By default, it shows 

Category as category 

• paramPermissions: User can select the viewing option for the parameter. Select the parameter 

as visible by Contractor Only, Tenant Read Only, or Tenant Read Write from the drop-down 

menu. If Contractor Only is selected, only the contractor can view the parameters in the wall mod-

ule. If Tenant Read Only is selected, tenant can view the parameters, but cannot make any changes 

in the parameters. If Tenant Read Write is selected, tenant can view as well as modify the param-

eters.  

 

Figure 260: paramPermissions Drop-Down Menu 

• enableFD: Fail Detect is the time until the CIPer Model 30 is notified of a failure on this point.  

o True: If the parameter has not received an update from the IPC network source in the fail 

detect time, then an alarm is generated and the presentValue is set to Invalid. Note that fail 

detect time depends on the update rate configured. 

o False: False means the object retains the last value that was written to it until a IPC network 

source changes it or the Honeywell CIPer Model 30 has a power outage or reset 

• Out: Provides the respective value to the controller from the wall module 

• allowNullValue: This option allows the user to provide Null value 

• enumerated: This option allows the user to provide Enum Setpoints 

• enumDefinition: If the Enumerated is set to true then user can set the multiple states of the Enum 

setpoint. 

a. To set the Enum states of the Setpoint click on the >> button. 

 

Figure 261: enumRange Parameter 

b. Set the states Ordinal & Display as per requirement. For example, 
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Figure 262: Enum Window 

c. Click Ok to save. 

• defaultEnumValue: This option displays list of default Enum value from the defined enum 
range. 

• numberOfDecimals: Provide the value of numbers of decimal as per requirement. 

• incrementDecrement: Value of the setpoint to be increased or decreased at one step. 

• defaultValue: Default value of the setpoint. 

• limitConfig: To set the high and low limits of the setpoint. 

If you provide the Low Limit From Sylk Param value, the value given in the Low Limit field is ignored. 

If you provide the High Limit From Sylk Param value, the value given in the High Limit field is 

ignored. 

 

Figure 263: Prpoerty Sheet of limitConfig 

o Low Limit From Sylk Param: To select the Low limit value from the other Sylk parameter of 

the respective system device 

o High Limit From Sylk Param: To select the High limit value from the other Sylk parameter 

of the respective system device 

o Low Limit: Set the constant value for High limit 

o High Limit: Set the constant value for Low limit 



HONEYWELL CIPer MODEL 30 SYSTEM ENGINEERING USER GUIDE 

SYLK DEVICE PROGRAMMING Sylk Parameters 

31-00237EFS - 02 | 223  

• selectLabelsToShowOnScreen: Select the required option (Setpoint top or Setpoint Bottom) to 

show the parameter on the home screen shown below: 

 

Figure 264: Sub-Menu of selectLabelsToShowOnScreen 

2. Click Save to save the changes made. 

Or click Refresh and then No, if you do not want to save the changes. 
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EVENT-BASED PROGRAMMING 

In this wire sheet, the value of the output changes only if there is a change in the input values. The function 

block gets executed based on the order of the changes in the input values, that is, there is no specific order 

for executing the function blocks. This helps reduce the execution time and controller resource usage, which 

helps in fast response. 

Event-Based Execution 

The event-based execution is more efficient when there is a conditional logic (if, then, or else) that does not 

involve feedback control loops, and where a quick response is required. However, based on how the event-

based execution is deployed, system loading, and engine’s priority, this execution provides faster control 

response to the events. The occasions, when there are too many events to execute or high processing 

demand from other system components in a heavily loaded system, you may notice slower response than 

average. This is an efficient method for a not-overloaded and low-noisy system, where supervisory services, 

data analysis, and event-based logic is the major concern. 

However, for the program with feedback control loops, without sequential execution and periodic rate, the 

effective gain that is used to tune the loop is inconsistent and can result in random instability. Also, if the 

inputs to the loop are noisy, the loop responds to the noise events and not to the average signal value. 

 

Note:  

CIPer Model 30 programming model function blocks which are under ipcProgrammingTool palette will 

not work in event-based control program. 

 

 

Figure 265: Add Function Block on Event Control Program Wire Sheet without Execution Order 
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SEQUENTIAL PROGRAMMING 

In this wire sheet, the value of the output changes continuously based on the execution of the function block 

in an ascending order. This prevents the race conditions in logic.  

Sequential Execution 

The sequential execution of the function blocks consumes more consistent amount of processing power 

than the event-based execution, and eventually becomes less efficient, because all the logic of the function 

blocks runs every cycle even if there are no changes occurred. So, sequential programming should be used 

for the applications, which need execution to be controlled in an ascending order. For example, two function 

blocks A and B have execution order 1 and 2 respectively. So, the function block A is executed first, and 

then B. 

 

Figure 266: Add Function Block on Sequenced Control Program Wire Sheet with Execution Order 

 

Note:  

• Whenever required, you can change the execution order of the function blocks. 

• When you add various function blocks onto the wire sheet for programming, the application 

starts executing the function blocks at the same time. If you want the application to start the 

execution only after you complete adding and linking the function blocks, you can do so by 

selecting the Request Sequenced Control Engine Stop or Start Sequenced Control Engine 

options available on right-clicking the Sequenced Control Program folder in the Nav tree and 

selecting Actions. 
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Figure 267: Request Sequenced Control Engine Stop and Start Sequenced Control Engine Op-

tions 
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FUNCTION BLOCK LIBRARY 

Function blocks are the library of the objects used to implement any custom application logic for wide 

variety of HVAC applications. A function block has inputs and outputs. A Function block receives inputs 

from physical inputs, network inputs, or from output of another function block. The function block pro-

cesses the received input data and produces an output. Processing depends upon the function block 

type. 

All function blocks are available in the ipcProgrammingTool palette in the WEBStation N4 application. 

The function block for CIPer Model 30 also provides offline expansion I/O configuration support, which 

helps you to connect more inputs and outputs. 

Common Behavior Overview 

Following are the common behaviors, which are applicable for all function blocks. 

Execution Time 

The execution time displays the default time (write synchronization) that is continuous 5-minute Inter-

val. If required you can adjust this, or set to Daily or Manual. 

Status 

It shows the component status at the last check. 

Facets 

It gives the facets in use by the parent proxy point. 

Out Save 

The Out Save feature saves the value of the component which was last saved. Suppose, you have ena-

bled the Out Save feature. The output value is 50 and it is saved, and later the output value changes to 

60, which is not yet saved. In this case, if the controller stops functioning, the Out Save displays the 

output value as 50, because 50 was the value which was saved last. If the Out Save feature is disabled, 

the output is some garbage value.  
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Function Blocks Details 

Function blocks are classified into following categories: 

• Analog Function Blocks 

• Control Function Blocks 

• Logic Function Blocks 

• Math Function Blocks 

• DataFunction Blocks 

• ZoneControl Blocks 

• BuiltIn 

• Utils Functional Blocks 

Any of these objects except SylkDevices can be dragged onto the wire sheet of SequencedControlPro-

gram. SylkDevices need to be dragged and dropped onto the LocalDevice folder. Make the connections 

between physical points, software points, and function blocks to create a Control Program or an Appli-

cation.  

Following figure shows the function blocks and objects of the CIPer Model 30 Control Application. 

  

Figure 268: ipcProgrammingTool Palette 

As shown in the above figure, the ipcProgrammingTool palette contains the following items: 

• IPCNetwork: IPCNetwork to communicate with CIPer device 
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• ExpansionIODeviceExt: Adds Expansion IO Devices  

• PortConfiguration: Configures the Network Port.  

• Containers: Contains folder to add program logic and I/O modules 

• IOs: Configures the floating motor output 

• Analog: Analog function block 

• Control: Control function block 

• Logic: Logic function block 

• Math: Math function block 

• DataFunction: DataFunction block 

• ZoneControl: Zone Arbitration function block 

• BuiltIn: BuiltIn function block 

• SylkDevices: Contains all types of Sylk Modules 

• SylkParams: Contains all possible default parameters for Sylk Devices 

• SylkSchedule: Contains schedule for Sylk Devices 

• Utils: Utility function block 

You need to add logic for CIPer Model 30 controller programming model in SequencedControlProgram 

and EventControlProgram folders. SequencedControlProgram acts same as JACE logic, whereas the 

EventControlProgram is event-based, that is you need to provide the Iteration Interval for each block 

for execution. 

You need to use CIPer Model 30 programming model for SequencedControlProgram, and Kit Control 

for EventControlProgram. To add Boolean Writable, Numeric Writable, and Enum Writable, you need to 

use Kit Control. 

Various capabilities provided in a function block are: 

• Add Function Block 

• Configure Function Block 

• Override Output of Function Block 

• Clear Overridden Output of Function Block 

• Delete Function Block 

• Remove non-required Pin Slots 
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Adding a Function Block 

You can add new function block with Add Function Block feature. 

To add a function block: 

1. Navigate to the ipcProgrammingTool palette. If the ipcProgrammingTool palette is not visible 

on the left pane, on the Menu bar, select Window > Side Bars > Palette. The ipcProgram-

mingTool palette is displayed. 

2. Navigate to IPCNetwork > Local Device > Points in the Nav tree and double-click the Se-

quencedControlProgram or EventControlProgram. The wire sheet is displayed at the right-

side area of the screen. 

3. Drag and drop the required function block from the ipcProgrammingTool palette onto the wire 

sheet. 

4. Enter the name of the function block and click Ok. The function block is added and it appears 

on the wire sheet. 

Configuring a Function Block 

You can modify the properties of a function block with the Configure Function Block feature. 

To configure a function block:  

1. Add the required function block onto the wire sheet of an Application Logic, Program, or Macro. 

See Add Function Block section for more details.  

2. Double-click the required function block on the wire sheet and the AX Property Sheet of the 

function block is displayed. 

3. Enter the required information in the available input fields. The input fields differ for each func-

tion block. 

4. Click Save to save the changes. The Save button is enabled when there is a change in at least 

one of the input fields. Or click Refresh on the property sheet, and then Yes on the dialog box 

to save the changes. 

5. Click Refresh after changing the input field values to revert to the last saved settings and click 

No on the dialog box. Or click Cancel on the dialog box to return to the property sheet view. See 

the following example. 

 
Note:   

You can also configure a function block by double-clicking the required function block in the 

palette pane. The AX Property Sheet of the selected function block is displayed at the right-

side area of the screen. 

Example: 

1. Navigate to the Maximum function block in the Analog function block folder. 
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2. Navigate to IPCNetwork > Local Device > Points in the Nav tree and double-click Sequenced-

ControlProgram or EventControlProgram. The wire sheet is displayed on the right-side area 

of the screen. 

3. Drag and drop the Maximum function block onto the wire sheet of SequencedControlProgram 

or EventControlProgram. 

4. Double-click the function block. The property sheet is displayed along with the parameter val-

ues as shown in. 

 

Figure 269: Property Sheet of Maximum Function 

You can modify the properties which are editable.  

Overriding Output of a Function Block 

You can override the output value of the function blocks and provide the duration for which you want 

to override the output.  

To override output of a function block: 

1. Right-click the required function block present on the SequencedControlProgram wire sheet. 

 

Figure 270: Override Option in Actions Menu of Function Block 

2. Select Actions and then click Override. The Override window is displayed. 
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Figure 271: Override Window 

3. Enter the duration for which you want to override the function block in the hours-minutes-sec-

onds format. Use the  (up and down arrows) to increase or decrease the duration respec-

tively. 

4. Enter the value to override the output in the OUTPUT input field. 

5. Click Ok to save the override properties. 

Or 

Click Cancel, if do not want to save the changes. 

 
Note:   

• Once the duration of the override is passed, the Output automatically changes to Auto. 

• To view the list of function blocks that are overridden, right-click LocalDevice, click Views, and 

then Override Function Blocks Summary. 

 

Figure 272: Override Function Blocks Summary Option in View Menu of LocalDevice 
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Clearing Overridden Output of a Function Block 

To clear overridden output of a function block: 

1. Right-click the required function block present on the SequencedControlProgram wire sheet. 

 

Figure 273: Override Option in Actions Menu of Function Block 

2. Select Actions and then click Auto. The overridden value of the output is no more applicable, 

and the function block is not executed to calculate the output. 

 
Note:   

You can also clear the overridden outputs of multiple function blocks at a time by right-clicking Lo-

calDevice, clicking Actions, and then Clear Function Blocks Override. 

 

Figure 274: Clear Function Blocks Override in Actions Menu of LocalDevice 

Deleting a Function Block 

You can delete a function block from the wire sheet with Delete option. 

To delete a function block: 

3. On the wire sheet, select the required function block. 

4. Click the Delete button on the keyboard or right-click the function block and select Delete. The 

function block is deleted from the wire sheet along with bindings to it, if any. 
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Removing a Non-Required Pin Slot 

Every function block has inputs and outputs. Many times, all these inputs and outputs are not required 

in the logic. In such situations, you can remove unwanted pin slots of the function block. 

To remove unwanted pin slots from the function block: 

1. Right-click on the function block and select Pin Slots. The Pin slots window appears. 

2. Click the pins which are not required and click OK. The respective function block appears on 

the wire sheet without the removed pin slots. 

Example: As shown in the following figure, AND function block with only two inputs connected, in1 and 

in2. From in3 to FalseDelay inputs are not utilized. 

 

Figure 275: AND Function Block with All Inputs 

After removing the non-required pin slots, the logic appears as shown in the following figure. 

 

Figure 276: AND Function Block with Required Inputs 



HONEYWELL CIPer MODEL 30 SYSTEM ENGINEERING USER GUIDE 

FUNCTION BLOCK LIBRARY Common Behavior Overview 

31-00237EFS - 02 | 235  
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Analog Function Blocks 

The CIPer Model 30 programming model provides the following analog function blocks that you can 

configure and use to build the application logic: 

• AnalogLatch 

• Average 

• Compare 

• DecisionBox 

• Edge 

• Encode 

• HystereticRelay 

• Maximum 

• Minimum 

• Priority Select 

• Select 

• Switch 

AnalogLatch 

This function block latches the Y output to the value of the X input, when the latch input transitions 

from FALSE to TRUE. The output remains the same and is retained until the next transition happens 

from FALSE to TRUE. At each FALSE to TRUE transition, the output Y is latched to the current X input. 

The logic inputs for analog latch are as shown in the following table. 

 

Figure 277: Function Block of AnalogLatch 
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Logic Inputs 

Table 23: Logic Inputs of Analog Latch 

Input 

Name 

Input 

Value 

Logic 

Value 
Description 

latch Uncon-

nected 

0 Output remains zero, because there is no input value to cause a 

latch. 

VAL != 0.0 1 Latch the input X to the output on FALSE to TRUE transitions (no 

negation) 

invalid 0 Output remains as it was. 

Analog Inputs 

The following table shows the details about analog inputs of an analog latch. 

Table 24: Analog Inputs of Analog Latch 

Input Name 
Range 

Input Value Description 
Low High 

x >= – infinity < + infinity unconnected X = invalid 

invalid X = invalid 

Output 

Table 25: Output of Analog Latch 

Output Name Range Description 

Y Any floating-point value The value of X, when the latch input changes 

from FALSE to TRUE. 

 

 
Note:   

If both the X and latch inputs are unconnected, the output is invalid. 

If the input is invalid, the output transits to invalid, when the latch input changes from FALSE to TRUE. 

You can negate the latch input to cause a TRUE to FALSE transition to latch X to Y. 

In each iteration, the analog latch keeps a track of the last state of the latch input, so that it knows when 

a FALSE to TRUE transition occurs. 

On power up/reset, the last latch value is set to FALSE, regardless of the negation configuration. 
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Example: An illustration to explain the behavior of the Analog Latch is shown in the following figures. 

 

Figure 278: Behavior of Analog Latch 

 

Case 
In-

put 
Latch Output 

Descrip-

tion 
Image 

1 45 True 45 

Output 

latches to 

input 

when 

Latch 

Transition 

from 

False to 

True 

 

2 0 False 45 

Output 

held in 

the same 

state until 

the next 

False to 

True 

transition 
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3 0 True 0 

Output 

latches to 

input 

when 

Latch 

Transition 

from 

False to 

True 

 

4 85 True 0 

Output 

held in 

the same 

state until 

the next 

False to 

True 

transition 
 

5 85 False 0 

Output 

held in 

the same 

state until 

the next 

False to 

True 

transition 
 

6 85 True 85 

Output 

latches to 

input 

when 

Latch 

Transition 

from 

False to 

True 
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Average 

This function block calculates the average of 8 inputs. The output is set to the average value of inputs. 

 

Logic Diagram 

 

Function Block 

Figure 279: Average Function 

 
Note:   

The output returns an invalid value, if no inputs are connected or if all inputs are invalid. 

Ignore invalid inputs: If this option is selected, function block considers only valid inputs while deter-

mining the average of the inputs. If this option is not selected, and any input becomes invalid then 

output also becomes invalid. 

Inputs 

Table 26: Inputs of Average Function 

Input 

Name 

Range 

Input Value 

Ignore 

Invalid 

Input 

Description 
Low High 

in1-8 >= – infinity  <+ infinity  
uncon-

nected  

 Not used in the calculation. If all in-

puts are unconnected, output is in-

valid. 

in1-8  >= – infinity  <+ infinity  invalid  
false If any input is invalid, output is in-

valid. 

in1-8  >= – infinity  <+ infinity  invalid 

true Output considers only valid inputs 

while determining the average of 

the inputs. 

in1-8  >= – infinity  <+ infinity  valid 
 Calculates the average of 8 inputs 

or those set as constant. 
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Outputs 

Table 27: Outputs of Average Function 

Output Name Range Description 

OUTPUT Any floating-point number Average of all the inputs 

Configuration 

Table 28: Configuration of Average Function 

Name Range Description 

Invalid Flag 0, 1 See above table. 
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Compare 

This function compares two inputs with each other. 

 

Logic Diagram 

 

Function Block 

Figure 280: Compare Function 

 
Note:   

It is possible to create invalid numbers by combining large values of input 2, and on and off hysteresis. 

The behavior is dependent on the operation selected, value of input 1, and the compiler. (That is, the 

simulator may have a behavior different from the product). 

You can make the following comparison calculations using the Compare function block: 

• Input1 less than input2 

• Input1 greater than input2 

• Input1 equal to input2 

Additionally, ON and OFF hysteresis analog inputs are provided which you can use to make comparison 

calculations. 

 
Note:   

The output returns an invalid value if no inputs are connected or if all inputs are invalid. 

Analog Inputs 

Table 29: Inputs of Compare Function 

Input Name 
Range 

Input Value Description 
Low High 

input1-2 >= – infinity < +infinity unconnected out = 0 

 

 

Output_Enum 
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invalid out = 0 

onHyst 0 < +infinity 
unconnected val = 0 

invalid val = 0 

offHyst 0 < +infinity 
unconnected val = 0 

invalid val = 0 

Setpoints 

Table 30: Setpoints of Compare Function 

Operation Description 

Equals • The output is set to TRUE if (Input 2 – On Hyst) <= Input 1 <=  

(Input 2 + Off Hyst). 

Less than • The output is set to TRUE if Input 1 < (Input 2 – On Hyst). 

• The output does not change if (Input 2 – On Hyst) <= Input1 < (Input 2 + Off 

Hyst). 

• The output is set to FALSE if Input1 >= (Input 2 + Off Hyst). 

Greater than • The output is set to TRUE if Input 1 > (Input 2 + On Hyst). 

• The output does not change if (Input 2 – Off Hyst) < Input1 <= (Input 2 + On 

Hyst). 

• The output is set to FALSE if Input1 <= (Input 2 - Off Hyst). 

Outputs 

Table 31: Outputs of Compare Function 

Output Name Range Description 

OUTPUT False (0) or True (1) Comparison of inputs 

OUTPUT_ENUM Null or False (0) or 

True (1) 

Comparison of inputs 

Configuration 

Table 32: Configuration of Compare Function 
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Name Range Description 

operation 0, 2 equals (0), less than (1), greater than (2) 
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DecisionBox 

The newly added DecisionBox in the CIPer Model 30 programming model compares the analog value 

(value1) with one or more reference values (value2 to value31). Here the comparison operation is based 

on the selected operation like Equals, Greater Than, Greater Than Or Equal To, Less Than, Less Than 

Or Equal To, Any Equal, and In Any Range. 

 

Logic Diagram 

 

Function Block 

Figure 281: DecisionBox Function 

Logic Inputs 

Table 33: Logic Inputs of DecisionBox Function 

Input Name 
Input Value Logic 

Value 

Description 

Y/N Input VAL != 0.0 1 Enable input, possibly chained from another De-

cisionBox. 

0 0  

Unconnected 0  

Invalid 0  

Analog Inputs 

Table 34: Analog Inputs of DecisionBox Function 
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Input Name 
Range Input Value Description 

Low High 

HysteresisPar 0 65535 valid Hysteresis to be applied for operations 

2,3,4,5. Ignored for other operations. 

uncon-

nected 

HysteresisPar = 0 

invalid HysteresisPar = 0 

< 0 HysteresisPar = 0 

> 65535 HysteresisPar = 65535 

Value #1 >= –∞ <+∞ valid Value to be compared to reference value(s) 

uncon-

nected 

Value #1= 0 

invalid Value #1= 0 

Value #2 >= –∞ <+∞ valid Reference value 

uncon-

nected 

Value #2= 0 

invalid Value #2= 0 

Value #3 >= –∞ <+∞ valid Reference value 

uncon-

nected 

Value #3= 0 

invalid Value #3= 0 

Value #4 >= –∞ <+∞ valid Reference value 

uncon-

nected 

Value #4= 0 

invalid Value #4= 0 

Value #5 >= –∞ <+∞ valid Reference value 

uncon-

nected 

Value #5= 0 
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Input Name 
Range Input Value Description 

Low High 

invalid Value #5= 0 

Additional Value inputs obtained via extension blocks are treated same as Value #5. 
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Outputs 

Table 35: Outputs of DecisionBox Function 

Output 

Name 

Range Description 

Y-Output False (0) or True (1) Defaults to 0 on startup 

N-Output False (0) or True (1) Defaults to 0 on startup 

Configuration 

Table 36: Configuration of Decision Box Function 

Input 

Name 

Range Input 

Value 

Description 

Low High 

Operation 1 7 < 1 Operation = invalid. Block is disabled. 

1 Operation = “=” 

2 Operation = ”>” 

3 Operation = ”>=” 

4 Operation = ”<” 

5 Operation = ”<=” 

6 Operation = Value #1 equal to any reference value  

7 Operation = Value #1 in any range defined by pairs of refer-

ence values 

> 7 Operation = invalid. Block is disabled. 

NumValues 

 

2 

 

30 

 

valid Total number of value inputs, including Value #1, Value #2, 

and so on and any input provided via extension blocks. Used 

for operations 6 and 7. 

< 2 NumValues = invalid. Block is disabled. 
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Operation 

Nu

mva

lue 

YorNIn-

put 

Value

1 

Value

2 

Value

3 

Value

4 

Value

5 

Y_Out-

put 

N_Out

put 

Remarks 

Equal 

2 or 

mor

e 

(Val

ue1 

& 

Valu

e2 

will 

be 

use

d & 

Oth-

ers 

valu

e will 

be 

ig-

nore

d) 

 

False 80 80 85 90 95 False False 

YorNInput 

need to be true 

to enable De-

cision box. 

Others value 

will be ignored  

Equal True 80 80 85 90 95 True False 

Y_Output is 

true as Value1 

is equal to 

Value2 

Equal True 85 80 85 90 95 True true 

N_Output is 

true as Value1 

is not equal to 

Value2 

Greater-

Than 
True 85 80 85 90 95 True False 

Y_Output is 

true as Value1 

is greater than 

Value2 

AnyEqual 

3 or 

Mor

e 

True 85 80 85 90 95 True False 

Y_Output is 

true as Value1 

is equal to 

Value3 i.e any 

of the values 

InAnyRang

e 
3 True 84 80 85 90 95 True False 

Y_Output is 

true as Value1 

is in range of 

Value2 & 

Value3 
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Edge 

The Edge block monitors the X input for the significant change in value. Analog outputs of the block 

post the current (THIS) and PREVIOUS values of X. Logical outputs indicate when a significant change 

has been detected, in either the rising or falling direction. A change is considered significant only if it 

exceeds the specified offset from the previous value. 

 

Logic Diagram 

 

Function Block 

Figure 282: Edge Function 

 
Note:   

• Because each iteration of the block compares only the current and previous values of X, it is 

possible for slow changes in X to occur over time without causing the Rise/Fall flags to fire. 

• A transition of X either to or from INVALID is not considered as a Rise or Fall event. 

For example, if the offset value is 5, it is possible for X to increase by 2 in each iteration of the block 

without ever causing a Rise event to fire. 

Analog Inputs 

Table 37: Analog Inputs of Edge Function 

Input 

Name 

Range Input Value Description 

Low High 

X >= –∞ <+∞ valid Value being monitored for change 

unconnected X = invalid 

invalid X = invalid 

Offset 0 <+∞ valid Amount of change in X required to be considered signif-

icant 

unconnected Offset = 0 
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Input 

Name 

Range Input Value Description 

Low High 

invalid Offset = 0 

< 0 Offset = 0 

Outputs 

Table 38: Outputs of Edge Function 

Input Name Range Input Value 

THIS Any floating-point value Value from X in this cycle 

PREVIOUS Any floating-point value Value from X in last cycle 

RISE False (0) or True (1) A significant increase in X is detected 

FALL False (0) or True (1) A significant decrease in X is detected. 

 

Input 

Value 

This Previ-

ous 

Rise Fall Result 

78 78 78 False False 

As the Input value is same as the Previous and This value, the Rise 

and Fall both are False 

 

80 80 78 True False 

Rise is True for few moment as input value is greater than the 

previous value 
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75 75 80 False True 

Fall is True for few moment as input value is Lower than the 

previous value 
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Encode 

This function translates enumerations of a digital value into different enumeration numbers, allowing 

standard and custom enumerations to be combined and used together. 

If the value of inEnum input does not match with any of the in1 to in9 values, OUTPUT value is equal 

to the value of inEnum input and FIRE output is equal to FALSE. If disable input is TRUE, the OUTPUT 

value is equal to inEnum input. 

 

Figure 283: Ecode Property Sheet 

Unconfigured is taken as high priority compared to Negate. If nothing is configured and Negate is ap-

plied nothing will get effected. Unconfigured will be taken as high priority. 
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Logic Diagram 

 

Function Block 

Figure 284: Encode Function 

 
Note:   

• To check IO pins configuration, go to terminal assignment view, click  refresh button. It reflects 

the changes on terminal. 

• Terminal assignment view shows only physical points. 
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Analog Inputs 

Table 39: Analog Inputs of Encode Function 

Input 

Name 

Range 
Input Value Description 

Low High 

inEnum  0  255 unconnected Val = 0 

invalid Val = 0 

Val matches an input 

value 

Output = matching input’s output 

value 

Val matches two or more 

input values 

Output = matching input’s first out-

put value 

disable 0 255 unconnected Val = 0 

invalid Val = 0 

VAL !=0 All mappings disable, pass input to 

output  

Val=0 Enable mappings 

in1, 2, 3 0 All mappings 

disable, pass 

input to out-

put Val=0 

Enable map-

pings 

0xAABBCC See the note above this table. Input 

1 value 0xAA maps to output 1 

value. 

Input 2 value 0xBB maps to output 

2. 

Input 3 value 0xCC maps to output 

3  

in4, 5, 6 0 16777215.0  0xDDEEFF See the note above this table. Input 

4 value 0xDD maps to output 4 

value. 

Input 5 value 0xEE maps to output 

5. 

Input 6 value 0xFF maps to output 

6. 

in7, 8, 9 0 16777215.0 0xGGHHII See the note above this table. Input 

7 value 0xGG maps to output 7 

value. 
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Input 

Name 

Range 
Input Value Description 

Low High 

Input 8 value 0xHH maps to output 

8. 

Input 9 value 0xII maps to output 9. 

out1, 2, 

3 

0 16777215.0  0xaabbcc See the note above this table. Input 

1 value 0xaa maps to output 1 

value. 

Input 2 value 0xbb maps to output 

2. 

Input 3 value 0xcc maps to output 

3. 

out4, 5, 

6 

0 16777215.0  0xddeeff See the note above this table. Input 

4 value 0xdd maps to output 4 

value. 

Input 5 value 0xee maps to output 

5. 

Input 6 value 0xff maps to output 6. 

out7 0  255  0xgg Input 7 value 0xgg maps to output 

7 value. 

out8  0 255  0xhh Input 8 value 0xhh maps to output 

8 value. 

out9  0  255  0xii Input 9 value 0xii maps to output 9 

value. 

 

 
Note:   

• in1, 2, 3, in4, 5, 6, in7, 8, 9, out1, 2, 3, and out4, 5, 6 are created by taking each individual input 

value (0-255), converting into a hex byte (0x00 – 0xFF), and putting first value in Most Signif-

icant Byte, second value in middle and third value in Least Significant Byte.  

• The result gives an integer value that must be stored as a float. So, if in1 is 1, in2 is 2 and in3 is 

3 then the integer would be 0x010203=66051, and the float value stored as a parameter would 

be 66051.0. 
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• The tool prompts you for individual in1 out9 values and do the conversion both to and from 

the packed structure. 

Analog Outputs 

Table 40: Analog Outputs of Encode Function 

Input 

Name 

Range 
Input Value Description 

Low High 

Out  0 255 See description If an input matches a block mapping and Disable is 

FALSE, output = block mapping. 

If input does not match a block mapping or if Disable is 

TRUE, the output = input. 

fire 0 1 See description If Disable is FALSE and input matches a block mapping, 

fire output is TRUE. 

If Disable is TRUE, fire is TRUE. 

For example, to map a standard HVAC enumeration to a custom enumeration, the standard HVAC enu-

meration and desired mapping is as shown in the following table. 

Table 41: Standard HVAC Enumeration and Desired Mapping 

In Pa-

rameter 

Input Enumeration Con-

figurations 

Input 

Range 

Out Pa-

rameter # 
Output Enumerations 

Out-

put 

Range 

in1 HVAC_AUTO 0 out1 COOL_MODE 0 

in2 HVAC_HEAT 1 out2 HEAT_MODE 2 

in3 HVAC_MORN-

ING_WARM_UP 

2 out3 HEAT_MODE 2 

in4 HVAC_COOL 3 out4 COOL_MODE 0 

in5 HVAC_NIGHT_PURGE 4 out5 NIGHT_MODE 7 

in6 HVAC_PRECOOL 5 out6 COOL_MODE 0 

in7 HVAC_OFF 6 out7 OFF_MODE 255 

in8 HVAC_TEST 7 out8 OFF_MODE 255 

in9 HVAC_EMER-

GENCY_HEAT 

8 out9 EMERG_HEAT 3 
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In Pa-

rameter 

Input Enumeration Con-

figurations 

Input 

Range 

Out Pa-

rameter # 
Output Enumerations 

Out-

put 

Range 

Block 2 

passed 

through 

HVAC_FAN_ONLY 9 Block 2 not 

used 

Pass through (output =9) 

(Does not require map-

ping because the output 

is the same as the input.) 

 

Block 2 

In 1 

HVAC_NUL  255 Block 2 

Out1 

REHEAT_MODE  1 

The first encode function block parameters are:  

• in1, 2, 3: 0, 1, 2 = 0x000102 = 258 

• in4, 5, 6: 3, 4, 5 = 0x030405 = 197637 

• in7, 8, 9: 6, 7, 8 = 0x060708 = 395016 

• out 1, 2, 3: 0, 2, 2 = 0x000202 = 514 

• out4, 5, 6: 0, 7, 0 = 0x000700 = 1792 

• out7: 255 

• out8: 255 

• out9: 3 

The second encode function block parameters are: 

 

• in1, 2, 3: 255, 0, 0 = 0xFF0000 = 16711680 

• in4, 5, 6: 0, 0, 0 = 0x000000 = 0 

• in7, 8, 9: 0, 0, 0 = 0 

• out1, 2, 3: 1, 0, 0 = 0x010000 = 65535 

• out4, 5, 6: 0, 0, 0 = 0 

• out7: 0 

• out8: 0 

• out9: 0 

 

 

Figure 285: Encode Function Block Parameters 
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HystereticRelay 

This function sets the output to TRUE if input value is greater than onVal and to FALSE if input value is 

less than offVal. 

minOn: When output transits from TRUE to FALSE, it remains TRUE for the period specified by the 

minOn input. This input can be a constant, or can take value from other function blocks or physical/net-

work inputs. 

minOff: When output transits from FALSE to TRUE, it remains FALSE for the period specified by the 

minOff input. 

In each iteration, the function block keeps track of the current minimum on or off time. On power, up/re-

set this timer is cleared. 

 

Figure 286: HystereticRelay Property Sheet 

 

Logic Diagram 

 

Function Block 

Figure 287: Hysteretic Relay Function 

Analog Inputs 
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Table 42: Inputs of Hysteretic Relay Function 

Input Name 

Range 
Input Value Description 

Low High 

In 
>= – infinity <+ infinity unconnected val = invalid Output = FALSE  

  invalid val = invalid Output = FALSE 

onVal 
>= – infinity <+ infinity unconnected val = invalid Output = FALSE  

  invalid val = invalid Output = FALSE 

offVal 
>= – infinity <+ infinity unconnected val = FALSE Output = invalid 

  invalid val = invalid Output = FALSE 

minOn 

(sec) 

0 65535 unconnected val = 0 

  invalid val = 0 

minOff 

(sec) 

0 65535 unconnected val = 0 

  invalid val = 0 

Output 

Table 43: Output of Hysteretic Relay Function 

Output Name Range Description 

OUT-

PUT 

False (0) or true 

(1) 

The output is set to TRUE at onVal and FALSE at offVal while honoring 

minOn and minOff times. 

Example: 

Input 

value 

Output 

Value 

Remarks 

70 False 

The Output is False as the Input is lower than the On Value. 
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85 True 

The Output is True as the Input is greater than the On Value. 

 

75 True 

The Output is still true as the Input is greater than the Off Value. 

 

55 False 

The Output is False as the Input is lower than the Off Value 
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Maximum 

This function calculates the maximum of 8 inputs (connected inputs or inputs set as constant). The 

output is set to the largest value of all the inputs. 

 

Logic Diagram 

 

Function Block 

Figure 288: Maximum Function 

 
Note:   

If one or more inputs are selected as constant, any previous connection from the outputs of other 

function blocks to maximum function block is removed automatically and the maximum of the se-

lected constant values is set as the output. 

Ignore invalid inputs: If this option is selected, function block considers only valid inputs while deter-

mining the maximum of the inputs. If this option is not selected, and any input becomes invalid then 

output also becomes invalid. 

Inputs 

Table 44: Inputs of Maximum Function 

Input 

Name 

Range 
Input 

Value 

Ignore 

Invalid 

Input 

Description 
Low High 

in1-8 >= – infinity  
<+ infin-

ity  

uncon-

nected  

 Not used in the calculation. If all inputs 

are unconnected, output is invalid. 

in1-8  >= – infinity  
<+ infin-

ity  
invalid  

false If any input is invalid, output is invalid. 
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Input 

Name 

Range 
Input 

Value 

Ignore 

Invalid 

Input 

Description 
Low High 

in1-8  >= – infinity  
<+ infin-

ity  
invalid 

true Output considers only valid inputs 

while determining the maximum of the 

inputs. 

in1-8  >= – infinity  
<+ infin-

ity  
valid 

 Calculates the maximum of 8 inputs or 

those set as constant. 

Outputs 

Table 45: Outputs of Maximum Function 

Output Name Range Description 

OUTPUT Any floating-point value  Maximum of the inputs 
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Minimum 

This function calculates the minimum of 8 inputs or those set as constant. The output is set to the 

smallest input. Unused/invalid inputs are ignored. 

 

Logic Diagram 

 

Function Block 

Figure 289: Minimum Function 

Ignore invalid inputs: If this option is selected, function block considers only valid inputs while deter-

mining the minimum of the inputs. If this option is not selected, and any input becomes invalid then 

output also becomes invalid. 

The Ignore invalid inputs option is not supported in the PVL6436A, PVL6438N, and PUL6438 models 

and therefore this configuration cannot be downloaded to those models. 

Analog Inputs 

Table 46: Inputs of Minimum Function 

Input 

Name 

Range 
Input 

Value 

Ignore 

Invalid 

Input 

Description 

Low High    

in 1-8 >= – infinity  
<+ infin-

ity  

uncon-

nected  

 Not used in the calculation. 

If all inputs are unconnected, output is inva-

lid. 

in1-8  >= – infinity  
<+ infin-

ity  
invalid  

False If any input is invalid, output is invalid. 
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Input 

Name 

Range 
Input 

Value 

Ignore 

Invalid 

Input 

Description 

Low High    

in1-8  >= – infinity  
<+ infin-

ity  
invalid  

True Output considers only valid inputs while de-

termining the minimum of the inputs. 

in1-8  >= – infinity  
<+ infin-

ity  
valid 

 Calculates the minimum of 8 inputs or 

those set as constant. 

Outputs 

Table 47: Outputs of Minimum Function 

Output Range Description 

OUTPUT Any floating-point value  Minimum of the inputs 

Configuration 

Table 48: Configuration of minimum Function 

Name Range Description 

Invalid Flag 0, 1 See above table. 
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PrioritySelect 

This function allows one to four inputs in any combination to be individually enabled to override the 

default. The output is the input with its highest priority enabled TRUE. 

 

Figure 290: PrioritySelect Property Sheet 

 

Logic Diagram 

 

Function Block 

Figure 291: Priority Select Function 

Unconfigured is taken as high priority compared to Negate. If nothing is configured and Negate is ap-

plied nothing will get effected. Unconfigured will be taken as high priority. 
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Logic Inputs 

Table 49: Logic Inputs of PrioritySelect Function 

Input Name Input Value Logic Value Description 

enable1 -4  VAL != 0.0 0 1   

0 0  

unconnected  0  

invalid 0  

Analog Inputs 

Table 50: Analog Inputs of PrioritySelect Function 

Input Name 
Range 

Input Value Description 
Low High 

in1-4  >= – infinity  <+ infinity  

unconnected  val = invalid 

invalid val = invalid 

Valid Val = value of in1-4 

Setpoint 

Table 51: Setpoint of PrioritySelect Function 

Name Range/Value Description 

In1 As Default  
Yes 

Output is set to Input 1 even if all Enable Inputs 1-4 are inva-

lid. 

No Output is set to Invalid if all Enable Inputs 1-4 are disabled. 

Output 

Table 52: Output of PrioritySelect Function 

Output Name Range Description 

OUTPUT Any floating-

point value 

The output is set to the input that is enabled. 

• If all inputs are unconnected, output is invalid. 

• If all enable inputs are disabled, and all inputs are invalid, 

the output is invalid. 
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Output Name Range Description 

• If In1asDefault is enabled, output is input1, even if all enable 

inputs are disabled. 

• When SetIn1asDefault is disabled/enabled and if at least 

one enable input is enabled, output is the input with its 

highest priority enabled TRUE. The priority order among en-

able inputs is: 

1. enable1  

2. enable2  

3. enable3  

4. enable4 

Based on the In1asDefault option and the Enable options selected, the output is set as Input as shown 

in the table. Output Based on In1AsDefault 

Name Range Description 

In1AsDe-

fault 

False (0) or 

True (1) 

You can specify if input 1 should be used as the default (Yes/No). If 

none of the enable inputs are true and input 1 is configured to be the 

default, the output is set to input 1. If none of the enable inputs are true 

and input 1 is not the default, the output is set to Invalid. 

 

Table 53: Output Based on In1AsDefault 

In1asDefault 
Enable Inputs 1–

4 
Output 

Enabled Disabled Output is set to Input1. 

Enabled Output is set to highest enabled input. 

Disabled Disabled The output is invalid. 

One or more in-

puts is Enabled 

Output is set to one of the Inputs 1-4 based on the priority 

order: 

1. Enable1  

2. Enable2  

3. Enable3  

4. Enable4 

 

 
Note:  
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• Enable 1 has the highest priority and if it is enabled, output is taken as Input1. 

• If Enable 1 is disabled, Enable 2 has the next highest priority, and if Enable 2 is enabled, output 

is taken as Input 2. 

• Enable 3 has the third highest priority and if Enable 1 and Enable 2 are disabled, the output is 

taken as Input 3. 

• Enable 4 has the least priority and output is set to Input 4 only if Enable 1-3 is disabled. 
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Example: 

The Output value is same as Input 2 as Enable2 is enabled. 
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As Input1 has higher priority, thus out is same as Input 1 Value. 
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Select 

The Select function block selects one of the 6 input values to be transferred to the output. The input 

selected depends on the value of X. 

The default input allows multiple select function blocks to be tied together by chaining the outpu00t 

of one block to the default input of the next. 

When the Select function blocks are chained, all chained blocks receive the same input, but different 

offsets. So, the select function blocks examine different ranges of the input values.  

When (X) selects one of the 6 inputs, the output equals the value on the input (X-offset). Otherwise, the 

output equals the value on the default input. 

 

Logic Diagram 

 

Function Block 

Figure 292: Select Function 

Analog Inputs 

Table 54: Analog Inputs of Select Function 

Input 

Name 

Range 
Input Value Description 

Low High 

x 0 255 

 selection index 

uncon-

nected 

val = invalid 

invalid val = invalid 

default >=  –∞ <+∞ 

 
Default value to be output when x selection index is 

invalid or out of range 

uncon-

nected 

val = invalid 
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Input 

Name 

Range 
Input Value Description 

Low High 

invalid val = invalid 

input0 to 5 

>=  –∞ <+∞  inputs selected by the index (x – offset) 

uncon-

nected 

val = invalid 

invalid val = invalid 

Output 

Table 55: Output of Select Function 

Output Name Range Description 

Output Any floating-point value Output = input (x-offset) 

Setpoint 

Table 56: Setpoints of Select Function 

Name Range Description 

Offset 0 - 255 

Output value depends upon the input value x and offset. Out-

put value is the value equal to the input (any one of the in-

put0-5) selected by the input x-offset. 

input0: 1 

input1: 2 

input2: 3 

input3: 4 

input4: 5 

input5: 6 

offset: 2 

If input x is 4, (x - offset = 4 - 2) = 2 

Output is the value of input 2. From the input values, out-

put=3. 

 

 
Note:    
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If any input is invalid, the output is invalid. 

Output = Position determined by the value (X - Offset).  

• If the value of (X – Offset) is greater than 6, the default value is taken as the Output.  

• If the value (X - Offset) is a floating-point number between 0 and 6, the position is determined as:  

o 0.10 – 0.99, 0 is returned and Input 0 is taken as Output 

o 1.10 – 1.99, 1 is returned and input 1 is taken as Output  

o 2.10 – 2.99, 1 is returned and input 2 is taken as Output 

o 3.10 – 3.99, 1 is returned and input 3 is taken as Output 

o 4.10 – 4.99, 1 is returned and input 4 is taken as Output 

o 5.10 – 5.99, 1 is returned and input 5 is taken as Output 

 

Example 1: 

X = 100, Offset = 97, default = 10 

Output = 100 – 97 = 3, and hence input 3 is taken as the output. 

Example 2: 

X = 100.6, Offset = 95.2, default = 10 

Output = 100.6 – 95.2 = 5.4, and hence input 5 is taken as the output. 

Example 3: 

X = 100, Offset = 5.2, default = 10 

Output = 100 – 5.2 = 94.4, and hence default value 10, is taken as the output. 
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Switch 

This function takes an enumerated typed input and subtracts a user-defined offset to determine which 

output to set TRUE, holding all others FALSE.  

The valid range of the input minus the offset is 0 through 7. The output X (0 through 7) is TRUE if input 

– offset = X, else, it is FALSE. 

 

Logic Diagram 

 

Function Block 

Figure 293: Switch Function 

Analog Inputs 

Table 57: Analog Inputs of Switch Function 

Input Name 
Range 

Input Value Description 

Low High 

input  0  255  

unconnected val = invalid, all outputs off. Note 1 

invalid val = invalid, all outputs off. Note 1 

in - offset > 8 All outputs off. See the note in the 

Encode function block section. 

in - offset < 0 All outputs off. See the note in the 

Encode function block section. 
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Output 

Table 58: Outputs of Switch Function 

Output 

Name 
Range Description 

OUTPUT 0 - 

7 

False (0) or True 

(1) 

The output [0-7] is TRUE if input – offset = X, otherwise it is 

FALSE. 

Setpoint 

Table 59: Setpoint of Switch Function 

Output 

Name 
Range Description 

offset  0 - 

255 

Used to determine which Output is set to TRUE based on the expression 

(input - offset) = Output 

Configuration 

Table 60: Configuration of Switch Function 

Output 

Name 
Range Description 

offset  0 - 

255 

Base number from which input matches are measured. 

Output = Output position determined by the value (input – Offset).  

• If the value of (input – Offset) is greater than 7, all outputs are taken as FALSE. 

• If the value (input – Offset) is a floating-point number between 0 and 8, the position is determined 

as:  

o 0.10 – 0.99, 0 is returned, Output 0 is TRUE and all other outputs are FALSE 

o 1.10 – 1.99, 1 is returned, Output 1 is TRUE and all other outputs are FALSE 

o 2.10 – 2.99, 2 is returned, Output 2 is TRUE and all other outputs are FALSE 

o 3.10 – 3.99, 3 is returned, Output 3 is TRUE and all other outputs are FALSE 

o 4.10 – 4.99, 4 is returned, Output 4 is TRUE and all other outputs are FALSE 

o 5.10 – 5.99, 5 is returned, Output 5 is TRUE and all other outputs are FALSE 

o 6.10 – 6.99, 6 is returned, Output 6 is TRUE and all other outputs are FALSE 

o 7.10 – 7.99, 7 is returned, Output 7 is TRUE and all other outputs are FALSE 

Example 1: 
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Input = 100, Offset = 97 

Output = 100 – 97 = 3, and hence Output 3 is made TRUE and all other outputs are made FALSE.  

Example 2: 

X = 100.6, Offset = 95.2 

Output = 100.6 – 95.2 = 5.4, and hence Output 5 made TRUE and all other outputs are made FALSE. 

Example 3: 

X = 100, Offset = 5.2 

Output = 100 – 5.2 = 94.4, and hence all Outputs are made FALSE. 
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Control Function Blocks 

The CIPer Model 30 programming model provides the following control function blocks that you can 

configure and use to build the required application logic: 

• AIA 

• Cycler 

• FlowControl 

• PID 

• RateLimit 

• Stager 

• StageDriver 

AIA 

This function is an Adaptive Integral Action controller (AIA). You can use AIA in place of the PID (Pro-

portional Integral Derivative), because it works better than PID, when delays in the process being con-

trolled cause integral windup resulting in undershoot or overshoot that leads to instability. 

 

Figure 294: AIA Property Sheet 

Unconfigured is taken as high priority compared to Negate. If nothing is configured and Negate is ap-

plied nothing will get effected. Unconfigured will be taken as high priority. 
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Logic Diagram 

 

Function Block 

Figure 295: AIA Function 

Err = Sensor – Set Point. 

If Direct/Reverse is set to reverse, Err term is set to – Err. 

tr (throttling range): It is error value that results in an output change of the maximum value (maxAO-

Change) from one step to the next. maxAOChange is the maximum amount in percentage that output 

changes for a single cycle of the control (1 second). This is typically set to 100 percent / (Actuator speed 

(second/full stroke)).  

Deadband: Error value must be greater than the deadband absolute value to reflect any change in the 

output. 

EffErr = Err – deadband 

If Err > 0, ErrSign = 1 else ErrSign = –1. 

If |Err| < deadband, AbsErr = 0. 

Otherwise (|Err| > deadband), AbsErr = |Err| – deadband 

Output = Output + ErrSign * [(maxAOChange – minAO) * (AbsErr / (ThrottlingRange – Deadband)) * 3 + 

MinAO)]. 

In each iteration, the function block keeps track of the old proportional error. On power up/reset this is 

cleared. 

Whenever there is a certain configuration change in AIA block (like derivative gain) if users expect be-

havior like Spyder controller, then they need to Stop and start the Sequenced Control Engine.   

Steps to stop and start the sequenced control engine 

1. Right click on Sequenced Control Program  

2. Invoke Action request sequenced Control engine stop 

3. Then invoke Start Sequenced Control Engine to start the engine 

 



HONEYWELL CIPer MODEL 30 SYSTEM ENGINEERING USER GUIDE 

FUNCTION BLOCK LIBRARY Control Function Blocks 

31-00237EFS - 02 | 280 

Logic Inputs 

Table 61: Logic Inputs of AIA Function 

Input Name Input Value Logic Value Description 

disable unconnected 0  AIA function runs. 

VAL != 0.0  1  Disable AIA function. Output is set to 

0. 

0 0  AIA function runs. 

invalid  0  AIA function runs. 

Analog Input 

Table 62: Analog Inputs of AIA Function 

Input Name 
Range 

Input Value Description 
Low High 

sensor  
>= – infin-

ity 
< +infinity 

unconnected 
AIA function is disabled. Output is 

set to 0. 

invalid 
AIA function is disabled. Output is 

set to 0. 

setPt 
>= – infin-

ity 
< +infinity 

unconnected 
AIA function is disabled. Output is 

set to 0. 

invalid  
AIA function is disabled. Output is 

set to 0. 

tr  0  < +infinity 

unconnected 
AIA function is disabled. Output is 

set to 0. 

invalid 
AIA function is disabled. Output is 

set to 0. 

VAL <= 0 
AIA function is disabled. Output is 

set to 0. 

maxAO-

Change 

(%/sec) 

0 < 100 

unconnected maxAOChange = 1.1%/sec 

invalid maxAOChange = 1.1%/sec 

0 maxAOChange = 1.1%/sec 
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Input Name 
Range 

Input Value Description 
Low High 

VAL < low maxAOChange = 1.1%/sec 

VAL > high maxAOChange = 1.1%/sec 

deadband 0 < tr 

unconnected Disable Dead Band action. 

invalid Disable Dead Band action. 

VAL < low 

OR 

VAL >+ tr 

DB = 0 

0 disable Dead Band action. 

derivGain  0 <+ 
unconnected val = 0 

invalid val = 0 

minAO-

Change 
0 < 

<= maxAO-

Change 

unconnected minAOChange = 0 

invalid minAOChange = 0 

VAL < 0 minAOChange = 0 

VAL>=maxAO-

Change 

minAOChange = 0 

 

 

Output 

Table 63: Output of AIA Function 

Output 

Name 
Range Description 

OUT-

PUT 

0 to +100% Output = Output + ErrSign * NonLin (AbsErr, ThrottlingRange, maxAO-

Change, minAOChange) 

Setpoint 

Table 64: Setpoint of AIA Function 
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Name Range Description 

revAct 0 = Direct acting 

1 = Reverse act-

ing 

User-specified revAct value 

Configuration 

Table 65: Configuration of AIA Function 

Name Range Description 

revAct 0 to 1 You can specify revAct: 0 = Direct acting, 1 = reverse acting. 
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Cycler 

This function is a generic stage driver or a Thermostat Stage Cycler dependent on the value of the CPH 

(Cycles per Hour) parameter (cph = 0 means stager functionality, and cph = 1 - 60 gives thermostat 

cycler functionality). The input range (In) for the Cycler block is -200 to +200. 

 

Figure 296: Cycler Property Sheet 

Unconfigured is taken as high priority compared to Negate. If nothing is configured and Negate is ap-

plied nothing will get effected. Unconfigured will be taken as high priority. 

 

Logic Diagram 

 

Function Block 

Figure 297: Cycler Function 

Logic Inputs 

Table 66: Logic Inputs of Cycler Function 
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Input Name Input Value Logic Value Description 

disable unconnected 0 Normal operation 

VAL != 0.0 1 Disable block, output = 0 

0 0 Normal operation 

invalid 0 Normal operation 

override Off  unconnected 0 Normal operation 

VAL != 0.0 1 Turns off stages as minOn time allows 

0 0 Normal operation 

invalid 0 Normal operation 
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Analog Inputs 

Table 67: Analog Inputs of Cycler Function 

Input Name 
Range 

Input Value Description 
Low High 

In (%) 0 100 
unconnected stgsAct = 0 

invalid in = 0% 

maxStgs 1 255 
unconnected stgsAct = 0 

invalid maxStgs = 1 

minOn (sec) 0 65535 

unconnected stgsAct = 0 

invalid stgsAct = 0 

minOff (sec) 0 65535 

unconnected stgsAct = 0 

invalid stgsAct = 0 

intstgOn (sec) 0 65535 

unconnected stgsAct = 0 

invalid stgsAct = 0 

intstgOff (sec) 0 65535 
unconnected stgsAct = 0 

invalid stgsAct = 0 

Output 

Table 68: Output of Cycler Function 

Output Name Range Description 

STAGES_ ACTIVE 0 to +100% The number of stages active (on) 

Configuration 

1. Specify CPH from 0 to 60. 

2. Specify Anticipator Authority from 0 to 200%. Typical value is 100%. 

3. Specify hysteresis from 0 to 100.   
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Table 69: Configuration of Cycler Function 

Name Range/Value Description 

cph 0 to 60 You can specify CPH from 0 to 60. 

hyst 0 to 100 You can specify hysteresis from 0 to 100. A value of 0 re-

sults in an effective hysteresis of: hyst = 100/maxStgs 

when CPH = 0 (stager operation) or hyst = anticipatorAu-

thority/maxStgs/2 when CPH != 0 (cycler operation). 

anticipatorAuthority 0 to 200 You can specify Anticipator Authority from 0 to 200%. 

Typical value is 100%. 

intstgOff (sec) 0 to 255 You can specify intstgOff time in seconds under condi-

tions. 

Cycler Functionality 

The Cycler function is the traditional anticipator cycling algorithm used in Honeywell thermostats. In-

put is either P or PI space temperature error in % (0-100). Standard (recommended) settings are cph = 

3 for cooling, cph = 6 for heating, anticAuth = 100%, hyst = 100%/maxStgs/2. Note that for multiple 

stage cyclers the PID block feeding this block should have an appropriately large throttling range to 

achieve smooth behavior. 

 

100 % /MaxStgs

Stages

CmdPercent

Stage 3 locked on

AnticAuth/MaxStgs

Cycler 
Behavior

Stage 2 locked on

Stage 1 locked on

- Hyst
0 %

Hyst

 

Figure 298: Cycler Functionality 
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FlowControl 

This function is a Variable Air Volume (VAV) Damper Flow Controller. Traditionally, this is the second 

half of a pressure independent VAV box cascade control strategy. Typically, the input would come from 

the output of a PID block controlling space temperature. 

 

Logic Diagram 

 

Function Block 

Figure 299: Flow Control Function 

Whenever there is a certain configuration change in Flow Control block (like duct area) if users expect 

behavior like Spyder controller, then they need to Stop and start the Sequenced Control Engine.   

Steps to stop and start the sequenced control engine 

1. Right click on Sequenced Control Program  

2. Invoke Action request sequenced Control engine stop 

3. Then invoke Start Sequenced Control Engine to start the engine 

Analog Inputs 

Table 70: Analog Inputs of Flow Control Function 

Input Name 
Range 

Input Value Description 
Low High 

cmdFlowPercent 

(%) 
0 < + infinity 

uncon-

nected 

cmdFlowPercent = 0 

invalid Same as unconnected 

sensedFlowVol  > = – infinity < + infinity 

uncon-

nected 

damperPos = cmdFlowPercent 

invalid damperPos = cmdFlowPercent 

minFlowSetPt  > = – infinity < + infinity 
uncon-

nected 

Switch to Pressure-dependent 

mode.  
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Input Name 
Range 

Input Value Description 
Low High 

• minFlowSetPt = 20  

• maxFlowSetPt = 100  

• effFlowSetPt = invalid 

invalid  Same as unconnected 

maxFlowSetPt  > = – infinity < + infinity 

uncon-

nected 

Switch to Pressure-dependent 

mode.  

• minFlowSetPt = 20  

• maxFlowSetPt = 100  

• effFlowSetPt = invalid 

invalid Same as unconnected 

manFlowOverride  > = – infinity < + infinity 

uncon-

nected 

Normal operation 

invalid  Same as unconnected 

manFlowValue   0 < + infinity 

uncon-

nected 

value = invalid 

invalid  Same as unconnected 

ductArea  > 0 < + infinity 

invalid 

effFlowSetPt = invalid & 

damperPos   = (100* min-

FlowSetPt/  maxFlowSetPt) 

uncon-

nected 

Same as invalid 

VAL < = 0 Same as invalid 

Output 

Table 71: Outputs of Flow Control Function 

Output Name Range Description 

EFF_FLOW_SETPT  Any floating-point value Effective Flow setpoint 

DAMPER_POS Any floating-point value Damper position 

Configuration 
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Table 72: Configuration of Flow Control Function 

Name Range/Value Description 

units 0 to 2 You can specify the units from 0 to 2. 0 = flow (cfm), area(ft**2); 1 = 

flow (Lps), area (m**2); 2 = flow (cmh), area (m**2). Default is zero (0). 

motor-

Speed 

1 to 255 You can specify the motor speed from 1 to 255 seconds per 90 de-

grees. Default is 90. 

• Specify the units from 0 to 2. 

o 0 = flow (cfm), area(ft2) 

o 1 = flow (Lps), area (m2) 

o 2 = flow (cmh), area (m2) 

• Specify the motor speed from 1 - 255 sec per 90 . Default is 90. 

The Flow Controller function calculates an effective flow control set point (effFlowSetPt) and outputs 

0% - 100% command to drive a VAV box damper. The commanded flow set point (in percent) from a 

temperature control signal is mapped into the effective flow set point such that 0% maps to the min 

flow set point and 100% maps to the max flow set point. The sensedFlowVol input is the volumetric 

flow into the box, if it is invalid (sensor fails) the damper is driven in a pressure dependent mode where: 

Output = 100% * (minSP/maxSP) + (1 − minSP/maxSP) * cmdPercent. 

If either flow MinSP, or MaxSP is invalid, the Output = 20% + .8 * cmdPercent. 

The Units parameter sets the units being used for the flow sensor, set points, and the duct area where 

0 = cfm (flow) and ft2 (area), 1 = L/s (flow) and m2 (area), 2 = m3/hr (flow) and m2 (area). The cmdFlow-

Percent input is the input in percent from the temperature control logic. The DuctArea is the area of an 

air flow duct and you can calculate it by using the height and width of the duct, if the duct is in square 

shape (for circular duct it can be calculated by using diameter of the duct). DuctArea is required for the 

control algorithm. 

The control loop is implemented in air velocity to simplify loop tuning. The motorSpeed parameter is 

the time the actuator being used takes to travel a full 90 stroke in seconds (this is used to automati-

cally adjust the control gains). 

The manFlowOverride input allows the flow set point to be selectively overridden based on the following 

codes: (taken from snvt_hvac_overid) 

• 0 and all others not listed = no override (normal operation) 

• 2 = effFlowSetPt is set to the ManFlowValue input 

• 6 = effFlowSetPt is set to the minFlowSetPt input 

• 7 = effFlowSetPt is set to the maxFlowSetPt input 

Manual flow override is particularly useful when trying to make the box easy to be balanced. 
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Figure 300: Effective Flow Setpoint Calculation 

Example: The flow Setpoint value will be calculated based in the Cmd Percent value, Min Flow Set-

point & Max Flow Setpoint as below: 

 

 

But if the Manual Flow Override value is other than 0 then the Flow Setpoint value will be either Min 

Flow Setpoint or Max Flow Setpoint or Man Flow Value based upon selection. 
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The setting for Man Flow Override need to be similar as below: 
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PID 

The Proportional Integral Derivative (PID) controller compares a measured value from a process with a 

reference setpoint value. The difference (or error signal) is then used to calculate a new value for a ma-

nipulatable input to the process that brings the process measured value back to its require setpoint. 

Unlike simpler control algorithms, the PID controller can adjust the process outputs based on the his-

tory and rate of change of the error signal, which gives more accurate and stable control. The output 

limit is -200 to +200 and you can choose the option 0 to 100 separately. 

 

Figure 301: PID Property Sheet 

Unconfigured is taken as high priority compared to Negate. If nothing is configured and Negate is ap-

plied nothing will get effected. Unconfigured will be taken as high priority. 

 

Logic Diagram 

 

Function Block 

Figure 302: PID Function Block 
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In a PID loop, correction is calculated from the error in three ways:  

• Cancel out the current error directly (Proportional) 

• The amount of time the error has continued uncorrected (Integral) 

• Anticipate the future error from the rate of change of the error over time (Derivative) 

o Err = Sensor – Set Point 

o Kp = 100/Proportional Band 

o Ti = Integral Time (seconds) 

o Td = Derivative Time (second) 

o Bias = Proportional offset (%)  

Output (%) =Bias +Kp * Err + Kp/Ti ∫ (𝐸𝑟𝑟)𝑑𝑡
𝑡

0
 + Kp* Td*dErr/dt 

Whenever there is a certain configuration changes in PID block (like integral time) if users expect be-

havior like Spyder controller, then they need to Stop and start the Sequenced Control Engine.   

Steps to stop and start the sequenced control engine 

1. Right click on Sequenced Control Program  

2. Invoke Action request sequenced Control engine stop 

3. Then invoke Start Sequenced Control Engine to start the engine 

 

Logic Inputs 

Table 73: Logic Inputs of PID 

Input Name Input Value Logic Value Description 

disable 

unconnected 0.  PID function runs. 

VAL != 0.0 1 PID function is disabled. Output set to zero 

0 0 PID function runs. 

invalid 0 PID function runs. 

Analog Inputs 

Table 74: Analog Inputs of PID 

Input Name 
Range 

Input Value Description 
Low High 

sensor >=− infinity <+ infinity unconnected 
PID function disabled. Output is set to 

0. 
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Input Name 
Range 

Input Value Description 
Low High 

invalid  

setPt >=− infinity <+ infinity 
unconnected 

PID function disabled. Output is set to 

0 

invalid Same as unconnected 

tr 0< <+ infinity 

unconnected 
PID function disabled. Output is set to 

0. 

invalid Same as unconnected 

0 
PID function disabled. Output is set to 

0 

VAL < low val = low 

intgTime 

(sec).  
0 <+ infinity 

unconnected 
PID function disabled. Output is set to 

0. 

invalid Disable Integral Action. 

0 Disable Integral Action. 

VAL < low IT = low 

dervTime 

(sec) 
0 <+ infinity 

unconnected Disable Derivative action. 

invalid Disable Derivative action 

0 Disable Derivative action. 

VAL < low DT = low 

deadBand  0 < tr 

unconnected Same as 0 input 

invalid Same as 0 input 

VAL < low or 

VAL >= tr 

DB = 0 

0 Disable deadband action 

dbDelay 

(sec)  
0 65565 

 Deadband delay 

unconnected Same as 0 input 

invalid Same as 0 input 

0 
Deadband action enabled without de-

lay 
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Input Name 
Range 

Input Value Description 
Low High 

VAL < low Dead band delay = low 

Output 

Table 75: Output of PID 

Output Name Range Description 

OUTPUT  
−200 to +200% 

or 0-100 

Output (%) =Bias +Kp * Err + Kp/Ti ∫ (𝐸𝑟𝑟)𝑑𝑡
𝑡

0
 + Kp* Td*dErr/dt 

Setpoints 

Table 76: Setpoints of PID 

Name Range/Value Description 

revAct  • 0 to 2 You can specify revAct: 0 = Direct acting, 1 = reverse acting, 2 = sign of the tr input 

determines direction: (+) = Direct acting, (-) = Reverse acting. 

bias 0 to 100% You can specify the Bias: 0 to 100%. 

Output 

Range 

0 to100 or -200 to +200 You can specify the required Output range 

Configuration 

1. Specify Action 

• 0 = Direct acting  

• 1 = Reverse acting 

2. Specify the bias: 0 to 100%. 

When Disable/Initialize input is TRUE, the Output and the integral are set to 0 and the block stops 

running.  

If Direct/Reverse is set to reverse, Err term is set to –Err. 

When Err < Deadband, Err is set to zero until Deadband Delay time has elapsed and Err is still in the 

dead band. 

To prevent integral wind up, the integral portion of the total error output is limited to 100%.  

From iteration to iteration, the Function Block keeps track of the old proportional error, integral error, 

and deadband timer. On power up/reset these are cleared. 
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Example: To control a Cooling Coil Valve the PID need to be configured as Direct acting and set the 

Parameters as per requirement. 

 

 

To control a Heating Coil Valve the PID need to be configured as Reverse Acting. 
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RateLimit 

This function creates an output that follows the input but prevents the output from changing faster 

that the specified rates depending on direction. 

 

Figure 303: RateLimt Property Sheet 

Unconfigured is taken as high priority compared to Negate. If nothing is configured and Negate is ap-

plied nothing will get effected. Unconfigured will be taken as high priority. 

 

Logic Diagram 

 

Function Block 

Figure 304: Rate Limit Function 

Logic Inputs 

Table 77: Logic Inputs of Rate Limit Function 
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Input Name Input Value Logic Value Description 

disable unconnected 0.  The function executes. 

 VAL != 0.0 1 The function is disabled.  

 0 0 The function executes. 

 invalid 0 The function executes. 

Analog Inputs 

Table 78: Analog Inputs of Rate Limit Function 

Input Name 
Range 

Input Value Description 

Low High 

in  >= – infinity <+ infinity unconnected In= 0.0 

  invalid In = Invalid 

  Valid In = value 

startInterval 

(sec)  

0 65535 unconnected Start interval = 0 

  invalid Start interval = 0 

  0<val<max float Limit Start interval value 0 to 65535.0 

sec. 

  <0 StartInterval = 0 

startVal.  >= – infinity <+ infinity  Output assumes the start value when 

the function is disabled 

  unconnected If disable=1 then Out=in 

  invalid If disable=1 then Out=in 

upRate 

(chg/sec) 

0< <+ infinity unconnected No limit on upRate 

  invalid No limit on upRate 

  0  No limit on upRate 

  <0 upRate = 0 (no limit on upRate) 

0< <+ infinity unconnected Rate no limit on downRate 
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Input Name 
Range 

Input Value Description 
Low High 

downrate 

(chg/sec) 

  invalid No limit on downRate  

  0 No limit on downRate 

  <0 downRate=0 (no limit on upRate) 

Output 

Table 79: Output of Rate Limit Function 

Output Name Range Description 

OUTPUT  Any floating-point value  Rate limit 

Operation 

The value StartInterval (Sec) limits the output after the rate limit function is enabled (disable input set 

to 0) and the StartInterval time is still in process. RateLimit uses the startVal input as the default output 

during disable. 

• If the RateLimit function is disabled (disable input set to 1) the output is set to StartVal. 

• After RateLimit is enabled (disable set to 0), the StartInterval timer counts down from the Start-

Interval number of seconds and during this time the output is Ratelimited. 

• When the timer expires (and RateLimit is enabled), the out value is exactly what the input (in) 

is set to and there is no longer rate limiting. 

• If the StartInterval second is set to 0 (and ratelimit is enabled), the output is Ratelimited. 

• During RateLimit the output moves at the maximum allowed rate towards the new input value 

each second. 

• UpRate controls the rate in a more positive direction, and DownRate controls the rate in a more 

negative direction. UpRate set to zero means the uprate limit is not enforced. DownRate set to 

zero means the downrate limit is not enforced. 

• Out is set to StartVal before rate limiting is enabled (disable set to 0). 

• From iteration to iteration, the Function Block keeps track of the start timer. On power/up/reset, 

this is set to the StartInterval. 

Where cph = 0 means stager functionality, and cph = 1-60 gives thermostat cycler functionality. 

Example: Rate Limit is used to slow down the PID output changes 
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Stager 

This function is a generic stage driver or a Thermostat Stage Cycler dependent on the value of the CPH 

parameter. The input range (In) for the stager block is -200 to +200. 

 

Figure 305: Stager Property Sheet 

Unconfigured is taken as high priority compared to Negate. If nothing is configured and Negate is ap-

plied nothing will get effected. Unconfigured will be taken as high priority. 

 

Logic Diagram 

 

Function Block 

Figure 306: Stager Function Block 

Logic Inputs 
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Table 80: Logic Inputs of Stager Function 

Input Name Input Value Logic Value Description 

disable 

unconnected 0 Normal operation 

VAL != 0.0 1 Disable block, output = 0 

0 0 Normal operation 

invalid 0 Normal operation 

override Off 

unconnected 0 Normal operation 

VAL != 0.0 1 Turns off stages as minOn time allows 

0 0 Normal operation 

invalid 0 Normal operation 
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Analog Inputs 

Table 81: Analog Inputs of Stager Function 

Input Name 

Range 

Input Value Description 
Low High 

in % 0 100 unconnected stgsAct = 0 

invalid in = 0% 

maxStgs 1 255 unconnected stgsAct = 0 

Invalid maxStgs = 0 

minOn  

(sec)  

0 65535 unconnected stgsAct = 0 

invalid stgsAct = 0 

minOff (sec) 0 65535 unconnected stgsAct = 0 

invalid stgsAct = 0 

intstgOn 

(sec) 

0 65535 unconnected stgsAct = 0 

invalid stgsAct = 0 

intstgOff 0 (sec) 65535 unconnected stgsAct = 0 

invalid stgsAct = 0 

Output 

Table 82: Output of Stager Function 

Output Name Range Description 

STAGES_ ACTIVE   0 to +100% 
The number of stages active (on) 

Setpoints 

Table 83: Setpoint of Stager Function 

Name Range/ Value Description 

hyst  0 to 100 User-specified value 

Configuration 

Specify hysteresis from 0 to 100. 
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Stager Functionality 

The Stager Function takes a 0-100 percent (typically PID error) input and determines how many stages 

to turn on. The 0-100 percent input range is divided evenly between how many stages are configured 

in maxStgs. The first stage is turned on at CmdPercent > 0 and off at CmdPercent < – Hyst. As shown in 

following illustration the general criterion for turning on stage N is:  

CmdPercent > (N –1) * 100% / maxStgs.  

For turning off stage N the criterion is: 

CmdPercent < (N –1) * 100% / maxStgs – Hyst 

From iteration to iteration, the Function Block keeps track of the on timer, off timer, anticipator, and 

CPH multiplier. On power up/reset, the off timer and anticipator are cleared, the on timer is set equal 

to the inter-stage on time and the CPH multiplier is recalculated. 

100 %/MaxStgs

Stages

CmdPercent

Stage 3 on

Stager 
Behavior

Stage 2 on

Stage 1 on

0 %

Hyst

 

Figure 307: Stager Functionality 

When override is TRUE, active stages are shed (turned off) based on min on and interstage timers re-

gardless of the CmdPercent input. Output is the number of stages active (0-MaxStages) which can be 

sent to the StageDriver function block. Configuration parameters include: 

• maxStgs is the maximum stages available to turn on.  

• CPH (non-zero) is max cycle rate in Cycles Per Hour when input is halfway between stages available, 

and AnticAuth is at the default value (100%). CPH = 0 means the Stager logic is performed and has 

no other effect. 

• Hyst is the switching differential around the switch points in % error. (Range: 0 < Hyst < 100 / max-

Stgs) 

• AnticAuth (cycler only (CPH != 0)) is the anticipator authority, which allows adjustment of the cycling 

behavior. It represents the max amount of “fake” error in % that is input into the switching logic when 

maxStgs are turned on. (Range 0 < AnticAuth < 200.) 

• minOnTime is the minimum time a stage must be on once it is turned on. 

• minOffTime is the minimum time a stage must be off once it is turned off. 

• intstgOn is the minimum time before the next stage can be turned on after the previous one is turned 

on. 
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• intstgOff is the minimum time before the next stage can be turned off after the previous one is 

turned off.  
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StageDriver 

The StageDriver function takes the number of active stages as an input and determines which stages 

to energize or de-energize based on the lead/lag strategy chosen while configuring the stage driver 

control block. The stage driver works with StageDriverAdd to distribute additional stages above those 

provided in the stage driver and maintains nonvolatile runtime total and digital stage status infor-

mation for each stage.  

When the equal runtime strategy is selected, the engineering tool must allocate a block of ControlNon-

volatile public variables for use as run timers, and convey the base PVID of that block to the 

STAGEDRIVER function block via the offset output. When other strategies are selected (STD or FOFO), 

no run timers are required, and the offset output content is ignored. 

The stgStatusOut output is also a legacy artifact that is no longer required. No connection is made to 

the STAGEDRIVER_ADD block(s) associated with the STAGEDRIVER. Instead, the STAGEDRIVER_ADD 

blocks must follow the STAGEDRIVER block directly (in the execution order). 

 

Logic Diagram 

 

Function Block 

Figure 308: Stage Driver Function 

Analog Inputs 

Table 84: Analog Inputs of Stage Driver Function 

Input Name 

Range 

Input Value Description 
Low High 

nStagesAc-

tive  

0 255 unconnected Stages all off 

invalid Stages all off 

runtimeReset 0 255 Unconnected No action to reset; runtime can accumulate 
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Input Name 
Range 

Input Value Description 
Low High 

Invalid No action; runtime can accumulate 

Value=0 No action; runtime can accumulate 

1<=VAL<=255 Stage runtime for stage VAL is reset to 0; 

runtime for this stage does not accumulate—

should be reset VAL to 0 to allow accumulation 

of runtime. 

Outputs 

Table 85: Outputs of Stage Driver Function 

Output 

Name 

Range 
Description 

Low High 

Stage1 0  1 Stage 1 output 

Stage2 0 1 Stage 2 output 

Stage3 0  1 Stage 3 output 

Stage4  0 1 Stage 4 output 

Stage5 0 1 Stage 5 output 

stgSta-

tusOut  

  Output values to connect to StageDriverAdd block. The floating number 

must be converted to an integer and then converted to a two-byte value. 

The upper byte (value right shifted 8 bits) is the maxStgs info and the lower 

byte (value AND 0xFF) is the stageStatus offset to reference the starting 

location in digital memory for the stageStatus bytes. 

offset    Float value has two components – after conversion to a two-byte unsigned 

integer value, the upper byte is the offset of the number of nonvolatile en-

tries to get to the start of the stage runtime storage (used only for 

leadLag=LL-RUNEQ) and the lower byte is the offset of number of digital 

memory locations to the start. 

Configuration 

Specify the maximum number of stages (maxStgs) from 1 to 255. 

Specify the lead lag 

• LL_FOLO = 0  first on last off 

• LL_FOFO = 1  first on first off 

• LL_RUNEQ = 2  runtime equalization for lowest runtime 
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If the leadLag is outside of the range of 0 - 2 then stages are initialized to off and not commanded. 
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Inputs 

nStagesActive is the input number of stages to be distributed to on/off values to individual stages. 

runtimeReset is the stage number. Runtime to be reset to 0 (zero), if the lead-lag parameter is set to LL 

RUNTIME, 0 (zero) or unconnected results in no reset occurring.  

This value must be returned to 0 (zero) to allow the reset stage number to resume counting. It is valid 

only when leadLag is set to LL RUNTIME. The stage runtime values are only allocated and updated if 

the leadLag config is set to LL RUNTIME. The runtime for each stage is stored as a floating-point num-

ber in intervals of 1 min. 

The stages are sampled once a minute and if the stage is on, the stage runtime accumulator number 

for that stage is incremented by one minute. The range of values for an integer number stored as a float 

is from –16,777,216 to 16,777,216. If the runtime is stored in minutes starting at 0 to 16, 777, and 

216, the range of runtime is from 0 to 31.92 years of run time. 

Outputs 

Stage1, stage2, stage3, stage4, and stage5 are individual outputs that represent on or off values. These 

are outputs that are turned on in a different order depending on the leadLag strategy. 

stgStatusOut is connected from StageDriver to the StageDriverAdd block and gives a floating-point 

number combined to hold two pieces of information, offset in the Common Memory to the StageBit-

Status values and maximum number of stages are available. This information is used by the StageDriv-

erAdd to find the correct offset to command which stages to turn on or off.  

The floating value can be converted into an integer and ANDed with 0xFF. It gives the value of the 

stageStatus Offset. The floating value stgStatusOut converted to an integer and right-shifted 8 bits 

gives the byte value of the maxStgs. These values are needed to allow the StageDriverAdd to work 

properly.  

The values in stgStatusOut are created by the StageDriver stage and no tool calculation is required.  

Offsets store the public Variable ID to a float value created by the tool to allocate storage memory and 

reference for stage status in digital memory and stage runtime in nonvolatile memory. There are two 

offsets stored inside the float value, one for runtime, and one for stage status. The offset, float value 

right-shifted 8 bits gives the number of nonvolatile float values from the beginning nonvolatile index 

(offset), where the runtime values are stored (one runtime value offset for each stage configured), and 

the offset ANDED with 0xff gives the number of digital values from the base, where the stageStatus is 

stored (one byte per up to 8 stages configured). Each digital memory location takes up 1 byte storage 

in calculating the offset. 

Example 

If three nonvolatile were already assigned and four digital outputs were already assigned before adding 

a StageDriver stage of nine stages with runtime accumulation, the offset float value would be 256 (3) 

+ 4 = 772.0. 

That means the tool would have 8 nonvolatile runtime locations starting at offset 3 from the base of 

nonvolatile memory. The tool allocates digital memory of two bytes for the stage status starting at off-

set of 4 from the base of digital memory. The tool sets this float value for offsets and allocates the 
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memory, and then StageDriver uses this information to know where to look for stageStatus and stage 

runtime information.  

The Float value that stores Offsets is composed of two values 

• offsetStageRuntimer (byte)  

The float value converted to an integer and shifted 8 bits specifies the variable quantity offset 

to be applied to the beginning of nonvolatile memory variable numbers that indicates the start-

ing variable number used to store the individual stage runtime values. This number is calcu-

lated by the configuration tool and is not changeable.  

• offsetStageStatus (byte)  

The float value converted to an integer and ANDed with 0xFF specifies the variable number 

offset to be applied to the beginning of the digital memory area that indicates the starting var-

iable number used to store the individual stage on/off values. This number is calculated by the 

configuration tool and is not changeable. This value is exported to other stages through the 

StageBitStatus output. 

Parameters 

leadLag (Byte param:UBYTE) specifies whether the staging strategy should be: 

• First on, last off (LL FILO = 0 - standard) 

• First on, first off (LL FOFO = 1 - Rotating) 

• Run time accumulation where next ON has lowest runtime and next OFF has highest runtime 

(LL RUNEQ = 2 - Runtime Accumulation) 

Runtime Accumulation selection requires the tool to allocate Nonvolatile memory and Set the Offsets 

value.  

Example: 

LL FILO: Consider that a Stage Driver function block is configured with 3 stages and with LL FILO 

settings for a boiler application. 

1. If nStageActiveinput value=1, Stage 1 is turned on. 

2. If nStageActiveinput value=2, Stage 1 and stage 2 are turned on. 

3. If nStageActiveinput value becomes 3, or greater than 3 then all 3 states are turned on. 

Assume that nStageActiveinput is 3 and it becomes 2 then stage 3 is turned OFF first and stage 1 and 

2 remain ON. Stage 3 is turned OFF, because it is last stage. Stage 1 always comes on first and is always 

the last stage to turn off. 

LL FIFO: If the stage driver is configured as LL_FIFO then stage driver operates the stages on a basis 

of First On First Off. 

Number of Active stages = value of nStagesActive input 

If stage driver with three stages and with LL_FIFO is configured and if, 

1. nStageActive input becomes 1 then stage driver turns on first stage. 

2. nStageActive input becomes 2 then stage driver turns on second stage. 
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3. nStageActive input becomes 1 then Stage 1 is turned OFF. 

4. nStageActive input again becomes 2 then Stage 3 is turned ON. 

nStageActive input becomes 1 then Stage 2 is turned OFF as it was the first stage. 

RUNEQ: If the stage driver is configured with LL_RUNEQ, it accumulates the run time of every active 

stage. When staging down is required, it turns OFF the stage which has largest runtime. 

Number of active stages=value of nStageActive input 

If the stage driver is configured with three stages and LL_RUNEQ setting, 

1. If nActiveStages input value is zero, all stages are turned OFF. If it is considered as an initial 

condition, accumulated active time for every stage is 0 minutes. 

2. If nActiveStages value becomes one, first stage is turned ON. If the stager remains in this con-

dition for two minutes, runtime of first stage is two minutes. 

3. If nActiveStages value becomes 2 then second stage turns ON. If stager remains in this condi-

tion for 2 minutes, runtime of first stage is 4 minutes and runtime of the second stage is 2 

minutes. 

4. If nActiveStages value becomes 1 then first stage is turned OFF, and second stage remains ON 

as second stage has least time. 

5. If nActiveStages value becomes 2 then third stage is turned ON as third stage has 0 runtime as 

compared to first stage. 

During staging up, the least runtime stage is turned ON and during staging down, the stage with high-

est run time is turned OFF. The aim is to equal runtime of every stage. 

maxStgs (Byte param:UBYTE) specifies how many total stages nStagesActive can reach. maxStgs can 

go up to a total of 20 stages. 

 

Example: Below is an example of using Stager and Stage Driver to enable 3 Chillers with Runtime 

equalization 

The setting for Stager & Stage Driver are as below 
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If Stager & Stage Driver are directly connected, then the value of Max Stages need to match exactly. 
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Note:   

Due to limitations of Niagara, only 95 stages can be seen on the wire sheet. To see, say stage number 

200, do one of the following: 

• Select the stages (in this case, stage 200) that needs to be seen by right-clicking them in the Block 

Configuration table under Show Stages and select Show. 

• Invoke the link editor on the wire sheet. Select the Source and Target (in this case, stage 200).  
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Logic Function Blocks 

The CIPer Model 30 programming model provides the following logic function blocks that you can con-

figure and use to build the required application logic:  

• AND 

• OneShot 

• OR 

• XOR 

Inputs to the logic function blocks may come from either Digital or Floating-point variables.  

For digital inputs: 

• 0 = FALSE 

• 1-255 = TRUE 

For floating point variables: 

• = FALSE 

• Any nonzero number = TRUE 

An output sent to a digital variable is 0 or 1. Similarly, an output sent to a float point variable is 0.0 or 

1.0. 

AND 

AND output becomes TRUE, if all inputs are TRUE. This function is a six-input AND Function Block. 

Each input may be individually inverted (NOT). The following table shows the basic operation of AND 

function block. 

 

Logic Diagram 

 

Function Block 

Figure 309: AND Function 
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Table 86: Basic Operation of AND 

Input Output 

(X NAND Y = XY) (X) (Y) 

0 (FALSE) 0 (FALSE) 0 (FALSE) 

0 (FALSE) 1 (TRUE) 0 (FALSE) 

1 (TRUE) 0 (FALSE) 0 (FALSE) 

1 (TRUE) 1 (TRUE) 1 (TRUE) 

The following table shows basic operation of NAND function block. 

Table 87: Basic Operation of NAND 

Input Output 

(X NAND Y = XY ) (X) (Y) 

0 (FALSE) 0 (FALSE) 1 (TRUE) 

0 (FALSE) 1 (TRUE) 1 (TRUE) 

1 (TRUE) 0 (FALSE) 1 (TRUE) 

1 (TRUE) 1(TRUE) 0 (FALSE) 

Unconnected or invalid inputs default to TRUE, without negation, to have no effect on the result. 

In each iteration, the function block keeps track of the last computed output value and the current true 

or false delay time. These values are cleared on power up/reset. 

Logic Inputs 

Table 88: Logic Inputs of AND Function 

Input Name Input Value Logic Value Description 

in1-6 VAL ! = 0.0 1  

 0 0  

 unconnected 1 Inputs with a "not" interpreted as logic 1 when 

disconnected. 

 invalid 1 Negin does not affect the invalid logic value. 
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Analog Inputs 
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Table 89: Analog Inputs of AND Function 

Input 

Name 

Range 
Input Value Description 

Low High 

trueDelay 0 3276 7 unconnected val = 0 

It is the minimum time the computed output must 

stay True before the output changes from False to 

True. 

(sec)   invalid val = 0 

falseDelay  0 3276 7 unconnected val = 0  

It is the minimum time the computed output must 

stay False before the output changes from True to 

False. 

(sec)   invalid val = 0 

 

Output 

Table 90: Outputs of AND Function 

Input 

Name 
Low Description 

OUTPUT Any floating-

point value 

Output = AND/NAND (inputs).  

Negating the Output makes AND function block operate like a NAND 

function block. 

 

Example  

1. Set In1- In6 = 1, and True delay = 2, and False delay = 6.  

In this case, the output is set to 1 after a time delay of 2 seconds as specified by the True delay.  

2. Set In1 = 0, In2 - In6 = 1, and True delay = 2, and False delay = 6.  

In this case, the output is set to 0 after a time delay of 6 seconds as specified by the False delay. 
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OneShot 

In the OneShot function block, when x transitions from False to True, y is set to True for onTime sec-

onds. 

The onTime is limited to the range 0 - 65535 sec. An onTime of zero keeps the output OFF irrespective 

of changes occur in the x input. 

Both the x input and y outputs have an option to be negated. In each iteration, the function block keeps 

track of the last input and the onTime. On power, up/reset, this track is cleared. 

 

Logic Diagram 

 

Function Block 

Figure 310: OneShot Function 

Logic Inputs 

Table 91: Logic Inputs of OneShot Function 

Input 

Name 

Input 

Value 
Logic Value Description 

X uncon-

nected 

N/A For an invalid input make output be OFF (ON if output is 

negated). Clear the timer. 

Must go from FALSE to TRUE (or TRUE to FALSE (Ne-

gated)) 

VAL != 0.0 1  

0 0  

invalid N/A Same as unconnected. 

Analog Inputs 

Table 92: Analog Inputs of OneShot Function 



HONEYWELL CIPer MODEL 30 SYSTEM ENGINEERING USER GUIDE 

FUNCTION BLOCK LIBRARY Logic Function Blocks 

31-00237EFS - 02 | 321  

Input Name 
Range 

Input Value Description 
Low High 

onTime(sec) 0 65535 unconnected onTime =0 

invalid onTime =0 

< 0 0  

>65535 65535 

Output 

Table 93: Output of OneShot Function 

Input 

Name 
Low Description 

Y False (0) or True (1) When x transitions from FALSE to TRUE, y is set to TRUE (1) for 

onTime seconds. Negation on input or output reverses the 

logic as appropriate. 

Example 

The Input is a square wave of 2 sec amplitude. The time transition diagram of the Output for different 

onTimes of 1 and 5 seconds is illustrated as shown in the following figure. 

 

Figure 311: Time Transition Diagram of 1 sec and 5 Sec 
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OR 

The OR output becomes TRUE if at least one input is TRUE. This function is a six input OR. Each input 

may be individually inverted (NOT).  

Following table shows basic operation of OR function block. 

Table 94: Basic Operation of OR 

Input Output 

(X OR Y = X + Y) (X) (Y) 

0 (FALSE) 0 (FALSE) 0 (FALSE) 

0 (FALSE) 1 (TRUE) 1 (TRUE) 

1 (TRUE) 0 (FALSE) 1 (TRUE) 

1 (TRUE) 1 (TRUE) 1 (TRUE) 

Following table shows basic operation of NOR function block. 

Table 95: Basic Operation of NOR 

Input Output 

(X NOR Y = Y  X + ) (X) (Y) 

0 (FALSE) 0 (FALSE) 1 (TRUE) 

0 (FALSE) 1 (TRUE) 0 (FALSE) 

1 (TRUE) 0 (FALSE) 0 (FALSE) 

1 (TRUE) 1(TRUE) 0 (FALSE) 

Unconnected or invalid inputs default to True, without negation, to have no effect on the result.  

In each iteration, the function block keeps track of the last computed output value and the current true 

or false delay time. These values are cleared on power up/reset. 
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Logic Diagram 

 

Function Block 

Figure 312: OR Function 

Logic Inputs 

Table 96: Logic Inputs of OR Function 

Input 

Name 
Input Value 

Logic 

Value 
Description 

in1-6 VAL != 0.0 1  

0 0  

unconnected 0 Inputs with a "not" interpreted as logic 0 when discon-

nected. 

0 0 Negin does not affect the invalid logic value 

Analog Inputs 

Table 97: Analog Inputs of OR Function 

Input Name 
Range 

Input Value Description 
Low High 

trueDelay 

(sec) 

0 32767 unconnected val = 0 

invalid val = 0 

falseDelay 0 32767 unconnected val = 0 
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Input Name 
Range 

Input Value Description 
Low High 

(sec) invalid val = 0 

Output 

Table 98: Output of OR Function 

Input Name Range Description 

OUTPUT False (0) or True (1) Output = OR/NOR (inputs) 

  



HONEYWELL CIPer MODEL 30 SYSTEM ENGINEERING USER GUIDE 

FUNCTION BLOCK LIBRARY Logic Function Blocks 

31-00237EFS - 02 | 326 

XOR 

The XOR output becomes TRUE if exactly one input is TRUE. This function is a six input XOR. Each 

input may be individually inverted (NOT). 

Table 99: Basic Operation of XOR 

Input Output 

(X OR Y = YXXY + ) (X) (Y) 

0 (FALSE) 0 (FALSE) 0 (FALSE) 

0 (FALSE) 1 (TRUE) 1 (TRUE) 

1 (TRUE) 0 (FALSE) 1 (TRUE) 

1 (TRUE) 1 (TRUE) 0 (FALSE) 

Following shows basic operation of XNOR function block. 

Table 100: Basic Operation of XNOR 

Input Output 

(X NOR Y = XYXY + ) (X) (Y) 

0 (FALSE) 0 (FALSE) 1 (TRUE) 

0 (FALSE) 1 (TRUE) 0 (FALSE) 

1 (TRUE) 0 (FALSE) 0 (FALSE) 

1 (TRUE) 1(TRUE) 1 (TRUE) 

Unconnected or invalid inputs default to True, without negation, to have no effect on the result.  

In each iteration, the function block keeps track of the last computed output value and the current true 

or false delay time. These values are cleared on power up/reset. 
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Logic Diagram 

 

Function Block 

Figure 313: XOR Function 

Logic Inputs 

Table 101 Logic Inputs of XOR Function 

Input 

Name 
Input Value 

Logic 

Value 
Description 

in1-6 VAL != 0.0 1  

0 0  

uncon-

nected 

0 Inputs with a "not" interpreted as logic 0 when discon-

nected. 

0 0 Negin does not affect the invalid logic value 

Analog Inputs 

Table 102: Analog Inputs of XOR Function 

Input Name 
Range 

Input Value Description 
Low High 

onTime (sec) 0 32767 unconnected val = 0 

invalid val = 0 



HONEYWELL CIPer MODEL 30 SYSTEM ENGINEERING USER GUIDE 

FUNCTION BLOCK LIBRARY Logic Function Blocks 

31-00237EFS - 02 | 328 

Input Name 
Range 

Input Value Description 
Low High 

0 32767 unconnected val = 0 

invalid val = 0 

Output 

Table 103: Output of XOR Function 

Input Name Low Description 

OUTPUT Any floating-point 

value 

Output = XOR/XNOR (inputs) 

 

  



HONEYWELL CIPer MODEL 30 SYSTEM ENGINEERING USER GUIDE 

FUNCTION BLOCK LIBRARY Math Function Blocks 

31-00237EFS - 02 | 329  

Math Function Blocks 

The CIPer Model 30 programming model provides the following Math function blocks that you can 

configure and use to build the required application logic:  

• Add 

• Digital Filter 

• Divide 

• Enthalpy 

• Exponential 

• Flow Velocity 

• Limit 

• Logarithm 

• Multiply  

• Ratio 

• Reset  

• Square Root 

• Subtract 

Add 

Math functions operate on and produce single precision floating-point numbers. In the absence of any 

other restrictions, if the result overflows the range of a single precision floating-point number (approx-

imately minus 3.4e38 to plus 3.4e38), the result returned is invalid. 

 
Note:   

You can connect both Analog and Digital inputs to this function block. 

TailOperation: The output value is based on one of four specified property values: 

• No Change: The actual result is returned. 

• Absolute: The absolute (modulus or non-negative) value of the result is returned. For example, 

if the output is -3, the result is 3. 

• Integer: The integer value of the result is returned. For example, if the output is 3.25, the result 

is 3. 

• Fractional: The fractional value of the result is returned. For example, if the output is 3.25, the 

result is .25. 

Ignore invalid inputs:  

 



HONEYWELL CIPer MODEL 30 SYSTEM ENGINEERING USER GUIDE 

FUNCTION BLOCK LIBRARY Math Function Blocks 

31-00237EFS - 02 | 330 

If this option is selected, function block considers only valid inputs while determining the addition of 

the inputs. If this option is not selected, and any input becomes invalid then the output becomes invalid 

too. 

  

Logic Diagram 

 

Function Block 

Figure 314: Add Function 

Inputs 

Table 104: Inputs of Add Function 

Input 

Name 

Range 
Input Value 

Ignore In-

valid Input Description 

Low High 

x1-x8 >= – infinity  <+ infinity  
uncon-

nected  

 Not used in the calculation. If all 

inputs are unconnected, output 

is zero. 

x1-x8  >= – infinity  <+ infinity  invalid  
false If any input is invalid, output is 

invalid. 

x1-x8  >= – infinity  <+ infinity  invalid 

true Output considers only valid in-

puts while determining the ad-

dition of the inputs. 

x1-x8  >= – infinity  <+ infinity  valid 
 Calculates the addition of 8 in-

puts or those set as constant. 

 

Output 

Table 105: Output of Add Function 
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Input Name Low Description 

Y  Any floating-point 

value 

Output is the sum of inputs x1 through x8. 
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Digital Filter 

This function digitally filters the input.  

Ynew = Yold +(X –Yold) * (1 – exp(–t/Tau)).  

τ

t

e
old

YX
old

YnewY

−

−−−= 







 

Where, t = 1 sec and Tau is in the range 0 - 65535 sec. 

The output can be initialized to zero (zeroInit=TRUE) or the first valid input value (zeroInit=FALSE). 

From iteration to iteration, the Function Block keeps track of the tau multiplier (1 – exp (–t/Tau)). On power, 

up/reset, this is recalculated 

 

Logic Diagram 

 

Function Block 

Figure 315: Digital Filter Function 

Inputs 

Table 106: Inputs of Digital Filter Function 

Input 

Name 

Range 
Input Value Description 

Low High 

X >= – infinity <+ infinity Uncon-

nected 

The output is invalid. 

   Invalid Output is set to invalid and filter reinitial-

izes when the input returns to valid. 

Output 

Table 107: Output of Digital Filter Function 
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Input Name Low Description 

Y Any floating-point 

value 

Ynew = Yold +(X –Yold) * (1 – exp (–t/Tau)). 
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Setpoint 

Table 108: Setpoint of Digital Filter Function 

Input Name Low Description 

Y Any floating-point 

value 

Ynew = Yold +(X –Yold) * (1 – exp (–t/Tau)). 

 

 
Note:   

Both Analog and Digital inputs can be connected as inputs to this function block. 

Example 1:  

Set In1 (X) = 4, tau = 2.0, Set ZeroInit = 1 (initializes filter to 0.0) 

Ynew = Yold + (X – Yold) * (1 – exp (–t / Tau)) 

In the first iteration,  

Yold = 0; Ynew = Yold + (X – Yold) *  

 (1 – exp (–t/Tau)) 

Ynew = 0 + (4 - 0) * (1 – 2.718 (–1 / 2)) 

          = 0 + 4 * (0.393)  

          = 1.572 

In the second iteration, 

Yold = 1.572; X = 4; Ynew = 1.57 +  

 (4 – 1.57) * (0.393) 

Ynew = 2.52 

In the third iteration, 

Ynew = 2.52 + (4 – 2.52) * (0.393) 

          = 3.107 

The iterations continue until the input is reached. 

Example 2:  

Set In1 (X) = 4, tau = 2.0, Set ZeroInit = 0 (initializes filter to first valid value) 

Ynew = Yold + (X – Yold) * (1 – exp (–t / Tau)) 

In the first iteration, 

Ynew = X 

          = 4 

In the second iteration, if X = 6 
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Ynew = Yold + (X – Yold) * (1 – exp (–t / Tau)) 

          = 4 + (6 – 4) * (0.393) 

          = 4 + 0.786 

          = 4.786 

In the third iteration, if X = 6 

Ynew = Yold + (X – Yold) * (1 – exp (–t / Tau)) 

          = 4.786 + (6 – 4.786) * (0.393) 

          = 5.263. 

The iterations continue until the input is reached. 
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Divide 

This function divides one input by the other. 

Y = x1 / x2. Division by 0 results in an invalid output. If the result overflows the range of a single precision 

floating point number (approximately minus 3.4e38 to plus 3.4e38) the result returned is invalid. 

divOperation: The result of the division is based on one of two specified property values. For Modulo, 

the output is the remainder of the division; for Divide, the output is the quotient. 

TailOperation: The output value is based on one of four specified property values: 

• No Change: The actual result is returned. 

• Absolute: The absolute (modulus or non-negative) value of the result is returned. For example, 

if the output is -3, the result is 3. 

• Integer: The integer value of the result is returned. For example, if the output is 3.25, the result 

is 3. 

• Fractional: The fractional value of the result is returned. For example, if the output is 3.25, the 

result is .25. 

 
Note:   

Both Analog and Digital inputs can be connected as inputs to this function block. 

 

 

Logic Diagram 

 

Function Block 

Figure 316: Divide Function 

Analog Inputs 

Table 109: Analog Inputs of Divide Function 
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Input 

Name 

Range Input 

Value 

Ignore In-

valid Input Description 
Low High 

x1, x2 >= – infinity  <+ infinity  

uncon-

nected  

 Not used in the calculation. If all in-

puts are unconnected, output is set to 

invalid. 

invalid  false If any input is invalid, output is invalid. 

invalid 

true Output considers only valid inputs 

while determining the division of the 

inputs. 

valid 
 Calculates the division of two inputs 

or those set as constant. 

Output 

Table 110: Output of Divide Function 

Output Name Range Description 

Y out Any floating-point value Y= x1/x2 

Configuration 

Table 111: Configuration of Divide Function 

Name Range Description 

invalidFlag 0 to 1 See above table. 

divOperation 0 to 1 Divide operation to be performed:  

0 = division/quotient. Result is x1/x2. 

1 = modulo/remainder. The result is x1 modulo x2, that is,the remain-

der f, where 

x1 = a*x2 + f for some integer a and 0 <= f < x2. 

tailOperation 0 to 3 Operation to be applied to the result just prior to output: 

 0 = no change to result 

1 = absolute value (result is made positive if negative) 

2 = integer part. The fractional part is truncated to 0. The sign is re-

tained 
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Name Range Description 

3 = fractional part. The integer part is truncated to 0. The result is al-

ways positive. 
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Enthalpy 

This function computes the enthalpy (BTU/LB) based on the temperature (F) and relative humidity 

(%) inputs. Relative humidity (rh) is limited to 0% to 100%. Temperature is limited to 0F - 120F. 

 

Logic Diagram 

 

Function Block 

Figure 317: Enthalpy Function 

Analog Inputs 

Table 112: Analog Inputs of Enthalpy Function 

Input Name 
Range 

Input Value Description 

Low High 

t  0F 120F unconnected output = invalid 

(F)   invalid output = invalid 

   VAL < low T = low 

   VAL > high T = high 

rth (%) 0 100 unconnected output = invalid 

   invalid output = invalid 

   VAL < low RH = low 

   VAL > high RH = high 

Output 

Table 113: Output of Enthalpy Function 

Input Name Low Description 

Y Any floating-point value Output = Enthalpy (t, rth) 
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Exponential 

This function raises y to the power of x. x and y are floating point numbers. The application designer is 

limited to two function blocks (these types) per device. Unconnected inputs are treated as 0. Invalid 

inputs result in an invalid output. The negInvalid input determines whether the operation should pro-

ceed with a negative base and non-integer exponent, operating on the absolute value of the base, or 

return invalid. The negInvalid input does not affect an unconnected or invalid input. If both the x and y 

inputs are disconnected, the output z is 1. 

TailOperation: The output value is based on one of four specified property values: 

• No Change: The actual result is returned. 

• Absolute: The absolute (modulus or non-negative) value of the result is returned. For example, 

if the output is -3, the result is 3. 

• Integer: The integer value of the result is returned. For example, if the output is 3.25, the result 

is 3. 

• Fractional: The fractional value of the result is returned. For example, if the output is 3.25, the 

result is .25. 

 

Logic Diagram 

 

Function Block 

Figure 318: Exponential Function 

Analog Inputs 

Table 114: Analog Inputs of Exponential Function 

Input Name 
Range 

Input Value Description 

Low High 

onTime 0 65535 unconnected onTime = 0 
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Input Name 
Range 

Input Value Description 
Low High 

(sec) 
 invalid onTime = 0 

 < 0 0  

 >65535 65535 

 

Output 

Table 115: Output of Exponential Function 

Input 

Name 
Low Description 

Y Any floating-point 

value 

When x transitions from FALSE to TRUE, y is set to TRUE (1) for 

onTime seconds. 
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FlowVelocity 

This function computes the flow and velocity based on the measured pressure and the K factor. 

offsetΔPKflow −=  

And  

Vel = flow/area  

Where:  

• K = Flow coefficient (K-Factor) representing the actual flow in ft^3/min corresponding to a ve-

locity pressure sensor output of 1 w.g. 

• DeltaP = Flow sensor output pressure in inches  

• Water gauge (inw) 

• OFFSET = Correction pressure (inw) to adjust for zero 

• FLOW = Airflow in ft3/min (CFM) 

• VEL = Flow velocity in ft/min 

• area = Duct area in ft2 

 

Logic Diagram 

 

Function Block 

Figure 319: Flow Velocity Function 

Analog Inputs 

Table 116: Analog Inputs of Flow Velocity Function 

Input Name 
Range 

Input Value Description 
Low High 

press  >= – infinity < + infinity unconnected Output is set to invalid 
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Input Name 
Range 

Input Value Description 
Low High 

invalid Output is set to invalid 

> –0.002425 and  

< 0.002425 inw 

Flow and vel = 0 

autoSet-

Offset 

>= – infinity < + infinity Unconnected No effect on output 

Invalid No effect on output 

clearOffset   >= – infinity < + infinity ! = 0 Set offset = incoming press 

unconnected or invalid No effect on output 

! = 0 Set offset = 0 

area  >= – infinity < + infinity Invalid or < = 0; value in ft2 Velocity is set to invalid 

kFactor  >= – infinity < + infinity unconnected Output is set to invalid 

invalid Output is set to invalid 

< = 0 kFactor = 1015 

Output 

Table 117: Output of Flow Velocity Function 

Input Name 
Range 

Description 
Low High 

FLOW > = – infinity <+ infinity Flow value (ft3/min)  

OFFSET > = – infinity <+ infinity Input press, offset correction (inches water column). 

Not used for hardware connection. Stores Flow offset 

amount. 

VEL > = – infinity <+ infinity Flow velocity (ft/min) 
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Limit 

This function limits the input to the low and high limits. 

If the value of input (x) is:  

• Lower than the lowLimit, value of output is set to lowLimit 

• Higher than the hiLimit, output is set to hiLimit 

• Between the lowLimit and hiLimit, output is set to input 

 

Logic Diagram 

 

Function Block 

Figure 320: Limit Function 

Analog Inputs 

Table 118: Analog Inputs of Limit Function 

Input 

Name 

Range 
Input Value Description 

Low High 

x >= – infinity <+ infin-

ity 

unconnected Output is set to invalid  

   invalid Output is set to invalid 

   x< lowLimit Output is set to lowLimit  

   lowLimit > hiLimit Limits not enforced (not enforced means 

Y is always set to X.) 

   lowLimit < x < 

hiLimit 

Output set to x x>hiLimit Output set to 

hiLimit 

hiLimit >= – infinity <+ infin-

ity 

unconnected hiLimit not enforced  

   invalid hiLimit not enforced 

low-

Limit 

>= –infinity <+ infin-

ity 

unconnected lowLimit not enforced 

   invalid lowLimit not enforced 

Output 

Table 119: Output of Limit Function 
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Input Name Range Description 

Y Any floating-point value Y = Limit (x, lowLimit, hiLimit) 

Multiply 

This function multiplies one input with the other.  

y = x1 multiplied by x2. If the result overflows the range of a single precision floating point number 

(approximately minus 3.4e38 to plus 3.4e38), the result returned is invalid. 

 
Note:  

Both Analog and Digital inputs can be connected as inputs to this function block. 

TailOperation: The output value is based on one of four specified property values: 

• No Change: The actual result is returned. 

• Absolute: The absolute (modulus or non-negative) value of the result is returned. Example: If 

the output is -3, the result is 3. 

• Integer: The integer value of the result is returned. For example, if the output is 3.25, the result 

is 3. 

• Fractional: The fractional value of the result is returned. For example, if the output is 3.25, the 

result is .25. 

Ignore invalid inputs: If this option is selected, function block considers only valid inputs while deter-

mining the multiplication of the inputs. If this option is not selected and any input becomes invalid, 

output also becomes invalid.  

 

Logic Diagram 

 

Function Block 

Figure 321: Multiply Function 

Analog Inputs 

Table 120: Analog Inputs of Multiply Function 
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Input 

Name 

Range 
Input 

Value 

Ignore In-

valid In-

put 

Description 
Low High 

x1, x2 >= – infinity  <+ infinity  

uncon-

nected  

 Unconnected inputs are set to zero. If 

all inputs are unconnected, output is 

set to zero. 

invalid  false If any input is invalid, output is invalid. 

invalid 

true Output considers only valid inputs 

while determining the multiplication of 

the inputs. 

valid 
 Calculates the multiplication of two in-

puts or those set as constant. 

Output 

Table 121: Output of Multiply Function 

Input Name Range Description 

Y Any floating-point value Y= x1 * x2 
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Ratio 

This function converts the input X to the output Y based on the line defined by x1, y1, x2, and y2. 

Output (Y) = y1 + (((x – x1) * (y2 – y1)) / (x2 – x1)) 

 

Logic Diagram 

 

Function Block 

Figure 322: Ratio Function 

Analog Inputs 

Table 122: Analog Inputs of Ratio Function 

Input Name 
Range 

Input Value 
Ignore Invalid 

Input Description 
Low High 

x >= – infinity  <+ infinity  

uncon-

nected  

true Output set to invalid. 

false Output set to invalid. 

invalid  
true Output set to y1. 

false Output set to invalid. 

x1-x2  >= – infinity  <+ infinity  

uncon-

nected 

true Output set to invalid. 

false Output set to invalid. 

invalid 
true Output set to y1. 

false Output set to invalid. 

y1  >= – infinity  <+ infinity  

uncon-

nected 

true Output set to invalid. 

false Output set to invalid. 

invalid 
true Output set to invalid. 

false Output set to invalid. 
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Input Name 
Range 

Input Value 
Ignore Invalid 

Input Description 
Low High 

Y2 >= – infinity  <+ infinity  

uncon-

nected 

true Output set to invalid. 

false Output set to invalid. 

invalid 
true Output set to y1. 

false Output set to invalid. 

Output 

Table 123: Output of Ratio Function 

Input 

Name 
Range Description 

OUTPUT Any floating-point value Out Ratio (X, X1, Y1, X2, Y2) 

Setpoints 

Table 124: Setpoints of Ratio Function 

Input 

Name 
Range/Value Description 

operation Unlimited 

Vav_Flow_Balance 

Endpoint_Limited 

 

Unlimited 

The output is based on the line defined by x1, x2, y1, y2. The behavior of the function block is as illus-

trated in the following figure. 

Y = y1 + (((x – x1) * (y2 – y1)) / (x2 – x1)) 
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Figure 323: Unlimited 

VAV Flow Balance 

The output is based on the line defined by x1, x2, y1, y2. The slope of the line is as shown in the following illustration. 

• When x1 = 0,  

OUTPUT = 0 

• When x >= x1, 

OUTPUT = y1 + (((x - x1) * (y2 - y1)) / (x2 - x1)) 

• When x < x1, 

OUTPUT = ((x * y2) / x2) 

 

Figure 324: VAV Flow Balance  
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Endpoint Limited 

The output is based on the line defined by x1, x2, y1, y2. The slope of the line is as shown in the following 

illustration. Beyond points x1 and x2, the output is limited to the point y1 and y2 respectively. The out-

put is held between the point y1 and y2. 

 

Figure 325: Endpoint Limited 

• When x1 < x2 and x <= x1 OUTPUT = Y1 

• When x1 < x2 and x >= x2 OUTPUT = Y 

• When x1 > x2 and x <= x2 OUTPUT = Y2 

• When x1 > x2 and x >= x1 OUTPUT = Y1 
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Reset 

This function computes the reset value based on the relation of the input to the reset parameters. 

 

Logic Diagram 

 

Function Block 

Figure 326: Reset Function 

Analog Inputs  

Table 125: Analog Inputs of Reset Function 

Input Name 
Range 

Input Value Description 
Low High 

input >= – infinity <+ infinity unconnected Output is set to invalid  

  invalid Output is set to invalid 

sensor >= – infinity <+ infinity unconnected Output is set to invalid 

  invalid Output = input 

zeroPctResetVal >= – infinity <+ infinity unconnected Output is set to invalid 

  invalid Output = input 

  0%RV = 100%RV Output is set to invalid 

hundredPctReset-

Val 

>= – infinity <+ infinity unconnected Output is set to invalid 

  invalid Output = input 

  0%RV = 100%RV Output is set to input 

resetAmount >= – infinity <+ infinity unconnected Output is set to invalid 

  invalid Output = input 
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Output 

Table 126: Output of Reset Function 

Input Name Range Description 

OUTPUT Any floating-point 

value 

Y = Reset (input, sensor, 0%, 100%, reset amount) 

Working 

 

Figure 327: Working of Reset 

Table 127: Input and Output of Reset Function 

If Input Condition is  Output 

• Input is unconnected  

• Input is invalid 

• Sensor is unconnected  

• zeroPctResetVal is unconnected  

• hundredPctResetVal is unconnected  

• resetAmount is unconnected 

Output = invalid  

• Sensor is invalid  

• Sensor < zeroPctResetVal  

• zeroPctResetVal is invalid  

• hundredPctResetVal is invalid  

Output = input 
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If Input Condition is  Output 

• resetAmount is invalid  

• hundredPctResetVal = zeroPctResetVal 

Sensor > hundredPctResetVal  Output = input + resetAmount 

If none of the above conditions are satisfied Output =  input + ((sensor – zeroPctResetVal) / 

 hundredPctResetVal – zeroPctResetVal)) * 

 resetAmount 
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Square Root 

This function takes the square root of the input. The Output Y is the Sqrt (x), where x is the input. The 

behavior of a negative x input is controlled by the parameter negInvalid. 

 
Note:  

Negative values are treated as absolute values. Example: Square root of -9801 is given as 99, taking the absolute 

value of –9801 as 9801. 

TailOperation: The output value is based on one of four specified property values: 

• No Change: The actual result is returned. 

• Absolute: The absolute (modulus or non-negative) value of the result is returned. For example, 

if the output is -3, the result is 3. 

• Integer: The integer value of the result is returned. For example, if the output is 3.25, the result 

is 3. 

• Fractional: The fractional value of the result is returned. For example, if the output is 3.25, the 

result is .25. 

 

Logic Diagram 

 

Function Block 

Figure 328: Square Root Function 

Analog Inputs 

Table 128: Analog Inputs of Square Root Function 

Input 

Name 

Range Input 

Value 
Description 

Low High 

X >=– in-

finity 

<+ infin-

ity 

uncon-

nected 

Y= 0  

invalid Output is set to invalid 

x1 < 0 See the description for negInvalid input. 

negInvalid 0 1 0 Use the square root of the absolute value. 

1 If the input is negative, the output is invalid. The 

default value is 0.  
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Input 

Name 

Range Input 

Value 
Description 

Low High 

 uncon-

nected 

Y = sqrt(X), output is invalid for neg x1 

 invalid Y = sqrt(X), output is invalid for neg x1 

Output 

Table 129: Output of Square Root Function 

Input Name Range Description 

Y  Any floating-point 

value 

Y= Sqrt (X) 
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Subtract 

This function subtracts one input from the other. Y = x1 – x2. If the result overflows the range of a single 

precision floating point number, (approximately minus 3.4e38 to plus 3.4e38) the result returned is in-

valid. 

 Note:   

Both analog and digital inputs can be connected as inputs to this function block. 

Ignore invalid inputs:  

If this option is selected, the function block considers only valid inputs while determining the subtrac-

tion of the inputs. If this option is not selected and any input become invalid, output also becomes 

invalid 

TailOperation: The output value is based on one of four specified property values: 

• No Change: The actual result is returned. 

• Absolute: The absolute (modulus or non-negative) value of the result is returned. For example: 

if the output is -3, the result is 3. 

• Integer: The integer value of the result is returned. For example, if the output is 3.25, the result 

is 3. 

• Fractional: The fractional value of the result is returned. For example, if the output is 3.25, the 

result is .25. 

 

Logic Diagram 

 

Function Block 

Analog Inputs 

Table 130: Analog Inputs of Subtract Function 
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Input 

Name 

Range Input 

Value 

Ignore Invalid 

Input Description 
Low High 

x1, x2 >= – infinity  <+ infinity  

un-

con-

nected  

 Unconnected inputs are set to 

zero. If all inputs are unconnected, 

output is set to zero. 

invalid  
false If any input is invalid, output is in-

valid. 

invalid 

true Output considers only valid in-

puts while determining the sub-

traction of the inputs. 

valid 
 Calculates the subtraction of two 

inputs or those set as constant. 

Output 

Table 131: Output of Subtract Function 

Input Name Range Description 

Y  Any floating-point 

value 

Y= x1 - x2 
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Logarithm 

This function takes either the natural logarithm  

(log
e
(x) = ln(x)) or logarithm base 10 (log

10
(x)) of the input, depending on the configuration setting 

eOR10.  

Y = log
e
(X) or Y = log

10
(X).  

eOR10: The Log operation depends on the selection of this configuration property. In this property, you 

can select a natural or base10 log. 

• Natural: Natural logarithm (log
e
(x) = ln(x)) of the input 

• Base10: logarithm base 10 (log
10

(x)) of the input 

• TailOperation: The output value is based on one of four specified property values: 

• No Change: The actual result is returned. 

• Absolute: The absolute (modulus or non-negative) value of the result is returned. For example, 

if the output is −3, the result is 3. 

• Integer: The integer value of the result is returned. For example, if the output is 3.25, the result 

is 3. 

• Fractional: The fractional value of the result is returned. For example, if the output is 3.25, the 

result is .25.  

 

Logic Diagram 

 

Function Block 

Figure 329: Logarithm Function 

Analog Inputs 

Table 132: Analog Inputs of Subtract Function 
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Input Name 
Range 

Input Value Description 
Low High 

x > 0 + infinity uncon-

nected 

Output is set to invalid  

   invalid Output is set to invalid 

   x<=0 Output is set to invalid 

Output 

Table 133: Output of Subtract Function 

Input Name Range Description 

 Any floating-point 

value 

Y= Log (x) 
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Data Function Blocks 

The CIPer Model 30 programming model provides the following Data Function blocks that can be con-

figured and use to build the required application logic:  

• Counter 

• Override 

• RunTimeAccumulate 

Counter 

This function counts leading edge transitions of the input. If enable is True and the input transitions 

from False to True, the count is incremented or decremented by the count value. Positive values on 

count value increment the count. Negative values decrement the count. If the preset is True, the count 

is set to the Preset Value. From iteration to iteration, the Function Block keeps track of the previous 

state of the input so that it can detect a transition. On power up/reset, this is cleared. 

 

Figure 330: Counter Property Sheet 

Unconfigured is taken as high priority compared to Negate. If nothing is configured and Negate is ap-

plied nothing will get effected. Unconfigured will be taken as high priority. 
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Logic Diagram 

 

Function Block 

Figure 331: Counter Function 

Logic Inputs 

Table 134: Logic Inputs of Counter Function 

Input 

Name 

Input Value Logic 

Value 

Description 

Input  

unconnected 0 Set Input = False 

invalid 0 Set Input = False 

0 0 Input is False 

VAL != 0.0 1 Input is True 

Enable 

unconnected 1 Set Enable = True 

invalid 1 Set Enable = True 

0 0 Set Enable = False 

VAL != 0.0 1 Set Enable = True 

Preset 

unconnected 0 Set Preset = False 

invalid 0 Set Preset = False 

0 0 Set Preset = False 

VAL != 0.0 1 Set Preset = False 

StopAtZero 

unconnected 0 Set Stop At Zero = False. The default value is False. 

invalid 0 Set Stop At Zero = False. 

0 0 Stop At Zero is False. The count is unaffected by a zero 

value. 
VAL != 0.0 

1 Stop At Zero is True. Stops counting at zero if counting 

down from a positive count or up from a negative 

count. 
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Analog Inputs 

Table 135: Analog Inputs of Counter Function 

Input Name 

Range 

Input Value Description 
Low High 

Count Value  >= – infinity <+ infinity uncon-

nected 

Set Count Value = 1.0. The default 

value = 1.0 

Invalid Set Count Value = 1.0 

VAL < low Set Count Value = 1.0 

VAL > high Set Count Value = 1.0 

Preset Value  >= – infinity <+ infinity uncon-

nected 

Set Preset Value = 0.0 

Invalid Set Preset Value = 0.0 

VAL < low Set Preset Value = 0.0 

VAL> high Set Preset Value = 0.0 

 

  



HONEYWELL CIPer MODEL 30 SYSTEM ENGINEERING USER GUIDE 

FUNCTION BLOCK LIBRARY Data Function Blocks 

31-00237EFS - 02 | 363  

Output 

Table 136: Output of Counter Function 

Output Name Range Description 

COUNT Any floating-point number Counter value 

 

 

Figure 332: Transition versus Time with Positive and Negative Count Values 

Example: The counter setting to accumulate Pulse meter signal. (Note:  set the Count value 1 or more 

as per requirement) 
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Override 

This function sets the output to the highest priority input that is not invalid. The Priority1 value has the 

highest priority and cntrlInput the lowest priority. This function block checks if the Inputs are not invalid 

in the following order:  

1. priority1Value 

2. priority2Value 

3. priority3Value 

4. priority4Value 

5. priority5Value 

6. priority6Value 

7. CtrlInput 

The first value that is not invalid in the order of priority is set as the output. If all inputs are invalid or 

unconnected, the output is set to the defaultValue. 

This function block corresponds to the BACnet priority array implementation with the replacement of 

the BACnet NULL state with invalid. 

 

Logic Diagram 

 

Function Block 

Figure 333: Override Function 
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Analog Inputs 

Table 137: Analog Inputs of Override Function 

Input Name 
Range 

Input Value Description 
Low High 

prior-

ity1Value 

through pri-

ority6Value  

>= –∞ <+∞ Uncon-

nected or in-

valid 

Output = highest priority input (priority1Val is top 

priority and cntrlInput is lowest priority) that is not 

invalid or unconnected. If no inputs are valid, use de-

faultValue. 

cntrlInput  >= –∞ <+∞ Uncon-

nected or in-

valid 

Output = highest priority input (priority1Val is top 

priority and cntrlInput is lowest priority) that is not 

invalid or unconnected. If no inputs are valid, use de-

faultValue. 

default-

Value  

>= –∞ <+∞ unconnected defaultValue = invalid 

invalid defaultValue = invalid 

Output 

Table 138: Output of Override Function 

Output Name Range Description 

effOutput >= –∞ <+∞ effOutput = highest priority input that is not inva-

lid. 

Example 

Set the Inputs to the following:  

• Priority 1 Value = Invalid 

• Priority 2 Value = Invalid 

• Priority 3 Value = 50 

• Priority 4 Value = 60 

• Priority 5 Value = –20 

• Priority 6 Value = 80 

• Ctrl Input = 30 

The output is set as 50. Priority 1 and Priority 2 values are invalid. The next highest priority value (Priority 

3 value = 50) is set as the output. 

An invalid input to this function block could arise when the output of the Minimum function block can 

be connected whose input is invalid.  
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RuntimeAccumulate 

This function accumulates runtime whenever the input is True (non-zero) and enable is True. If Preset 

is True, runtime is set equal to the Preset Value. Runtime is provided in four outputs of seconds, 

minutes, hours, and days. In each iteration, the function block keeps track of the run time seconds. On 

power up/reset, this track is cleared. 

 

Figure 334: Runtime Accumulate Property Sheet 

Unconfigured is taken as high priority compared to Negate. If nothing is configured and Negate is ap-

plied nothing will get effected. Unconfigured will be taken as high priority. 

 Note:  

On power up/reset, only the Runtime Sec output is set to zero. The other three outputs, RUNTIME_MIN, 

RUNTIME_HRS, and RUNTIME_DAYS are stored and not lost. 

 

Logic Diagram 

 

Function Block 
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Figure 335: Runtime Accumulate Function 

Logic Inputs 

Table 139: Logic Inputs of Runtime Accumulate Function 

Input Name Input Value Logic Value Description 

Input  

unconnected 0 Set Input = False 

invalid 0 Set Input = False 

0 0 Input is False 

VAL != 0.0 1 Input is True 

Enable 

unconnected 1 Set Enable = True 

invalid 1 Set Enable = True 

0 0 Enable is False 

VAL != 0.0 1 Enable is True 

Preset 

unconnected 0 Set Preset = False 

invalid 0 Set Preset = False 

0 0 Preset is False 

VAL != 0.0 1 Preset is True 

Analog Inputs 

Table 140: Analog Inputs of Runtime Accumulate Function 

Input Name 
Range 

Input Value Description 
Low High 

PresetValue 0 <+8 unconnected Set Preset Value = 0.0 (in minutes) 

invalid Set Preset Value = 0.0 

VAL < low Set Preset Value = 0.0 

VAL > high Set Preset Value = 0.0 

Output 

Table 141: Outputs of Runtime Accumulate Function 
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Output Name  Range Description 

RUNTIME_MIN Any floating-point number >= 

0 

Runtime minutes 

RUNTIME_SEC Any floating-point number >= 

0 

Runtime seconds 

RUNTIME_HRS Any floating-point number >= 

0 

Runtime hours 

RUNTIME_DAYS Any floating-point number >= 

0 

Runtime days 

 

  



HONEYWELL CIPer MODEL 30 SYSTEM ENGINEERING USER GUIDE 

FUNCTION BLOCK LIBRARY Data Function Blocks 

31-00237EFS - 02 | 370 

Operation 

 

Figure 336: RunTime Function Block 

Run time is always accumulated internally in minutes. It is reported in 4 different units of seconds, 

minutes, hours and days. Run time Min is saved over a power outage and reset. If a power outage or 

reset occurs, the controller could lose up to one minute of runtime. RUNTIME_MIN, RUNTIME_HRS, 

and RUNTIME_DAYS are calculated at every iteration from the RUNTIME_MIN.  

RUNTIME_HRS and RUNTIME_DAYS outputs are fractional units to the nearest minute. 

RUNTIME_SEC is RUNTIME_MIN multiplied by 60. The preset input should be used to set the runtime 

to an initial value in minutes.  

Runtime Accumulate is run every second. The state of the input, enable, and the preset are examined 

by the function block when it is run. Momentary transitions of the inputs between invocations of the 

function block are not detected. If the runtime reaches 16,277,216 minutes, it stops. 

RUNTIME_MIN is effectively limited to 16, 277,216 minutes (31 years). 

Example 

Connect an output from another block to the Input. Connect a digital input to Preset. Set the Preset 

Value to 123. Set the PresetValue to 255 (TRUE).  

The four outputs are as follows:  

• RUNTIME_MIN = 123 

• RUNTIME_SEC = 7380 

• RUNTIME_HRS = 2.05 

• RUNTIME_DAYS = 0.085416 

 

Run Time
Function Block

    
Input 

Valid values:
True, False

    

Run Time
Accumulate

    
Enable

 Valid values:
True, False

    

    
Preset

 Valid values:
True, False

    

    

Preset  Value
(in seconds)

    

KEY :

Module
    

Public variable

        
Runtime Min
Runtime Sec
Runtime Hrs

Runtime Days
    

Internal Data Path
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Once you release the Preset point, the block will start accumulating the runtime value from the preset 

value. 
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ZoneControl Function Blocks 

The CIPer Model 30 programming model provides the following Zone Arbitration function blocks that 

you can configure and use to build the required application logic: 

• GeneralSetpointCalculator 

• OccupancyArbitrator 

• SetTemperatureMode 

• TemperatureSetPointCalculator 

GeneralSetpointCalculator 

This function does a generic setpoint calculation, including reset. It uses the three configuration pa-

rameters, that is effective occupancy, current state, and reset input to calculate the effective setpoint. 

 

Logic Diagram 

 

Function Block 

Figure 337: General Set Point Calculator Function 

Analog Inputs 

Table 142: Analog Inputs of General Set Point Calculator Function 

Input Name 
Range 

Input Value Description 
Low High 

Eff Occ Current 

state 

 

0 3 unconnected Eff Occ Current state = 0 (OCC) 

invalid Eff Occ Current state = 0 (OCC) 

VAL < low Eff Occ Current state = 0 (OCC) 

VAL > high Eff Occ Current state = 0 (OCC) 

Reset Input >= –∞ <+∞ unconnected Reset Input = Invalid 
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Input Name 
Range 

Input Value Description 
Low High 

 
invalid Reset Input = Invalid 

VAL < low Reset Input = Invalid 

VAL > high Reset Input = Invalid 

Reset 0Pct 

 

>= –∞ <+∞ unconnected Reset 0Pct = Invalid 

invalid Reset 0Pct = Invalid 

Val < low Reset 0Pct = Invalid 

Val > high Reset 0Pct = Invalid 

Reset 100Pct 

 

>= –∞ <+∞ unconnected Reset 100Pct = Invalid 

invalid Reset 100Pct = Invalid 

Val < low Reset 100Pct = Invalid 

Val > high Reset 100Pct = Invalid 

Reset Amount 

 

>= –∞ <+∞ unconnected Reset Amount = Invalid 

invalid Reset Amount = Invalid 

Val < low Reset Amount = Invalid 

Val > high Reset Amount = Invalid 

Occupied Setpoint 

 

>= –∞ <+∞ unconnected Occupied Setpoint = Invalid 

invalid Occupied Setpoint = Invalid 

Val < low Occupied Setpoint = Invalid 

Val > high Occupied Setpoint = Invalid 

Standby setpoint 

 

>= –∞ <+∞ unconnected Standby Setpoint = Invalid 

invalid Standby Setpoint = Invalid 

Val < low Standby Setpoint = Invalid 

Val > high Standby Setpoint = Invalid 

>= –∞ <+∞ unconnected Unoccupied Setpoint = Invalid 
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Input Name 
Range 

Input Value Description 
Low High 

Unoccupied set-

point 

invalid Unoccupied Setpoint = Invalid 

Val < low Unoccupied Setpoint = Invalid 

Val > high Unoccupied Setpoint = Invalid 

State value:  

• Occ = 0 

• Unocc=1 

• Bypass =2 

• Standby = 3 

• Null = 255 

  



HONEYWELL CIPer MODEL 30 SYSTEM ENGINEERING USER GUIDE 

FUNCTION BLOCK LIBRARY ZoneControl Function Blocks 

31-00237EFS - 02 | 375  

Output 

Table 143: Output of General Set Point Calculator Function 

Input Name Range Description 

Eff Setpoint Any floating-point number Effective Setpoint 

 

 

Figure 338: General Set Point Calculator 

Reset Input 

Reset allows to change the effective setpoint either in the direction of increased energy savings or in 

the direction of increased comfort. The Reset Amount (+/-) is positive or negative to accommodate en-

ergy savings versus comfort. The reset value varies between zero and the reset amount and is propor-

tional to the Reset Input with respect to the Reset 0% and Reset 100% parameters.  

 
Note:   

Ensure that the Reset 0% and Reset 100% parameters are in the same engineering unit as the Reset 

Input. The Reset Amount should be in the same units as the configured setpoints.  

Positive reset values are added to the setpoint and negative resets are subtracted. Reset only applies 

in the occupied mode. Reset 0% can be any relation to Reset 100%. The following illustration shows 

Reset 0% less than Reset 100% with a positive reset amount. If any of the Reset Input, Reset 0%, Reset 

100% or Reset Amount parameters is invalid, the Reset value is set to zero (0). 

  

    
Occ, Sby, Byp, Unocc

    

Gen SP Calc

    

Occ, Standby, Unocc

    

    

0%, 100%, Amount

    

    

    

KEY :

Module
    

Public variable
        

Effective Setpoint
    Internal Data Path

Reset Input

Reset3 Setpoints

General Setpoint Calculator

Eff Occ Current State
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Figure 339: Reset Calculation: Positive Amount 0% < 100% 

 

Figure 340: Reset Calculation: Positive Amount 100% < 0% 

Eff Occ Current State 

The effective occupancy current state comes from a scheduler. The valid values are: 

• Occupied 

• Unoccupied 

• Bypass 

• Standby 

• Null 

The General Setpoint Calculator uses the three configured setpoints: effective occupancy, current 

state, and reset input to determine the effective setpoint. If a setpoint is invalid, INVALID is propagated 

to the output as appropriate. 

Table 144: Valid values of Effective Occupancy Current State 

Eff Occ Current State Eff Setpoint 

UNOCC Result = unoccupied setpoint 

STANDBY Result = standby setpoint 

OCC Result = occupied setpoint + reset 

BYPASS Result = occupied setpoint + reset 

NULL Result = occupied setpoint + reset 
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OccupancyArbitrator 

This function computes the present Effective Occupancy Current State and the Manual Override State. 

  

Logic Diagram Function Block 

Figure 341: Occupancy Arbitrator 

Inputs 

Table 145: Inputs of Occupancy Arbitrator 

Input Name 
Range 

Input Value Description 
Low High 

scheduleCurrent-

State 

0 1,3,255 unconnected Schedule Current State = 255 (OC-

CNUL)  

invalid Schedule Current State = 255 (OC-

CNUL) 

VAL < low Schedule Current State =0 (OCC) 

VAL > high Schedule Current State = 255 (OC-

CNUL) 

WMOverride 0 1-3,255 unconnected WM Override = 255 (OCCNUL) 

invalid WM Override = 255 (OCCNUL) 

VAL < low WM Override = 0 (OCC) 

VAL > high WM Override = 255 (OCCNUL) 

NetworkManOcc 0 1-3,255 

unconnected Network Man Occ = 255 (OCCNUL)  

invalid Network Man Occ = 255 (OCCNUL) 

VAL < low Network Man Occ = 0 (OCC) 
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Input Name 
Range 

Input Value Description 
Low High 

VAL > high Network Man Occ = 255 (OCCNUL) 

OccSensorState 0 1, 255 

unconnected Occ Sensor State = 255 (OCCNUL)  

invalid Occ Sensor State = 255 (OCCNUL) 

VAL < low Occ Sensor State = 0 (OCC) 

VAL > high Occ Sensor State = 255 (OCCNUL) 

State values: 

Occ = 0   Standby = 3 

Unocc=1  Null = 255 

Bypass =2 

Outputs 

Table 146: Outputs of Occupancy Arbitrator 

Output Name Range Description 

EFF_OCC_CUR-

RENT_STATE 

0 to 3 (Occupied, Unoccupied, Bypass, 

Standby) 

Effective Occupancy Cur-

rent state 

MANUAL_OVER-

RIDE_STATE 

0 to 3, 255 (Occupied, Unoccupied, Bypass, 

Standby, Null) 

Manual Override State 

Configuration  

Specify Net wins (0) or Last in wins (1). Specify the occupancy sensor operation.  

There are 3 choices: Conference room (0), Unoccupied Cleaning Crew (1), and Unoccupied Tenant (2). 

Table 147: Configuration of Occupancy Arbitrator 

Name Range Description 

net-

LastInWins 

0 to 1 You can specify Net wins (0) or Last in wins (1). 

occSenso-

rOper 

0 to 2 You can specify the occupancy sensor operation. There are 3 choices: Con-

ference room (0), Unoccupied Cleaning Crew (1), and Unoccupied Tenant 

(2). See the bottom of the Occupancy Arbitrator table for differences be-

tween these options. 
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Operation 

 

Figure 342: Occupancy Arbitrator Function 

Manual Override Arbitration Mechanism 

Manual override arbitration mechanism determines the value of MANUAL_OVERRIDE_STATE. This 

value is used as an input to the Occupancy Arbitrator. 

The Manual Override Arbitrator uses either a Net Wins or a Last in Wins scheme to evaluate the inputs. 

Net Wins means the network command always takes precedence over the wall module command. 

With Last in Wins, the last override source is used to determine the final state. If multiple sources 

change the state in the same second, they are evaluated in the order: Network Man Occ, WM Override. 

Each second the function block is called; the algorithm looks for a change of state to Network Man Occ 

or WM Override. If either of these changed state, appropriate action is taken. Generally, a new command 

on any input, cancels prior action by another source. 

Table 148: Truth Table of Net Wins and Last Wins 

Net Wins/ 

Last in 

Wins 

Network 

Man Occ 

(note2) 

WM Over-

ride 

(note 2) 

RESULT: 

Manual 

Override 

State 

Comment 

Last in Wins OCC Don’t Care OCC Result set to Network Man Occ. 

Last in Wins UNOCC Don’t Care UNOCC Result set to Network Man Occ. 

    
Occ Sensor State

Valid Value:
Occ, Unocc, Null

    

Manual Override
Arbirator

    
Network Manual Occ 

Valid values:
Occ, Stby, Byp, Unocc, null

    

    
WM Override
Valid values:

Occ, Stby, Byp, Unocc, null
    

Net Wins/
Last-in Wins

KEY :

Module
    

Public variable
    

Internal Data Path

Occupancy Arbirator

    
Manual Override State 

Valid values:
Occ, Stby, Byp, Unocc, null

        
Schedule Current State 

Valid values:
Occ, Stby, Unocc, null

    

Occ Arb
Function Block

    
Effective Occ Current State 

Valid values:
Occ, Stby, Byp, Unocc, null

    

Occupancy 
Sensor 

Operation
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Net Wins/ 

Last in 

Wins 

Network 

Man Occ 

(note2) 

WM Over-

ride 

(note 2) 

RESULT: 

Manual 

Override 

State 

Comment 

Last in Wins BYPASS  Don’t Care BYPASS Result set to Network Man Occ. 

Last in Wins STANDBY Don’t Care STANDBY Result set to Network Man Occ. 

Last in Wins OCCNUL Don’t Care OCCNUL Override canceled. 

Last in Wins Don’t Care OCC OCC Result set to the wall module override. 

Last in Wins Don’t Care STANDBY STANDBY Result set to the wall module override. 

Last in Wins Don’t Care BYPASS BYPASS Result set to the wall module override. 

Last in Wins Don’t Care UNOCC UNOCC Result set to the wall module override. 

Last in Wins Don’t Care OCCNUL OCCNUL Override canceled. 

 

 
Note:   

Any other input value not listed, is not a valid state. If received, it is treated as OCCNUL. 

For last in wins, the value in the above table was just changed from another state and this is the current 

state. 

The manual override command is hold ON for the Bypass time outside the function block when Manual 

Override command is triggered. The function block does not have an ability to hold the Manual Override 

Command for the required Bypass time or don’t have any parameter for setting the bypass time. 

If manual Override Command is coming from ConventionalWallModule then it is held On for the bypass 

time by the wall module after triggering of the command. 

If network Manual Override Command is there, additional logic in the control program (or other device 

from the Manual Override Command is received over a Lon network) is need to be implemented for the 

bypass time. It need to be implemented. 

From iteration to iteration of the Function Block, the Occupancy Arbitrator keeps track of the last state 

of the Network Man Occ and WM Override inputs so that it knows when a transition occurs. On power 

up/reset the last latch value is set to FALSE, regardless of the negation configuration. Override is can-

celed, after a power outage. The Network Man Occ and WM Override inputs must reset themselves after 

a power outage.  
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Network Manual Occupancy Input 

NetworkManOcc is a method to command the occupancy state from a network workstation or a node. 

You may write logic to combine these, if both are required for the application. NetworkManOcc can 

command the state to be occupied, unoccupied, standby, bypass or null. It is required that the work-

station (nviManOccCmd) or network node (nviBypass) performs any timing needed that is bypass.  

WM Override Input 

WM Override is a method to command the occupancy state from a locally wired wall module. WM Over-

ride can command the state to be occupied, unoccupied, standby, bypass or null. It is required that the 

function block wired to this input, perform any timing needed that is bypass.  

 
Note:   

The current T7770 wall module function doesn’t support occupied or standby override, but future wall 

modules might. 

Occupancy Arbitration Mechanism 

The Occupancy Arbitrator computes the effective occupancy status. The inputs of the Effective Occu-

pancy Arbitrator include the Schedule Current State, Occ Sensor State, and Manual Override State. The 

Manual Override State comes from Network Man Occ or WM override. 

The Effective Occupancy Arbitrator sets the Effective Occ Current State. Valid states of current state 

are:  

• OCC: The space is occupied. 

• UNOCC: The space is unoccupied. 

• BYPASS: The space is occupied, though it is not scheduled to be occupied. 

• STANDBY: The space is in a standby state, somewhere between occupied and unoccupied. 

OCCNUL is not a valid output. If all inputs are OCCNUL, the output is set to occupied. 

Table 149: Truth Table of Valid States of Effective Occ Current State 

Manual 

Override 

State 

Schedule 

Current 

State 

Occ 

Sensor 

State 

Occ Sen-

sor Oper-

ation 

RESULT: 

effOcc 

Current-

State 

Comments 

Follows 

Lon-

Mark 

SCC 

OCC Don’t Care Don’t 

Care 

Don’t 

Care 

OCC Result = Manual Override 

State 

Yes. 

STANDBY Don’t Care Don’t 

Care 

Don’t 

Care 

STANDBY Result = Manual Override 

State 

Yes 

UNOCC Don’t Care  Don’t 

Care  

Don’t 

Care 

UNOCC Result = Manual Override 

State 

Yes 
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Manual 

Override 

State 

Schedule 

Current 

State 

Occ 

Sensor 

State 

Occ Sen-

sor Oper-

ation 

RESULT: 

effOcc 

Current-

State 

Comments 

Follows 

Lon-

Mark 

SCC 

BYPASS OCC Don’t 

Care  

Don’t 

Care 

OCC The result stays at occu-

pied because bypass 

isn’t effective when 

scheduled for occupied 

Yes 

BYPASS STANDBY Don’t 

Care 

Don’t 

Care 

BYPASS The result stays at by-

pass. 

Yes 

BYPASS UNOCC Don’t 

Care 

Don’t 

Care 

BYPASS Result = bypass Yes 

BYPASS OCCNUL OCC Don’t 

Care 

OCC The result follows occu-

pancy sensor 

Yes 

BYPASS OCCNUL UNOCC Don’t 

Care 

BYPASS The result follows man-

ual override 

Yes 

BYPASS OCCNUL OCCNUL Don’t 

Care 

OCC When occupancy sensor 

is null, default to occu-

pied. 

Yes  

OCCNUL STANDBY Don’t 

Care 

Don’t 

Care 

STANDBY Result = scheduled state. Yes  

OCCNUL OCC OCC Don’t 

Care 

OCC All say we are Occupied. Yes 

OCCNUL OCC UNOCC Don’t 

Care 

STANDBY We are scheduled to be 

occupied, but the room is 

unoccupied, so go to 

standby to save energy. 

Yes 

OCCNUL OCC OCCNUL Don’t 

Care 

OCC  Sensor not present so 

use schedule. 

Yes  

OCCNUL UNOCC UNOCC Don’t 

Care 

UNOCC All say we’re unoccupied. Yes 

OCCNUL UNOCC OCCNUL Don’t 

Care 

UNOCC Sensor not present so 

use schedule 

Yes 
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Manual 

Override 

State 

Schedule 

Current 

State 

Occ 

Sensor 

State 

Occ Sen-

sor Oper-

ation 

RESULT: 

effOcc 

Current-

State 

Comments 

Follows 

Lon-

Mark 

SCC 

OCCNUL OCCNUL OCC Don’t 

Care 

OCC Result -= occupancy 

sensor state. 

Yes 

OCCNUL OCCNUL UNOCC Don’t 

Care 

UNOCC Result -= occupancy 

sensor state. 

Yes  

OCCNUL OCCNUL OCCNUL Don’t 

Care 

OCC Result = occupied be-

cause the LonMark SCC 

sets a null occupancy 

sensor to Occupied. 

Yes 

OCCNUL UNOCC OCC Confer-

ence 

Room 

UNOCC Stay unoccupied regard-

less of what the sensor 

says that is save energy. 

Yes 

OCCNUL UNOCC OCC Cleaning 

Crew 

STANDBY We are scheduled to be 

unoccupied, but the 

room is occupied, so go 

to standby for the com-

fort of the cleaning crew. 

No 

OCCNUL UNOCC OCC Tenant OCC We are scheduled to be 

unoccupied, but the 

room is occupied, so, go 

to occupied for the com-

fort of the tenant. 

No 
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 SetTemperatureMode 

This function automatically calculates the effective temperature control mode based on the control 

type, system switch setting, network mode command, temperature set points, supply temperature and 

space temperature. 

 

Figure 343: SetTemperatureMode Property Sheet 

From iteration to iteration, the Function Block keeps track of the previous command mode and the 

effective temperature mode. On power up/reset, these are cleared. 

effTempMode indicates the current Mode determined by input states and arbitrated by control logic. 

SetTempMode does not generate all the possible Modes available. The following table shows the 

meaning of the valid enumerated values. The following table shows the meaning of valid enumerated 

values. 
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Logic Diagram Function Block 

Figure 344: Set Temperature Mode Function 

The following table shows the meaning of valid enumerated values. 

Table 150: Meanings of Valid Enumerated Values 

effTempMode Meaning 

COOL_MODE = 0 Cool air is being supplied to the node via the central air supply and cool-

ing energy is being supplied to the controlled space. 

REHEAT_MODE = 1 Cool air is being supplied to the node via the central air supply. The air 

is being reheated by a local Heat source. 

HEAT_MODE = 2 Heated air is being supplied to the node via the central air supply and 

heated air is being supplied to the controlled space 

EMERG_HEAT = 3 Emergency Heat is being supplied to the node via the central air supply.  

OFF_MODE = 255 The controller is commanded off. 
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Analog Input 

Table 151: Analog Inputs of Set Temperature Mode Function 

Input Name 
Range 

Input Value Description 
Low High 

sysSwitch 0 255 unconnected System Switch = SS_AUTO(0)  

invalid System Switch = SS_AUTO(0) 

VAL < low System Switch = SS_AUTO(0) 

VAL > high System Switch = SS_AUTO(0) 

cmdMode 0 255 unconnected val = CMD_AUTO_MODE(0)  

invalid val = CMD_AUTO_MODE(0) 

VAL < low val = CMD_AUTO_MODE(0) 

VAL > high val = CMD_AUTO_MODE(0) 

supplyTemp 0 255 

unconnected Supply Temp = invalid  

invalid Supply Temp = invalid 

Val < low SupplyTemp = low 

Val > high SupplyTemp = high 

spaceTemp 0 255 

unconnected SpaceTemp = invalid  

invalid SpaceTemp = invalid 

Val < low SpaceTemp = low 

Val > high SpaceTemp = high 

effHeatSP >=- <+ 
unconnected EffHeatSp = 68 

invalid EffHeatSp = 68 

effCoolSP >=- <+ 
unconnected EffCoolSp = 75  

invalid EffCoolSp = 75 

allowAutoChange 0 1 

unconnected allowAutoChange=1  

invalid allowAutoChange=1 
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Input Name 
Range 

Input Value Description 
Low High 

Val < low allowAutoChange=1 

Val > high allowAutoChange=1 

Outputs 

Table 152: Output of Set Temperature Mode Function 

Output Name 

Range 

Description 
Low High 

effSetpt 0.0 255 If effTempMode=COOL_MODE then val= effCoolSetPt, else 

val=effHeatSetPt 

effTempMode 0 255 See arbitration table for VAV and CVAHU behavior 

Configuration 

Specify the control Type (controlType)  

• 0 – CVAHU 

• 1 – VAV 

Specify the Behavior Type 

• Legacy – For normal output (Spyder Behavior)  

• Enhanced – For enhanced output. If no device is connected sysSwitch considered as SS Auto 

as default input for both CVAHU and VAV and EFF Temp mode output displays Heat mode. 

 Output 

Name 

Range 

Description 

Low High 

controlType 0 1 You can specify the control Type 

0 = CVAHU; 1 = VAV 
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Input Enumerations 

Table 153: Input Enumerations of Set Temperature Mode Function 

sysSwitch  

SS_AUTO = 0  

SS_COOL = 1 

SS_HEAT = 2 

SS_EMERG_HEAT = 3 

SS_OFF = 255 

cmdMode  

CMD_AUTO_MODE= 0 = 0  

CMD_ HEAT_MODE = 1 = 1 

CMD_COOL_MODE = 2 = 2 

CMD_OFF_MODE = 3 = 3 

CMD_ EMERG_HEAT_MODE = 4  = 4 

CMD_NUL_MODE = 255  = 255 

The CVAHU arbitration logic for ControlType = 0 (CVAHU) is summarized in the following table. 

Table 154: CVAHU Arbitration Logic for ControlType = 0 (CVAHU) 

Space 

Temp 
sysSwitch cmdMode effTempMode 

X X CMD_OFF(3) OFF_MODE(255)  

X X CMD_EMERG_HEAT_MODE(4) EMERG_HEAT(3) 

X X CMD_COOL_MODE(2) COOL_MODE(0) 

X X CMD_HEAT_MODE(1) HEAT_MODE(2) 

X 
X ENUMERATION (5) through ENU-

MERATION (254) 

HEAT_MODE(2)  

X 
SS_COOL (1) CMD_AUTO_MODE(0), 

CMD_NUL_MODE(255) 

COOL_MODE (0) 

X 

SS_HEAT (2) or ENU-

MERATION(4) through 

ENUMERATION (254) 

CMD_AUTO_MODE(0), 

CMD_NUL_MODE(255) 

HEAT_MODE(2)  

X 
SS_EMER-

GENCY_HEAT(3) 

CMD_AUTO_MODE(0), 

CMD_NUL_MODE(255), 

EMERG_HEAT(3) 
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Space 

Temp 
sysSwitch cmdMode effTempMode 

X 
SS_OFF (255) CMD_AUTO_MODE(0), 

CMD_NUL_MODE(255) 

OFF_MODE(255) 

INVALID 

SS_AUTO (0), invalid, 

unconected, or a non-

listed enumeration. 

CMD_AUTO_MODE(0), 

CMD_NUL_MODE(255) 

HEAT_MODE(2)  

VALID 

SS_AUTO (0), invalid, 

unconected, or a non-

listed enumeration. 

CMD_AUTO_MODE(0), 

CMD_NUL_MODE(255), 

COOL_MODE(0) or 

HEAT_MODE(2)  

(See the note follow-

ing this table.) 

 

 
Note:   

• X means don’t care. 

• If allowAutoChange = 1 then allow to switch between HEAT_MODE and COOL_MODE.  

• Must have valid effHeatSP and effCoolSP. If allowAutoChange = 1 and effHeatSp > effCoolSp 

then effHeatSp is internally set to effCoolSP. 

The VAV Mode arbitration logic for controlType = 1 the following table summarizes (VAV): 

Table 155: VAV Mode Arbitration Logic for controlType = 1 

Space 

Temp  
sysSwitch Supply Temp cmdMode effTempMode 

X X  X CMD_OFF_MODE (3) OFF_MODE (255)  

X X  X CMD_EMERG_HEAT_MODE 

(4) 

HEAT_MODE (2) 

X X  X ENUMERATION (5) through 

ENUMERATION (254) 

COOL_MODE (0) 

Valid X <70.0 CMD_AUTO_MODE (0) 

CMD_HEAT_MODE (1)  

CMD_NUL_MODE (255) 

COOL_MODE (0) or  

REHEAT_MODE (1)  

(See the note above 

this table.) 

Valid X 70.0 To 75.0 CMD_AUTO_MODE (0) 

CMD_HEAT_MODE (1) 

CMD_COOL_MODE (2) 

CMD_NUL_MODE (255)  

COOL_MODE (0) 

REHEAT_MODE (1) 

HEAT_MODE (2)  
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Space 

Temp  
sysSwitch Supply Temp cmdMode effTempMode 

(See the note above 

this table for transi-

tion between cool 

mode and reheat 

mode.) 

Valid X >75 CMD_AUTO_MODE (0) 

CMD_HEAT_MODE (1) 

CMD_NUL_MODE (255)  

HEAT_MODE (2) 

Valid X Invalid or uncon-

nected 

CMD_HEAT_MODE (1)  HEAT_MODE (2) 

Valid X Invalid or uncon-

nected 

CMD_COOL_MODE (2)  COOL_MODE (0) 

Valid SS_COOL (1) Invalid or uncon-

nected 

CMD_AUTO_MODE (0) 

CMD_NUL_MODE (255)  

COOL_MODE (0) 

Valid SS_HEAT (2) Invalid or uncon-

nected 

CMD_AUTO_MODE (0) 

 CMD_NUL_MODE (255)  

HEAT_MODE (2) 

Valid 

SS_ 

EMER-

GENCY_HEAT 

(3) 

Invalid or uncon-

nected 

CMD_AUTO_MODE (0) 

 CMD_NUL_MODE (255)  

HEAT_MODE (2) 

Valid SS_OFF (255) Invalid or uncon-

nected 

CMD_AUTO_MODE (0) 

 CMD_NUL_MODE (255)  

OFF_MODE (255) 

Valid SS_AUTO (0), 

invalid, un-

connected, or 

a non-listed 

enumeration. 

Invalid or uncon-

nected 

CMD_AUTO_MODE (0) 

CMD_NUL_MODE (255) 

COOL_MODE (0) or  

REHEAT_MODE (1) 

 (See the note above 

this table.) 

Invalid SS_AUTO (0), 

invalid, un-

connected, or 

a non-listed 

enumeration. 

Invalid or uncon-

nected 

CMD_AUTO_MODE (0) 

 CMD_NUL_MODE (255) 

COOL_MODE (0) 

 

 
Note:   
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• X means don’t care. 

• If allowAutoChange = 1 then allow to switch between REHEAT_MODE and COOL_MODE. Must 

have valid effHeatSP and effCoolSP.  

• If in cool mode and spaceTemp < effHeatSetPt and space temp < effCoolSetPt – 1.0 then go 

to reheat mode. If in reheat mode and spacetemp > effCoolSetPt and spacetemp > eff-

HeatSetPt + 1.0 then go to cool mode. 
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TemperatureSetpointCalculator 

This function calculates the current Effective Heat setpoint and Effective Cool setpoint based on the 

current schedule information, occupancy override, and intelligent recovery information. 

 

Logic Diagram 

 

Function Block 

Figure 345: Temperature Set Point Calculator Function  

Analog Inputs 

Table 156: Inputs of Temperature Set Point Calculator Function 

Input Name 

Range 

Input Value Description 

Low High 

EffOccCurrentState 0 3 unconnected Eff Occ Current State = 0 (OCC) 

invalid Eff Occ Current State = 0 (OCC) 

VAL < low Eff Occ Current State = 0 (OCC) 

VAL > high Eff Occ Current State = 0 (OCC) 

ScheduleNextState 0 1, 3, 

255 

unconnected Schedule Next State = 255 (OCCNUL) 

invalid Schedule Next State = 255 (OCCNUL) 

VAL < low Schedule Next State = 255 (OCCNUL) 
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Input Name 
Range 

Input Value Description 
Low High 

VAL > high Schedule Next State = 255 (OCCNUL) 

ScheduleTUNCOS 

(min) 

0 11520 unconnected Schedule TUNCOS = 11520 

invalid Schedule TUNCOS = 11520 

VAL < low Schedule TUNCOS = 0 

VAL > high Schedule TUNCOS = 11520 

Setpoint >= –∞ <+∞ unconnected Setpoint = 0 

invalid Setpoint = 0 

VAL < low Setpoint = 0 

VAL > high Setpoint = 0 

HeatRampRate 0 <+∞ unconnected Heat Ramp Rate = 0 

invalid Heat Ramp Rate = 0 

VAL < low Heat Ramp Rate = 0 

VAL > high Heat Ramp Rate = 0 

CoolRampRate 0 <+∞ unconnected Cool Ramp Rate = 0 

invalid Cool Ramp Rate = 0 

VAL < low Cool Ramp Rate = 0 

VAL > high Cool Ramp Rate = 0 

ManualOver-

rideState 

0 3,255 unconnected Manual Override State = 255 (OC-

CNUL) 

invalid Manual Override State = 255 (OC-

CNUL) 

VAL < low Manual Override State = 255 (OC-

CNUL) 

VAL > high Manual Override State = 255 (OC-

CNUL) 
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Input Name 
Range 

Input Value Description 
Low High 

occupiedCool >= –∞ <+∞ unconnected Setpoint = 75 

invalid Setpoint = 75 

VAL < low Setpoint = 75 

VAL > high Setpoint = 75 

standbyCool * >= –∞ <+∞ unconnected Setpoint = 78 

invalid Setpoint = 78 

VAL < low Setpoint = 78 

VAL > high Setpoint = 78 

unoccupiedCool * >= –∞ <+∞ unconnected Setpoint = 85 

invalid Setpoint = 85 

VAL < low Setpoint = 85 

VAL > high Setpoint = 85 

occupiedHeat * >= –∞ <+∞ unconnected Setpoint = 70 

invalid Setpoint = 70 

VAL < low Setpoint = 70 

VAL > high Setpoint = 70 

standbyHeat * >= –∞ <+∞ unconnected Setpoint = 67 

invalid Setpoint = 67 

VAL < low Setpoint = 67 

VAL > high Setpoint = 67 

unoccupiedHeat * >= –∞ <+∞ unconnected Setpoint = 55 

invalid Setpoint = 55 

VAL < low Setpoint = 55 
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Input Name 
Range 

Input Value Description 
Low High 

VAL > high Setpoint = 55 

Occ State enumeration: Occ = 0, Unocc=1, Bypass =2, Standby = 3, Null = 255. 

* - extension block inputs (Note:  extension block PVID# = Block PVID# - 9) 
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Outputs 

Table 157: Outputs of Temperature Set Point Calculator Function 

Output Name Range Description 

EFF_HEAT_SETPT Any floating-point number Effective Heat Setpoint 

EFF_COOL_SETPT Any floating-point number Effective Cool Setpoint 

Operation: 

 

TempSPCalc 

Ht Ramp Rate 

Valid values: 

0 to +infinity 

Manual Override State, 

Valid values: 

Occ, Stdby, Byp, Unocc, Null. 

Effective Heat Setpoint 

Effective Cool Setpoint 

 

Schedule Next State 

Valid values: 

Occ, Stdby, Unocc, Null 

KEY: 

Module Public Variable 

Internal data path 

TempSPCalc 

Function Block 

Schedule TUNCOS 

Valid values: 

0-11520 

Eff Occ Current State 

Valid values: 

Occ, Stdby, Byp, Unocc 

Setpoint 

Valid values: 

float 

Cl Ramp Rate 

Valid values: 

0 to +infinity 

 

Figure 346: Temperature Setpoint Function Block 

The Temperature Setpoint Calculator uses the 6 programmed-set-points, effective occupancy current 

state, scheduled next state and TUNCOS, center/offset setpoint, manual override state, recovery heat 

and cool ramp rates to determine the effective heat setpoint and effective cool setpoint. 

The algorithm flow is: 

1. Verify inputs are within range. 

2. Compute the occupied and standby heat and cool setpoints based on the setpoint input and 

programmed setpoints. 

3. If the effective occupancy current state is in unoccupied mode and not in manual override, cal-

culate the recovery ramps. 
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4. If the effective occupancy current state is in occupied or bypass mode, use the occupied set-

points. 

5. If the effective occupancy current state is in standby mode, use the standby setpoints. 

Programmed Set Points 

The control block uses six temperature set-points. There are three set points of occupied, standby and 

unoccupied for heating and the same for cooling. All six can be changed from the Network via network 

variables. The Temperature Setpoint calculator doesn’t place any restrictions on relationships between 

the set points and other inputs and the resulting calculations. This function block depends on the Tools 

writing TempSetpoints to enforce the range and relationship. 

For reference, the LonMark Space Comfort Controller profile defines TempSetpoints as having a range 

of 10°C to 35°C with the following relationship unoccupiedHeat ≤ standbyHeat ≤ occupiedHeat ≤ oc-

cupiedCool ≤ standbyCool ≤ unoccupiedCool. 

Setpoint Input 

This input allows the temperature setpoint for the occupied and standby mode to be changed via the 

wall module and/or network. This input can be either center or offset setpoint. If the input is less than 

10, it is treated as offset setpoint. If the input is greater than or equal to 10, it is treated as center set-

point. Ensure the results are within the desired range. That is, it is possible to combine the setpoint 

input and the programmed heat and cool setpoints and get an effective setpoint outside of the unoc-

cupied setpoints. 

Offset Setpoint 

The setpoint acts in offset mode, that is relative setpoint, when the value on the Setpoint input is less 

than 10. The setpoint input adjusts the programmed occupied and standby heating and cooling set-

points up and down by the amount on the input. You must ensure the input range is less than +10 for 

offset setpoint to be used. The setpoint input doesn’t affect the unoccupied setpoints. During bypass, 

the occupied setpoints are adjusted. If the setpoint input is not connected or the sensor has failed, the 

offset is zero. You must ensure consistent units. That is, if the Setpoint input is in degrees F, the pro-

grammed setpoints should also be in degrees F. 

• Occupied cool setpoint = programmed occupied cool setpoint + Setpoint input. 

• Occupied heat setpoint = programmed occupied heat setpoint + Setpoint input. 

• Standby cool setpoint = programmed standby cool setpoint + Setpoint input. 

• Standby heat setpoint = programmed standby heat setpoint + Setpoint input. 

Center Setpoint 

If the value on the Setpoint input is greater than or equal to 10, it is used as the center setpoint, that is 

absolute setpoint. If an invalid setpoint is on the Setpoint input, the programmed setpoints are used. 

The individual heat/cool setpoints for occupied and standby mode then derive from the Setpoint input 

minus/plus half the zero-energy bands calculated from the programmed setpoints. 
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HONEYWELL CIPer MODEL 30 SYSTEM ENGINEERING USER GUIDE 

FUNCTION BLOCK LIBRARY ZoneControl Function Blocks 

31-00237EFS - 02 | 401  

For example: 

zeb_occ = programmed occupied cool – programmed occupied heat 

zeb_standby = programmed standby cool – programmed standby heat. 

Occupied cool setpoint = setpoint + ½ zeb_occ 

Occupied heat setpoint = setpoint - ½ zeb_occ 

Standby cool setpoint = setpoint + ½ zeb_standby 

Standby heat setpoint = setpoint - ½ zeb_standby 

Manual Override State 

The Manual Override State is required to turn off recovery if in manual mode. If the Manual Override 

State is any value other than null then the algorithm doesn’t know the scheduled next state and set-

point recovery is NOT done.  

Note:  Manual Override State doesn’t affect the effective occupancy state. The OccArb function block 

already handles this. The effective setpoints never go to the state commanded by the Manual Override 

state input. Manual Override State just affects recovery as stated above. 

Effective Occupied State 

This is used by the algorithm to determine the setpoints for the current occupancy state. When the 

Effective Occupancy Current state is occupied or bypass, use the occupied setpoints. When the Effec-

tive Occupancy Current state is standby, use the standby setpoints. When the Effective Occupancy 

Current state is unoccupied, recover the setpoint to the next state of occupied or standby. No recovery 

is done if in manual mode. See Adaptive Intelligent Recovery section. 

Heating and Cooling Ramp Rates 

These are used by the adaptive recovery algorithm to recover the heating and cooling setpoints from 

their unoccupied values. 

Schedule Next State and TUNCOS 

These are used by the adaptive recovery algorithm to recover the heating and cooling setpoints from 

their unoccupied values. 

Adaptive Intelligent Recovery 

Set point recovery applies to setpoint changes associated with the following schedule state changes: 

• Unoccupied to Standby 

• Unoccupied to Occupied 

Setpoint changes from occupied or standby to unoccupied state, changes from occupied to standby 

state, and changes from standby to occupied state use a step change in setpoint. 

The heating or cooling recovery ramp begins before the next state transition time. During the recovery 

ramps, the heating and cooling set points are ramped from the unoccupied setpoint to the next state 
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setpoint. The setpoint ramps is at the target setpoint 10 minutes prior to the occupied/standby event 

time. 

This allows the HVAC equipment an extra 10 minutes to get the space temperature to the target set-

point during recovery. 

 
Note:   

Recovery is not done, if manual occupancy is in effect. 

 

 

Figure 347: Heat and Cool Recovery Ramps 

You can provide the heat and cool recovery ramp rates to the Temperature Setpoint Calculator. These 

can be constants, values calculated using the Ratio function block using outdoor air temperature, or 

some other method. 

Heating and cooling recovery ramp rates can be any value greater than or equal to zero and have units 

of /hr. A ramp rate of 0/hr. means no recovery ramp for that mode. This means the setpoint steps 

from one setpoint to the other at the event time that is no extra 10 minutes. You must ensure consistent 

units. That is, the ramp rates should be in the same units as the setpoints. 

 
Note:   

If you program a rate of 1/Hr. and have more than 192 spread between OCC and UNOCC set points, 

the algorithm is in recovery immediately when going to UNOCC. This is because the maximum TUN-

COS is 11520 minutes times 1/Hr. = 192 maximum delta. 
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TUNCOS Mesa 

The controller implements the “TUNCOS Mesa” feature. This feature, also known as the "Smith Mesa" 

after Gary Smith implemented it in the T7300 series 1000. The TUNCOS Mesa is added to the algorithm 

to ensure the HVAC equipment gets the space temperature up to setpoint by the occupied time. The 

recovery algorithm subtracts 10 minutes from the TUNCOS and uses that to calculate the setpoint 

ramps. 

Heat Unoccupied
Setpoint

Occupied
or Standby
SetpointHeat Recovery

Ramp
Rate

Occupied or
Standby

Time

Tuncos Mesa =
10 minutes

 

Figure 348: TUNCOS Mesa Heat Recovery Ramp (Cool is upside down) 

Effective Setpoint Limiting 

This algorithm does not ensure that the effective cooling setpoint doesn’t go above the unoccupied 

cooling setpoint and the effective heating setpoint doesn’t go below the unoccupied heating setpoint. 

No check is made to ensure the effective heat and cool setpoints stay a minimum distance apart. 
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BuiltIn 

The CIPer Model 30 programming model provides the following BuiltIn blocks that can be configured 

and use to build the required application logic:  

• ConventionalWallModule 

• Utils Function Blocks 

ConventionalWallModule 

The CIPer Model 30 programming model provides the ConventionalWallModule function blocks that 

you can configure and use to build the required application logic: 

The CIPer Model 30 programming model supports configuring the conventional wall module (7-wire).  

 

Figure 349: ConventionalWallModule Function Block 

To configure the conventional wall module:  

1. Expand the BuiltIn folder in the ipcProgrammingTool palette.  

2. Drag the ConventionalWallModule onto the wire sheet. The conventional wall module block 

appears on the wire sheet.  

3. Double-click the ConventionalWallModule block and the Properties Sheet is displayed. You 

can configure the properties for the conventional wall module in the Property Sheet. 
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Figure 350: Property Sheet of ConventionalWallModule 

Override Type 

 

Figure 351: Override Options 

You can select one of three options available: 

• NORMAL_OVERRIDE: If this option is selected, you can override the system in Unoccupied and 

Bypass Mode using Override button. If analog output is connected to the LED input of the wall 

module, it gives feedback of the overridden state.  

To override the system in Unoccupied Mode, press the Override button till LED starts blinking. 

To remove overridden state, press the Override button till LED turns off.  

To override the System in Bypass Mode, press the override button till LED turns ON. To remove 

overridden state, wait till bypass time (see Bypass Time in the same table) expires or press the 

Override button and wait till LED turns OFF.  

• BYAPSS_ONLY_OVERRIDE: If this option is selected, you can override the system in only By-

pass Mode. 

To override the System in Bypass Mode, press the override button till LED turns ON. To remove 

overridden state, wait till bypass time (see Bypass Time in the same table) expires or press the 

override button and wait till LED turns OFF.  
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• OVERRIDE_DISABLE: You cannot override the system in any mode. Override button has no 

effect. 

 

 
Note:   

If the user connects the sensors or hardware inputs directly to the conventional wall module then 

the wall module will automatically calibrate the output based on the current data. But if the user 

connects the parameters via passthrough or other blocks then user need to do manual commission-

ing to reflect the changes in the output.  

To do Manual commissioning select the Conventional Wall Module on the wiresheet -> right click -> 

select Commission Wall Module. Also, if user changes any configuration or connection of the Con-

ventional Wall Module then the user need to do manual commissioning to reflect the changes. 

  

Figure 352: Manual Commissioning of Conventional wall Module 

 

  

 



HONEYWELL CIPer MODEL 30 SYSTEM ENGINEERING USER GUIDE 

FUNCTION BLOCK LIBRARY Utils Function Blocks 

31-00237EFS - 02 | 407  

Utils Function Blocks 

The utility function block provides the PassThru, TextBlock, SystemTime, and Tuncos application 

blocks for programming. 

PassThru 

This object is used to provide an input and output slot to the application block so that inputs and out-

puts can be connected to that application block. 

Example: A logic is created with application block as shown in the following figure. It calculates the 

averages two temperature inputs and transfers the average value to the network outputs. As shown at 

the right-side area of the following figure, the application block does not have slots. The PassThru block 

helps creating these slots and then you can connect inputs and outputs to the slots created to the 

application block. 

 

Figure 353: PassThru Function Block 

 

Figure 354: PassThru Example 

 

Figure 355: Navigating to Composite  
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To create slots: 

1. Right-click the application block and select Composite. The Composite window is displayed. At 

the right pane of the window all points of which slots can be created appears. 

2. Create slots as shown in the following figure and click Ok. Input and output slots are created to 

the Application block. 

3. Connect inputs to input slots and output to the output slots. In this way, data is passed to and 

from Application logic through pass through object. Input and output slots can be created to 

function blocks also. 

4. In the following example, Average function block is used. Its inputs and outputs can be exposed 

to Application block. 

 

Figure 356: Composite Editor Window 

 

Figure 357: Wire Sheet View of Composite 
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TextBlock 

The TextBlock in the utility module provides you the ability to add the text boxes onto the wire sheet. 

You can add the text of your choice. 

To use TextBlock: 

1. Drag and drop the TextBlock from palette pane onto the wire sheet. 

2. Double-click the TextBlock. The property Sheet is displayed. 

3. Enter the text in the Text field. 

a. Set the Foreground and Background color properties. 

b. Select the font and font size from the respective drop-down menus. 

c. Apply the bold, italic, underline styles. 

d. Select the border and selectable property values from respective drop-down menus. 

4. Click Save to save the changes. 

Following figure shows the Property Sheet view of the TextBlock. 

 

Figure 358: Property Sheet View of TextBlock 
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SystemTime 

When you drag and drop the SystemTime block onto the wire sheet, the local time value which is con-

figured in the CIPer Model 30 is displayed. You can configure the value of SystemTime block by con-

figuring the Property Sheet of the SystemTime block or in the Platform Administration. The changes 

made at any one of these two places reflect at the other place. 

 

Figure 359: SystemTime Block 
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Tuncos 

The time until next change of state (TUNCOS) represents the time taken by the system to change from 

one or current state to another or next state. You cannot use the Tuncos block separately, and must 

use it with SylkSchedule block. By default, the Tuncos parameter is provided in the SylkSchedule block.  

To add the Tuncos function block onto the wire sheet: 

1. Open the wire sheet of the SequencedControlProgram folder by navigating to Station > Config 

> Drivers > IPCNetwork > LocalDevice > Points > SequencedControlProgram. 

2. Navigate to the Tuncos block in the Utils function block of ipcProgrammingTool palette. 

3. Drag and drop the Tuncos block onto the wire sheet. The Tuncos block is displayed on the wire 

sheet. 

 

Figure 360: Tuncos Block 

 

Figure 361: SylkSchedule Block with TUNCOS Parameter 
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CUSTOM PALETTE FILE 

You can create and use a custom palette file to store any CIPer Model 30 object application, macro, 

device, function blocks, and IOs from a station. The custom palette file can be used to share across 

stations and among multiple users. This file acts as a repository, but an object cannot be configured 

that exists in the palette. You can later copy and paste or drag and drop these objects from the custom 

palette to the station. 

Creating Custom Palette File 

To create a custom palette file:  

1. On the Nav sidebar, navigate to the drive, where the custom palette file needs to be created. 

2. Right-click the drive and click New > New Folder. A new folder is created. 

 

Figure 362: Creating New Folder 

3. Enter a name for the new folder and click Ok.  

4. Right-click the newly created folder and click New > PaletteFile.palette. 
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Figure 363: Creating New Palette File 

5. Enter a name for the palette file and click Ok. A new palette file is created. 

6. Expand the newly created folder to view the palette file that is created. 

7. Double-click the palette file to open its wire sheet. 

8. On the Palette pane, click the  (Open Palette) icon. The Open Palette window is displayed. 

 

Figure 364: Select Baja Module 



HONEYWELL CIPer MODEL 30 SYSTEM ENGINEERING USER GUIDE 

CUSTOM PALETTE FILE Creating Custom Palette File 

31-00237EFS - 02 | 414 

9. Select Baja module and click Ok. The UnrestrictedFolder folder is available in the Baja Palette 

(Palette pane with Baja module selected).  

 

Figure 365: Unrestricted Folder in Baja Module 

10. Drag the UnrestrictedFolder into the folder with the palette file that is created. A .bog file is 

displayed in the folder which contains the UnrestrictedFolder.  

11. Double-click the UnrestrictedFolder.bog file that is added to the newly created folder, to open 

its wire sheet.  

 

Figure 366: Unrestricted Folder Structure 

12. Right-click the folder to rename it. This is the Unrestricted folder, where all CIPer Model 30 ob-

jects can be stored. 

 
Note: 

You can double-click the UnrestrictedFolder in the Nav tree to open its wire sheet and drag the Unre-

strictedFolder object from the Palette onto the wire sheet. This has the effect of nesting folders within 

the palette file. This enables the categorization of objects that are stored in the palette file. 

For example, an UnrestrictedFolder can be dragged from the Baja palette (Palette with Baja module 

selected) onto the wire sheet of the palette file in the Nav tree and name it Applications. Then double-

click the Applications folder on the wire sheet, drag another UnrestrictedFolder object from the Baja 

palette, and name it VAV Applications. This creates the VAV Applications folder nested under the Appli-

cations folder in a tree structure in the custom palette file folder that is created. 
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Adding Items to Custom Palette File 

To add any CIPer Model 30 object such as an IO or function block to the custom palette:  

1. Browse to the Sequence Control Program that needs to be saved in the custom palette file by 

clicking Station > Drivers > IPCNetwork > LocalDevice > Points > SequencedControlProgram. 

Or 

2. Station > Drivers > IPCNetwork > LocalDevice > Points > EventControlProgram in the Nav tree. 

3. Right-click any object such as a function block or IO and select Copy. 

 

Figure 367: Copy Option 

4. Navigate to the folder that is created under the custom palette file (Applications or VAV Appli-

cations as given in the above Note) and right-click it and select Paste. 

Or 

Drag and drop the object to the wire sheet of the folder (Applications or VAV Applications as 

given in the Error! Reference source not found.) under the custom palette file. 

Or 
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Drag and drop a CIPer Model 30 object directly onto the folder (Applications or VAV Applica-

tions as given in the Error! Reference source not found.) under the custom palette file in the 

Nav tree.  

5. The object is saved under the folder in the custom palette file.  

6. Right-click the file in the custom palette file and click Save.  

7. Right-click the custom palette file and click Close to close the custom palette file. 

Closing Custom Palette File 

To close the custom palette file, right-click the custom palette file, and click Close.  

 
Note:   

If a custom palette file or the workbench is closed without saving the contents of the custom palette 

file, the newly added contents are not saved and are not be available next time. 

The components can be reused from the custom palette file in any application logic that is created by 

dragging and dropping the desired object from the custom palette file to the wire sheet of Sequenced-

ControlProgram or EventControlProgram as required. 

Adding Device to Custom Palette File 

Adding a device to the custom palette file is like adding an IPC object, but it has some specific steps 

that you need to perform additionally. 

To add a device to the custom palette file:  

1. Browse to the device that needs to be saved in the custom palette file by clicking Station > 

Drivers > IPCNetwork > LocalDevice. 

2. Right-click the device and select Copy.  

3. Navigate to the folder that is created under the custom palette file (Applications or VAV Appli-

cations as given in the note under Creating Custom Palette File section), right-click it, and se-

lect Paste.  

4. Right-click the custom palette file and select Save. The device is saved under the folder in the 

custom palette file. 
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